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Product Basics
See these sections to learn about the basic features of your product.
Setting Up the Control Panel
Product Parts Locations
The Sleep Timer
EPSON Connect Solutions
Using AirPrint
Using Google Cloud Print

Setting Up the Control Panel
See these sections to set up the control panel for use.
Control Panel Buttons and Lights
Adjusting Control Panel Position
Changing LCD Screen Language
Turning Off Control Panel Sounds
Parent topic: Product Basics

Control Panel Buttons and Lights

1 The power button and the power light
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2 The home button
3 The LCD screen
4 The up and down arrow buttons (you can also scroll by swiping up and down on the LCD screen

with your finger)
5 The WiFi light
6 The CD button
7 The back button
8 The start button

Parent topic: Setting Up the Control Panel

Adjusting Control Panel Position
You can adjust the position of the control panel to make it easier to access. Raise or lower it to the
desired angle as shown.

Parent topic: Setting Up the Control Panel

Changing LCD Screen Language
You can change the language used on the LCD screen.

1. Press the home button, if necessary.
2. Press the left or right arrow button and then select Setup.
3. Scroll down and select Basic Setup.
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4. Scroll down and select Language.
5. Select a language.

6. Press the home button to exit.
Parent topic: Setting Up the Control Panel

Turning Off Control Panel Sounds
You can turn off the sound heard when you press buttons on the control panel.

1. Press the home button, if necessary.
2. Press the left or right arrow button and then select Setup.
3. Select Printer Setup.
4. Select Sound.
5. Select Button Press.
6. Select the Off setting.

7. Press the home button to exit.
Parent topic: Setting Up the Control Panel

Product Parts Locations
See these sections to identify the parts on your product.
Product Parts - Top
Product Parts - Front
Product Parts - Inside
Product Parts - Back
Parent topic: Product Basics
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Product Parts - Top

1 Automatic Document Feeder (ADF)
2 Edge guide
3 ADF paper support
4 ADF output extension
5 ADF output tray
6 ADF cover
7 CD/DVD tray (shown removed and in storage position)
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1 Rear paper feed slot
2 Paper support

Parent topic: Product Parts Locations
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Product Parts - Front

1 Control panel
2 Output tray
3 Cassette 1 (upper cassette)
4 Cassette 2 (lower cassette)
5 Front cover
6 Cassette edge guides
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1 Document cover
2 Scanner glass
3 Memory card access light
4 Memory card slots
5 USB Type A port for external devices

Parent topic: Product Parts Locations
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Product Parts - Inside

1 Scanner unit
2 Print head/ink cartridge holder

Parent topic: Product Parts Locations

Product Parts - Back

1 AC inlet
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2 Rear cover
3 LAN port
4 LINE port
5 EXT port
6 USB port

Parent topic: Product Parts Locations

The Sleep Timer
The product enters sleep mode if it is not used for a period of time. You can adjust the time period before
sleep mode, but increasing the time reduces the product's energy efficiency.
Changing the Sleep Timer Setting From the Control Panel
Changing the Sleep Timer Setting - Windows
Changing the Sleep Timer Setting - Mac OS X
Parent topic: Product Basics

Changing the Sleep Timer Setting From the Control Panel
You can use the product's control panel to change the time period before the product enters sleep mode.

1. Press the home button, if necessary.
2. Press the left or right arrow button and then select Setup.
3. Select Printer Setup.

You see this screen:
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4. Press the up or down arrow buttons to select Sleep Timer.
You see this screen:

5. Press the up or down arrow buttons to select the time period you want before the product goes to
sleep.

6. Press the home button to exit.
Parent topic: The Sleep Timer
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Changing the Sleep Timer Setting - Windows
You can use the printer software to change the time period before the printer enters sleep mode.
1. Do one of the following:

• Windows 7: Click and select Devices and Printers. Right-click your product name and select
Printing Preferences.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
right-click your product name, and select Printing Preferences.

• Windows XP: Click Start and select Printers and Faxes. (Or open the Control Panel, select
Printers and Other Hardware if necessary, and select Printers and Faxes.) Right-click your
product name and select Printing Preferences.

2. Click the Maintenance tab.
3. Click the Printer and Option Information button.

You see the Printer and Option Information screen:

4. Select the time period you want before the product goes to sleep as the Sleep Timer setting.
5. Click Send.
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6. Click OK to close the open program windows.
Parent topic: The Sleep Timer

Changing the Sleep Timer Setting - Mac OS X
You can use the printer software to change the time period before the printer enters sleep mode.
1. Do one of the following:

• Mac OS X 10.6/10.7/10.8: In the Apple menu or the Dock, select System Preferences. Select
Print & Fax or Print & Scan, select your product, and select Options & Supplies. Select Utility
and select Open Printer Utility.

• Mac OS X 10.5: In the Apple menu or the Dock, select System Preferences. Select Print & Fax,
select your product, and select Open Print Queue. Select Utility.

2. Select Printer Settings.
You see this screen:

3. Select the time period you want before the product goes to sleep as the Sleep Timer setting.
4. Click Apply.
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5. Close the Printer Settings window.
Parent topic: The Sleep Timer

EPSON Connect Solutions
You can print documents, photos, emails, and web pages from your home, office, or even across the
globe. You can use your smartphone, tablet, or computer. Epson offers these solutions to print and scan
from anywhere: EPSON Email Print, EPSON iPrint Mobile App, EPSON Remote Print, and EPSON
Scan to Cloud.
Using EPSON Email Print
Using the EPSON iPrint Mobile App
Using EPSON Remote Print
Using EPSON Scan to Cloud
Parent topic: Product Basics

Using EPSON Email Print
With EPSON Email Print, you can print from any device that can send email, such as your smartphone,
tablet, or laptop. Just activate your product's unique email address. When you want to print, attach a
PDF, Microsoft Office document, or photo and send an email to your product.
1. Set up your product for network printing as described on the Start Here sheet.
2. If you did not already set up Email Print when you installed your product software, visit

www.epson.com/connect to learn more about Email Print, check compatibility, and get detailed
setup instructions.

3. Send an email with attachments to your product's Email Print address.

Note: Both the email and any attachments print by default. You can change these printing options by
logging into your EPSON Connect account.

Parent topic: EPSON Connect Solutions

Using the EPSON iPrint Mobile App
Use this free Apple and Android app to print to nearby EPSON networked products. The EPSON iPrint
Mobile App lets you print PDFs, Microsoft Office documents, photos, and web pages over a wireless
network. You can even scan and save a file on your device, send it as an email, or upload it to an online
service such as Box, Dropbox, EverNote, or Google Docs.

28

http://www.epson.com/connect


1. Set up your product for network printing as described on the Start Here sheet.
2. Visit www.epson.com/connect to learn more about EPSON iPrint and check the compatibility of your

mobile device.
3. Download EPSON iPrint from the Apple App Store or Google Play.
4. Connect your mobile device to the same wireless network that your product is using.
5. Print from your mobile device to your EPSON product.
Parent topic: EPSON Connect Solutions

Using EPSON Remote Print
With EPSON Remote Print software on your Windows computer or laptop, you can print to an EPSON
Email-enabled product anywhere in the world.
1. Visit www.epson.com/connect to learn more about Remote Print and how to download the software.
2. Download and install the Remote Print software.
3. Determine the email address and optional access key of the EPSON product you want to use for

printing, and enter this address during Remote Print setup.
4. Select the print command in your application and choose this EPSON product as the printer.
Parent topic: EPSON Connect Solutions

Using EPSON Scan to Cloud
The EPSON Scan to Cloud service sends your scanned files to a destination that you have registered
with EPSON Connect.
1. Set up your product for network printing as described on the Start Here sheet.
2. Visit www.epson.com/connect for instructions on registering an account and your product with

EPSON Connect.
3. After registering, sign in to the EPSON Connect web page with the email address and password you

selected.
4. Select Destination List for Scan to Cloud.
5. Click Add, then follow the instructions on the screen to enter your registered email address and a

display name for it.
6. When you're ready to scan, select the setting for the Scan to Cloud service on your product control

panel.
Parent topic: EPSON Connect Solutions
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Related tasks
Starting a Scan Using the Product Control Panel

Using AirPrint
AirPrint allows you to wirelessly print to AirPrint-enabled EPSON products directly from iPhone, iPad,
and iPod touch running the latest version of iOS.
1. Set up your EPSON product for wireless printing as described on the Start Here sheet.
2. Connect your Apple device to the same wireless network that your product is using.
3. Print from your iPad, iPhone, or iPod touch to your EPSON product.
Parent topic: Product Basics

Using Google Cloud Print
With a Google Account, you can print from your Apple or Android device to your EPSON wireless
product. You can also print from Chromebooks and the Google Chrome browser without drivers or
cables.
If you are setting up your product for the first time, set up your EPSON product for wireless printing as
described on the Start Here sheet.

Note: Make sure your EPSON printer and computer are connected to the same network before starting
the Google Cloud Print setup.

If your product is already on your wireless network, follow these steps:
1. Connect your device to the same wireless network that your EPSON product is using.
2. Print a network status sheet.
3. Locate your product's IP address on the network status sheet.
4. Enter the IP address into the address bar of a web browser.
5. Select the Google Cloud Print Services option.

Note: If you don't see the Google Cloud Print Services option, turn your product off and back on. If
the option still doesn't appear, select the Firmware Update option and follow the on-screen
instructions to update your product.

6. Click Register.
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7. Select the check box to agree to the Usage Advisory and click Next.
8. Click OK to launch the sign-in page.

A separate browser window opens.
9. Enter your Google Account username and password and click Sign in, or, if you don't have an

account, click Sign up for a new Google Account and follow the on-screen instructions.
10. Click Finish printer registration to complete setup and print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook,
computer, Apple or Android device with internet access. Visit Epson Support for more information on
using Google Cloud Print, or the Google Cloud Print website for a list of supported apps.

Parent topic: Product Basics
Related tasks
Printing a Network Status Sheet
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Selecting Wireless Network Settings From the Control Panel
You can select or change wireless network settings using your product control panel.
To install your product on a wireless network, follow the instructions on the Start Here sheet and install
the necessary software from the product CD. The installer program guides you through network setup.

Note: Breakdown or repair of this product may cause loss of fax and network data and settings. Epson is
not responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your fax and network data and settings.

1. Press the home button, if necessary.
2. Select Wi-Fi Setup.

You see this screen:

3. Select Wi-Fi Setup Wizard.

Note: If you need to disable the wireless network to set up your product on an Ethernet network,
scroll down and select Disable Wi-Fi instead. Then follow the instructions on the Start Here sheet to
set up your product on a wired network and install the necessary software from the product CD. The
installer program guides you through network setup.
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4. Select the name of your wireless network or enter the name manually.

Note: To enter the wireless network name manually, scroll down and then select Other Networks.
Use the displayed keypad to enter your network name, as described in the next step.

5. Enter your wireless password (or network name and then password) using the displayed keypad.

Note: The network name and password are case sensitive. Be sure to correctly enter uppercase and
lowercase letters, and numeric or special characters.

• Press the touch screen buttons repeatedly to scroll through characters.
• Press or to move the cursor.
• Press 1 Symb. to enter symbols.
• Press to delete the previous character.

6. Press Done when you’re finished entering your password.
7. Confirm the displayed network settings and select Proceed to save them.

Note: If you need to change a setting, press the back button.

8. If you want to print a network setup report, press the start button. (Otherwise, select Cancel.)
9. Press the home button to exit.

The WiFi light should now be on.
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Note: If the WiFi light is off, you may have selected the wrong network name or entered the
password incorrectly. Repeat these steps to try again.
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Loading Paper
Before you print, load paper for the type of printing you will do.
Loading Paper in Cassette 1 (Upper Cassette)
Loading Paper in Cassette 2 (Lower Cassette)
Loading Paper in the Rear Paper Feed Slot
Loading Envelopes
Paper Loading Capacity
Available EPSON Papers
Borderless Paper Type Compatibility
Paper or Media Type Settings

Loading Paper in Cassette 1 (Upper Cassette)
You can load photo paper and other media in these sizes in the upper paper cassette:
• 3.5 × 5 inches (89 × 127 mm)
• 4 × 6 inches (102 × 152 mm)
• 5 × 7 inches (127 × 178 mm)
• A6 (4.1 × 5.8 inches [105 × 148 mm])
• 16:9 wide (4 × 7.1 inches [102 × 181 mm])

Note: Do not remove or insert the paper cassette during printing.

1. Close the output tray, if necessary.
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Note: As you slide in the output tray, there may be slight resistance and noise. This is normal.

2. Open the front cover.

3. Pull out the upper paper cassette. The upper cassette has a label on the right side.

4. Slide the edge guides outward.
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5. Set the front edge guide to the position for the paper size you are using.

Note: Various paper sizes are marked on the tray.

6. Insert paper with the glossy or printable side facedown.

Note: Make sure the paper is loaded against the front edge guide.

7. Slide the side edge guides against the paper, but not too tightly.

Note: Make sure the paper is under the tabs on the edge guides.
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8. Keep the cassette flat as you insert it.

Note: The output tray will open automatically when you print.

Always follow these paper loading guidelines:
• Load only the recommended number of sheets.
• Load paper short edge first and printable side facedown.
• Make sure the paper is under the tabs on the edge guides and not sticking out from the end of the

cassette.
• Check the paper package for any additional loading instructions.
Parent topic: Loading Paper
Related references
Paper Loading Capacity
Related tasks
Loading Paper in Cassette 2 (Lower Cassette)
Loading Paper in the Rear Paper Feed Slot
Loading Envelopes

Loading Paper in Cassette 2 (Lower Cassette)
You can load paper up to this size in the lower paper cassette: Legal (8.5 × 14 inches [216 × 357 mm]).

Note: Do not remove or insert the paper cassette during printing.
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1. Close the output tray, if necessary.

Note: As you slide in the output tray, there may be slight resistance and noise. This is normal.

2. Open the front cover.

3. Pull on the front cover to pull out the lower paper cassette.

39



4. Slide the edge guides outward.

Note: If you are using legal-size paper, remove the CD/DVD tray from the product. Press the button
on the cassette and then extend it as shown.

5. Set the front edge guide to the paper size you are using.

Note: Various paper sizes are marked on the tray.
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6. Insert paper with the glossy or printable side facedown.

Note: Make sure the paper is loaded against the edge guide and not sticking out from the end of the
cassette.

7. Slide the side edge guides against the paper, but not too tightly.

Note: Make sure the paper is under the tabs on the edge guides.
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8. Keep the cassette flat as you insert it.

Note: The output tray will open automatically when you print.

Always follow these paper loading guidelines:
• Load only the recommended number of sheets.
• Load paper short edge first and printable side facedown.
• Make sure the paper is under the tabs on the edge guides and not sticking out from the end of the

cassette.
• Check the paper package for any additional loading instructions.
Parent topic: Loading Paper
Related references
Paper Loading Capacity
Related tasks
Loading Paper in Cassette 1 (Upper Cassette)
Loading Paper in the Rear Paper Feed Slot
Loading Envelopes

Loading Paper in the Rear Paper Feed Slot
You can load card stock, envelopes, and other thick media in the rear paper feed slot.

Note: Paper that is too stiff may not load correctly. Check the paper specifications.
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1. Send your print job from a computer or using the product's touch screen.
• If printing from a computer, select Rear Paper Feed Slot for the Source (Windows) or Paper

Source (Mac OS X) setting.
• If printing from the product's touch screen, select Rear Paper Feed Slot for the Paper Source

setting.
2. Flip open the rear paper feed slot cover and swing out the paper support.

3. Slide the edge guides outward.
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4. Do one of the following:
• If loading a single sheet of paper, insert it printable side up and short edge first, in the center of the

rear paper feed slot. Slide the edge guides against the paper, but not too tightly.

• If loading an envelope, insert it short edge first with the flap facing down, in the center of the rear
paper feed slot. Slide the edge guides against the envelope, but not too tightly.

44



5. Push the paper or envelope down until it meets resistance. About 2 inches (5 cm) of the paper
should be fed inside the printer as shown.

1 2 inches (5 cm)

6. When you are ready to print, press the start button.

Note: To cancel printing, select Cancel.

Always follow these loading guidelines:
• Load one sheet or envelope at a time.
• Load the paper or envelope short edge first and printable side faceup.
• Check the paper package for any additional loading instructions.
Parent topic: Loading Paper
Related references
Paper Loading Capacity
Paper Specifications
Related tasks
Loading Paper in Cassette 1 (Upper Cassette)
Loading Paper in Cassette 2 (Lower Cassette)
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Loading Envelopes

Loading Envelopes
You can load envelopes in Cassette 2 (lower cassette) as described here. You can print on plain paper
envelopes in this size: No. 10 (4.1 × 9.5 inches [105 × 241 mm]).
You can also load a single envelope in the rear paper feed slot, as described in that section.

Note: Do not remove or insert the paper cassette during printing.

1. Close the output tray, if necessary.

Note: As you slide in the output tray, there may be slight resistance and noise. This is normal.

2. Open the front cover.
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3. Pull on the front cover to pull out the lower paper cassette.

4. Slide the edge guides outward.

5. Insert up to 10 envelopes, printable side facedown and flap edge left, as shown.

Note: Make sure the envelope is not sticking out from the end of the cassette.
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6. Slide the edge guides against the envelopes, but not too tightly.

Note: Make sure the envelopes are under the tabs on the edge guides.

7. Keep the cassette flat as you insert it.

Note: The output tray will open automatically when you print.

Always follow these envelope loading guidelines:
• If you have trouble loading a stack of envelopes, press each envelope flat before loading it or load one

envelope at a time.
• Do not load envelopes that are curled, folded, or too thin.
Parent topic: Loading Paper
Related references
Paper Loading Capacity
Related tasks
Loading Paper in Cassette 1 (Upper Cassette)
Loading Paper in Cassette 2 (Lower Cassette)
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Loading Paper in the Rear Paper Feed Slot

Paper Loading Capacity
Load one sheet of paper or one envelope at a time in the rear paper feed slot. See the table here for the
loading capacity of the paper cassettes.

Paper type Load up to this many sheets
Cassette 2 (lower cassette) Cassette 1 (upper cassette)

Plain paper 100 sheets Letter (8.5 × 11 inches —
[216 × 279 mm]) or A4 (8.3 × 11.7
inches [210 × 297 mm])
100 sheets Legal (8.5 × 14 inches
[216 × 357 mm])

EPSON Bright White Paper 80 sheets —
EPSON Presentation Paper Matte
EPSON Premium Presentation 20 sheets —
Paper Matte
EPSON Ultra Premium
Presentation Paper Matte
EPSON Photo Paper Glossy 20 sheets 20 sheets
EPSON Premium Photo Paper
Glossy
EPSON Ultra Premium Photo
Paper Glossy
EPSON Premium Photo Paper
Semi-gloss
EPSON Ultra Premium Photo
Paper Luster
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Paper type Load up to this many sheets
Cassette 2 (lower cassette) Cassette 1 (upper cassette)

EPSON Premium Presentation 1 sheet —
Paper Matte Double-sided
EPSON Photo Quality Self-
adhesive Sheets
EPSON Iron-on Cool Peel Transfer
paper
EPSON Brochure & Flyer Paper
Matte Double-sided
Envelopes 10 envelopes —

Parent topic: Loading Paper

Available EPSON Papers
You can purchase genuine EPSON ink and paper at EPSON Supplies Central at www.epson.com/ink3
(U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an EPSON
authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

Paper Type Size Part number Sheet count
EPSON Bright White Paper Letter (8.5 × 11 inches S041586 500

[216 × 279 mm])
EPSON Photo Paper Glossy 4 × 6 inches (102 × 152 mm) S041809 50

S042038 100
Letter (8.5 × 11 inches S041141 20
[216 × 279 mm]) S041649 50

S041271 100
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Paper Type Size Part number Sheet count
EPSON Premium Photo Paper 4 × 6 inches (102 × 152 mm) S041808 40
Glossy S041727 100

5 × 7 inches (127 × 178 mm) S041464 20
8 × 10 inches (203 × 254 mm) S041465 20
Letter (8.5 × 11 inches S042183 25
[216 × 279 mm]) S041667 50

EPSON Ultra Premium Photo 4 × 6 inches (102 × 152 mm) S042181 60
Paper Glossy S042174 100

5 × 7 inches (127 × 178 mm) S041945 20
8 × 10 inches (203 × 254 mm) S041946 20
Letter (8.5 × 11 inches S042182 25
[216 × 279 mm]) S042175 50

EPSON Ultra Premium Photo Letter (8.5 × 11 inches S041405 50
Paper Luster [216 × 279 mm])
EPSON Premium Photo Paper 4 × 6 inches (102 × 152 mm) S041982 40
Semi-gloss Letter (8.5 × 11 inches S041331 20

[216 × 279 mm])
EPSON Presentation Paper Matte Letter (8.5 × 11 inches S041062 100

[216 × 279 mm])
Legal (8.5 × 14 inches S041067 100
[216 × 357 mm])

EPSON Premium Presentation 8 × 10 inches (203 × 254 mm) S041467 50
Paper Matte Letter (8.5 × 11 inches S041257 50

[216 × 279 mm]) S042180 100
EPSON Premium Presentation Letter (8.5 × 11 inches S041568 50
Paper Matte Double-sided [216 × 279 mm])
EPSON Ultra Premium Letter (8.5 × 11 inches S041341 50
Presentation Paper Matte [216 × 279 mm])
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Paper Type Size Part number Sheet count
EPSON Brochure & Flyer Paper Letter (8.5 × 11 inches S042384 150
Matte Double-sided [216 × 279 mm])
EPSON Photo Quality Self- A4 (8.3 × 11.7 inches S041106 10
adhesive Sheets [210 × 297 mm])
EPSON Iron-on Cool Peel Transfer Letter (8.5 × 11 inches S041153 10
paper [216 × 279 mm])
EPSON Velvet Fine Art Paper Letter (8.5 × 11 inches S041636 20

[216 × 279 mm])

Parent topic: Loading Paper

Borderless Paper Type Compatibility
You can print borderless photos on compatible paper types in compatible sizes:

Borderless Paper Types
• EPSON Photo Paper Glossy
• EPSON Premium Photo Paper Glossy
• EPSON Ultra Premium Photo Paper Glossy
• EPSON Premium Photo Paper Semi-gloss
• EPSON Ultra Premium Photo Paper Luster
• EPSON Premium Presentation Paper Matte
• EPSON Ultra Premium Presentation Paper Matte

Borderless Paper Sizes
• 3.5 × 5 inches (89 × 127 mm)
• 4 × 6 inches (102 × 152 mm)
• 16:9 wide (4 × 7.1 inches [102 × 181 mm])
• 5 × 7 inches (127 × 178 mm)
• 8 × 10 inches (203 × 254 mm)
• Letter (8.5 × 11 inches [216 × 279 mm])
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• A4 (8.3 × 11.7 inches [210 × 297 mm])
Parent topic: Loading Paper

Paper or Media Type Settings
For this paper Select this paper Type or Media Type setting
Plain paper Plain Paper/Bright White Paper
EPSON Bright White Paper
EPSON Iron-on Cool Peel Transfer paper
EPSON Photo Quality Self-adhesive Sheets
EPSON Ultra Premium Photo Paper Glossy Ultra Premium Photo Paper Glossy
EPSON Premium Photo Paper Glossy Premium Photo Paper Glossy
EPSON Photo Paper Glossy Photo Paper Glossy
EPSON Presentation Paper Matte Presentation Paper Matte
EPSON Premium Photo Paper Semi-gloss Premium Photo Paper Semi-Gloss
EPSON Ultra Premium Photo Paper Luster Ultra Premium Photo Paper Luster
EPSON Premium Presentation Paper Matte Premium Presentation Paper Matte
EPSON Premium Presentation Paper Matte
Double-sided
EPSON Ultra Premium Presentation Paper Matte
EPSON Brochure & Flyer Paper Matte Double-
sided
EPSON Velvet Fine Art Paper Velvet Fine Art Paper
Envelopes Envelope

Note: The settings listed here are available only when printing from your computer; they do not apply to
your product's control panel settings.

Parent topic: Loading Paper
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Placing Originals on the Product
Follow the instructions here to place your original documents or photos on the product.

Caution: Do not place anything on top of your product or use its cover as a writing surface to avoid
damaging it.

Placing Originals on the Scanner Glass
Placing Originals in the Automatic Document Feeder

Placing Originals on the Scanner Glass
You can place originals up to this size on the scanner glass: Letter (8.5 × 11 inches [216 × 279 mm]) or
A4 (8.3 × 11.7 inches [210 × 297 mm]).
1. Open the document cover.
2. Place your original facedown on the scanner glass with the top of the original facing into the corner

shown. Slide the original to the edges of the indicated corner.

Note: You can place multiple originals on the scanner glass. Just make sure they are at least 0.20
inch (5 mm) away from each other and from the edge of the scanner glass.
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3. If you are copying two book pages onto one sheet, place the book as shown to copy the first page,
then turn the book as shown to copy the second page.

4. Close the document cover gently to keep your original in place.
Parent topic: Placing Originals on the Product
Related topics
Copying
Scanning
Faxing

Placing Originals in the Automatic Document Feeder
You can place multi-page original documents in the Automatic Document Feeder (ADF). Make sure the
originals meet the Automatic Document Feeder specifications before loading them.
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Caution: Make sure your originals are not creased or folded, and do not contain holes, staples, tape, or
other materials that could obstruct the feeder.

1. Open the ADF paper support, and then slide out the output tray extension.

2. Slide the ADF edge guide outward.

3. Fan your stack of originals and tap them gently on a flat surface to even the edges.
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4. Insert the originals into the ADF faceup and top-edge first.

5. Slide the ADF edge guide against the originals, but not too tightly.

Note: If you're using the Letter, 2-up Copy, or A4, 2-up Copy layout, make sure the originals are
loaded as shown.
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Parent topic: Placing Originals on the Product
Related references
Automatic Document Feeder (ADF) Specifications
Related topics
Copying
Scanning
Faxing
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Copying
See the information here to copy documents or photos using your product.

Note: Copies may not be exactly the same size as your originals.

Copying Documents or Photos
Copying and Restoring Photos
Related tasks
Copying onto a CD/DVD

Copying Documents or Photos
You can copy documents or photos onto various sizes and types of paper, including Epson special
papers.
1. Place your original document or photo on the scanner glass, or load your documents in the ADF.
2. Load the paper you want to print on.

Note: Load only the recommended number of sheets.

3. Select Copy.

4. To print more than one copy, press + or – to select the number (up to 99).
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5. Select Color or B&W.
6. Scroll down to view and change additional copy settings, if necessary.
7. When you are ready to copy, press start.

Note: To cancel printing, select Cancel.

Paper Type Settings - Copying
Paper Size Settings - Copying
Copying Options
Parent topic: Copying
Related references
Paper Loading Capacity
Available EPSON Papers
Related topics
Loading Paper
Placing Originals on the Product

Paper Type Settings - Copying
Select a Paper Type setting that matches the paper you loaded.

Paper type loaded Paper Type setting
Plain paper Plain Paper
EPSON Bright White Paper
EPSON Presentation Paper Matte
EPSON Iron-on Cool Peel Transfer paper
EPSON Photo Quality Self-adhesive Sheets
EPSON Premium Presentation Paper Matte Matte
EPSON Ultra Premium Presentation Paper Matte
EPSON Premium Presentation Paper Matte Double-sided
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Paper type loaded Paper Type setting
EPSON Premium Photo Paper Glossy Prem. Glossy
EPSON Premium Photo Paper Semi-gloss
EPSON Ultra Premium Photo Paper Luster
EPSON Ultra Premium Photo Paper Glossy Ultra Glossy
EPSON Photo Paper Glossy Glossy

Parent topic: Copying Documents or Photos

Paper Size Settings - Copying
Select the Paper Size setting that matches the paper you loaded.

Note: You can copy photos only on these paper sizes.

• 4 × 6 inches (102 × 152 mm)
• 5 × 7 inches (127 × 178 mm)
• 8 × 10 inches (203 × 254 mm)
• Letter (8.5 × 11 inches [216 × 279 mm])
• A4 (8.3 × 11.7 inches [210 × 297 mm])
• Legal (8.5 × 14 inches [216 × 357 mm])
Parent topic: Copying Documents or Photos

Copying Options
Select the copying options you want to use for your copies.

Note: Not all options or settings may be available, depending on other copying settings.

Copying option Available settings Description
Density Varying levels Adjusts the lightness or darkness of copies
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Copying option Available settings Description
2-Sided Copying 1>1-Sided Uses the duplexer and ADF to make 2-sided

copies2>2-Sided
1>2-Sided
2>1-Sided

Layout With Border Leaves a small margin around the image
Borderless Expands the image to the edge of the paper

(slight cropping may occur)
A4, 2-up Copy Copies 2 originals onto a single A4-size sheet
Letter, 2-up Copy Copies 2 originals onto a single letter-size sheet
A4, Book/2-up Copies 2 pages of a book or magazine onto a

single A4-size sheet
Letter, Book/2-up Copies 2 pages of a book or magazine onto a

single letter-size sheet
Reduce/Enlarge Custom Size Automatically sizes the image by the percentage

you select
Actual Size Copies at 100% size
Auto Fit Page Automatically sizes the image to fit the selected

paper size setting
Letter->4x6in and other Automatically converts from one size to another
conversions

Paper Size Various sizes Selects the paper size for the copy printout
Paper Type Plain Paper Adjusts printer settings for the selected paper

typeMatte
Prem. Glossy
Ultra Glossy
Glossy

62



Copying option Available settings Description
Paper Source Cassette 1 Copies onto paper loaded in Cassette 1 (upper

cassette)
Cassette 2 Copies onto paper loaded in Cassette 2 (lower

cassette)
Document Type Text Copies a text document

Text & Image Copies a document that includes text and
images

Photo Copies a photograph
Quality Draft Provides lower quality for draft copies (plain

paper only)
Standard Quality Provides good quality for most copies
Best Provides the highest quality for special copies

Documentation Portrait Specifies the orientation of your originals (only
Orientation available when 2>1-Sided or 1>2-Sided isLandscape selected)
Binding Direction Left Edge Specifies the binding edge of your double-sided

originals (only available when 2>1-Sided isTop Edge selected)
Binding Margin Left Edge Specifies the binding edge of your double-sided

copies (only available when 1>2-Sided isTop Edge selected)
Expansion Standard Adjusts the amount of expansion for printing

borderless photosMedium
Minimum

Dry Time Standard Provides longer drying time for 2-sided copies, if
smudges or marks appear on the front of theLong paper when you print on the second side

Longer
Clear All Settings — Restores the copy settings to the default settings

Parent topic: Copying Documents or Photos
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Copying and Restoring Photos
You can restore the colors in faded photos as you copy them.
1. Load photo paper in the product.

2. Press the home button, if necessary.
3. Select More Functions.
4. Select Copy/Restore Photos.

5. Select On.
6. Place up to two original photos on the product.

Note: View the LCD screen for instructions on placing your photos on the product.

7. Press the start button.
8. Press + or – to select one or more copies of the photo (up to 99).
9. If you placed two originals on the scanner, press the left or right arrow button to view the second

original, then press + or – to select one or more copies of the photo (up to 99).
10. To adjust your print and copy settings, do one or more of the following:

• To change the print settings, select Settings, and select the necessary settings.
• To adjust the copy image, select Edit > Photo Adjustments, then select your settings.
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• To crop or zoom into your photo, select Edit > Crop/Zoom, then press the icons displayed on the
LCD screen to crop your image.

11. When you are ready to print, press the start button.

Note: To cancel printing, select Cancel.

Parent topic: Copying
Related references
Paper Loading Capacity
Available EPSON Papers
Paper Type Settings - Copying
Paper Size Settings - Copying
Copying Options
Related tasks
Placing Originals on the Scanner Glass
Related topics
Loading Paper
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Printing From a Computer
Before printing documents or photos from your computer, make sure you have set up your product and
installed its software as described on the Start Here sheet.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website. If you see a Software Update screen, select Enable automatic checking
and click OK. The update scans your system to see if you have the latest product software. Follow the
on-screen instructions.

Printing with Windows
Printing with Mac OS X
Cancelling Printing Using a Product Button
Related tasks
Checking for Software Updates

Printing with Windows
You can print with your product using any Windows printing program, as described in these sections.
Selecting Basic Print Settings - Windows
Selecting Advanced Print Settings - Windows
Selecting Print Layout Options - Windows
Selecting a Printing Preset - Windows
Selecting Double-sided Printing Settings - Windows
Printing Your Document or Photo - Windows
Selecting Default Print Settings - Windows
Changing Automatic Update Options
Parent topic: Printing From a Computer

Selecting Basic Print Settings - Windows
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
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2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:
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4. Select the Quality Option setting that matches your print content and the print quality you want to
use.

5. Select the Source setting that indicates where you loaded the paper or CD/DVD you want to print
on.

6. Select the type of paper you loaded as the Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

7. Select the size of the paper you loaded as the Size setting.

Note: You can also select the User Defined setting to create a custom paper size.

8. Select one of the border options:
• If you are printing a borderless photo, select Borderless.

Note: You must select a compatible borderless paper type and size to print without borders.
Check the borderless paper compatibility list for details.

• If you are printing a document or a photo with borders, select Borders.
9. Select the orientation of your document or photo as shown in the printer settings window.

Note: If you are printing an envelope, select Landscape.

10. To print on both sides of the paper, select a 2-sided printing option.
11. Select any of the available print options.

Note: If you need to access the Epson product support website, click the Online Support button.

Paper Source Options - Windows
Basic Print Options - Windows
Parent topic: Printing with Windows
Related references
Borderless Paper Type Compatibility
Paper or Media Type Settings
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Related tasks
Selecting Double-sided Printing Settings - Windows

Paper Source Options - Windows
You can select any of the available options in the Paper Source menu to print on the paper loaded in that
source.
Auto Cassette Selection

Automatically selects the paper source based on the selected paper size.
Cassette 1

Selects the paper in cassette 1 as the paper source.
Cassette 2

Selects the paper in cassette 2 as the paper source.
Cassette 1 > Cassette 2

Selects the paper in cassette 1 as the paper source and automatically switches to cassette 2 when
cassette 1 is empty.

Rear Paper Feed Slot
Selects the paper in the rear feed slot as the paper source.

CD/DVD
Selects the CD or DVD loaded as the source.

Parent topic: Selecting Basic Print Settings - Windows
Basic Print Options - Windows

You can select any of the basic print options to customize your print. Some options may be pre-selected
or unavailable, depending on other settings you have chosen.
Fix Photo

Improves the color, contrast, and sharpness of flawed photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.

Fix Red-Eye
Reduces or removes red-eye in photos.

Reverse Order
Prints multi-page print jobs last page first.
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Print Preview
Displays a preview of your printout before printing.

Parent topic: Selecting Basic Print Settings - Windows

Selecting Advanced Print Settings - Windows
Select print settings on the Advanced tab to customize the quality and color settings for your printout,
and save your own printing presets.
1. Click the Advanced tab.

You see the advanced print settings:
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2. Select the Paper & Quality Options settings for your printout:
• Select where you loaded the paper or CD/DVD you want to print on.
• Select the type of paper you loaded.

Note: Check the paper type settings list for details.

• Select the print quality setting you want to use.

Note: Check the print quality setting list for details.

• Select the size of the paper you loaded.
• Select Borderless to print a borderless photo, or Borders to print a document or a photo with

borders.

Note: You must select a compatible borderless paper type and size to print without borders.
Check the borderless paper compatibility list for details.

3. Select Portrait or Landscape as the orientation of your document or photo.

Note: If you are printing an envelope, select Landscape.

4. Select any of the available advanced print options.
5. Select any of the available color management options, or turn off color management.
Advanced Print Quality Settings - Windows
Advanced Print Options - Windows
Color Management Options - Windows
Parent topic: Printing with Windows
Related references
Borderless Paper Type Compatibility
Paper or Media Type Settings
Paper Source Options - Windows
Related tasks
Selecting Double-sided Printing Settings - Windows
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Advanced Print Quality Settings - Windows
You can select any of the print quality settings to fine-tune the quality of your print. Some settings may
be unavailable, depending on the paper type and border setting you have chosen.
Draft

For draft printing on photo paper.
Fast Economy

For the fastest printing with draft quality.
Economy

For fast printing with reduced quality.
Normal

For everyday text and image printing.
Fine

For text and graphics with good quality and print speed.
Photo

For photos and graphics with good quality and print speed.
Photo RPM

For the best print quality, but the slowest print speed.
Parent topic: Selecting Advanced Print Settings - Windows

Advanced Print Options - Windows
You can select any of the print options to customize your print. Some options may be unavailable,
depending on other settings you have chosen.
Fix Red-Eye

Reduces or removes red-eye in photos.
High Speed

Speeds up printing, but may reduce print quality.
Edge Smoothing

Smooths jagged edges in low-resolution images such as screen captures or images from the Web.
Print Preview

Displays a preview of your printout before printing.
Black/Grayscale

Prints text and graphics in black or shades of gray.
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Quiet Mode
Lessens noise during printing when you select Plain Paper/Bright White Paper as the paper Type or
Media Type setting.

Parent topic: Selecting Advanced Print Settings - Windows
Color Management Options - Windows

You can adjust the Color Management settings on the Advanced tab to fine-tune the colors in your
printout, or turn off color management in your printer software.
Color Controls

Lets you select a Color Mode setting, individual settings for Brightness, Contrast, Saturation, and
Density, and individual color tones. Depending on the selected color mode, you can also adjust the
midtone density using the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.

ICM
Lets you turn off color management in your printer software using the Off (No Color Adjustment)
option. You can then manage color using only your application software.

Parent topic: Selecting Advanced Print Settings - Windows

Selecting Print Layout Options - Windows
You can select a variety of sizing and layout options for your document or photo on the Page Layout tab.
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• To change the size of your printed document or photo, select the Reduce/Enlarge Document
checkbox and select sizing options.

• To print on both sides of your paper, select the 2-sided printing options.
• To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select

the Multi-Page checkbox and select the options you want.
• To print multiple copies and arrange their print order, select the Copies options.
• To control printing at the edges of borderless images, select a Borderless option:

• To adjust the automatic settings, select Auto Expand as the Enlargement Method setting, then
adjust the Expansion slider (if necessary) to control the amount of image expansion.
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Note: If you select the Min option for the Expansion setting, you may see white borders on your
printed photo.

• To print the borderless image at its actual size without scaling, select Retain Size as the
Enlargement Method setting.

• To add a watermark to your printout, select Watermark settings.
• To rotate or flip the printed image, select the Rotate 180° or Mirror Image checkboxes.
Parent topic: Printing with Windows
Related tasks
Selecting Double-sided Printing Settings - Windows

Selecting a Printing Preset - Windows
For quick access to common groups of print settings, you can select a printing preset.

Note: You can create your own preset by clicking the Save Settings button on the Advanced tab.

1. Click the Shortcuts tab.
You see the available Printing Presets options:
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2. Place your cursor over a Printing Presets option to view its list of settings.
3. Use any of the available options on the screen to control your printing presets.
4. To choose an option for printing, select it.
5. Click OK.
Parent topic: Printing with Windows
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Selecting Double-sided Printing Settings - Windows
You can print on both sides of the paper by selecting one of the 2-sided printing options on the Main or
Page Layout tab. (Some options are not available on the Main tab.)
Automatic double-sided printing is only available if you have loaded plain paper in these sizes: Letter
(8.5 × 11 inches [216 × 279 mm]) and A4 (8.3 × 11.7 inches [210 × 297 mm]).

Note: Some options may be unavailable, depending on other settings you have chosen.

1. Click the Page Layout tab.
2. Select one of the 2-sided printing options:

• Select the Auto checkbox to automatically print your double-sided print job.
• Select the Manual checkbox to print your double-sided print job manually by printing one side and

flipping the paper over to print the other side (recommended for paper types that do not support
automatic duplexing).

3. Select the Folded Booklet checkbox if you want to order the pages of your double-sided print to
create a single-fold booklet.

4. Click the Settings button.
You see this window:
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5. Select the binding options you want to use.
6. Click OK to return to the Page Layout tab.
7. Click the Adjust Print Density button.

You see this window:
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8. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

9. If you selected the Manual document type, select the Adjustments options you want to use.
10. Click OK to return to the Page Layout tab.
11. Print a test copy of your double-sided document to test the selected settings.
12. Follow any instructions displayed on the screen during printing.
Double-sided Printing Options - Windows
Print Density Adjustments - Windows
Parent topic: Printing with Windows
Related tasks
Selecting Basic Print Settings - Windows
Selecting Advanced Print Settings - Windows

Double-sided Printing Options - Windows
You can select any of the double-sided options to set up your double-sided print job.
Binding Edge Options

Select a setting that orients double-sided print binding in the desired direction.
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Binding Margin Options
Select options that define a wider margin to allow for binding.

Booklet Option
Select a binding option to use when creating a folded booklet.

Parent topic: Selecting Double-sided Printing Settings - Windows
Print Density Adjustments - Windows

You can select any of the available options on the Print Density Adjustment window to adjust the print
quality of your double-sided print job.
Print Density

Sets the level of ink coverage for double-sided printing.
Increased Ink Drying Time

Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing to prevent ink smearing.

Parent topic: Selecting Double-sided Printing Settings - Windows

Printing Your Document or Photo - Windows
Once you have selected your print settings, you are ready to save your settings and print.
1. Click OK to save your settings.

You see your application's Print window, such as this one:
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2. Click OK or Print to start printing.
Checking Print Status - Windows
Parent topic: Printing with Windows
Related tasks
Selecting Basic Print Settings - Windows
Selecting Advanced Print Settings - Windows
Selecting Print Layout Options - Windows

Checking Print Status - Windows
During printing, you see this window showing the progress of your print job. It allows you to control
printing and check ink cartridge status.
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• To cancel printing, click Cancel.
• To see print jobs lined up for printing, click Print Queue.
• To check ink status, click Check Ink Levels.
Parent topic: Printing Your Document or Photo - Windows

Selecting Default Print Settings - Windows
When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.
1. Right-click the product icon in the Windows taskbar.
2. Select Printer Settings.

You see the printer settings window:
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3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.
These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.
Changing the Language of the Printer Software Screens
Parent topic: Printing with Windows

Changing the Language of the Printer Software Screens
You can change the language used on the Windows printer software screens.
1. Right-click the product icon in the Windows taskbar.
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2. Select Printer Settings.
You see the printer settings window.

3. Click the Maintenance tab.
You see the maintenance options:

4. Select the language you want to use as the Language setting.
5. Click OK to close the printer software window.
The printer software screens appear in the language you selected the next time you access them.
Parent topic: Selecting Default Print Settings - Windows
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Changing Automatic Update Options
Your printer software for Windows automatically checks for updates to the product software. You can
change how often the software checks for updates or disable this feature.
1. Right-click the product icon in the Windows taskbar.
2. Select Software Update Settings.

You see this window:

3. Do one of the following:
• To change how often the software checks for updates, select a setting in the Check every menu.
• To disable the automatic update feature, select the Never option.

4. Click OK to exit.

Note: If you choose to disable the automatic update feature, you can check for updates manually.

Parent topic: Printing with Windows
Related tasks
Checking for Software Updates

Printing with Mac OS X
You can print with your product using any Mac OS X printing program, as described in these sections.
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Selecting Basic Print Settings - Mac OS X
Selecting Page Setup Settings - Mac OS X
Selecting Print Layout Options - Mac OS X
Selecting Double-sided Printing Settings - Mac OS X
Managing Color - Mac OS X
Selecting Printing Preferences - Mac OS X
Printing Your Document or Photo - Mac OS X
Parent topic: Printing From a Computer

Selecting Basic Print Settings - Mac OS X
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product as the Printer setting.

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.
You see the expanded printer settings window for your product:
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Note: The print window may look different, depending on the version of Mac OS X and the
application you are using.

5. Select the Copies and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.

6. Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.
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7. Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

8. Select Print Settings from the pop-up menu.

You see these settings:

9. Select the Paper Source you wish to print from.
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10. Select the type of paper you loaded as the Media Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

11. Select the Print Quality setting you want to use.
12. Select any of the available print options.
Paper Source Options - Mac OS X
Print Quality Settings - Mac OS X
Print Options - Mac OS X
Parent topic: Printing with Mac OS X
Related references
Paper or Media Type Settings
Related tasks
Selecting Page Setup Settings - Mac OS X
Printing Your Document or Photo - Mac OS X

Paper Source Options - Mac OS X
You can select any of the available options in the Paper Source menu to print from paper loaded in that
source.
Cassette 1

Selects the paper in cassette 1 as the paper source.
Cassette 2

Selects the paper in cassette 2 as the paper source.
Rear Paper Feed Slot

Selects the paper in the rear feed slot as the paper source.
Parent topic: Selecting Basic Print Settings - Mac OS X

Print Quality Settings - Mac OS X
You can select any of the print quality settings to fine-tune the quality of your print. Some settings may
be unavailable, depending on the paper type and border setting you have chosen.
Draft

For draft printing on photo paper.
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Fast Economy
For the fastest printing with draft quality.

Economy
For fast printing with reduced quality.

Normal
For everyday text and image printing.

Fine
For text and graphics with good quality and print speed.

Photo
For photos and graphics with good quality and print speed.

Photo RPM
For the best print quality, but the slowest print speed.

Parent topic: Selecting Basic Print Settings - Mac OS X
Print Options - Mac OS X

You can select any of the print options to customize your print. Some options may be unavailable,
depending on other settings you have chosen.
Expansion

If you selected a borderless paper size setting, this option adjusts the image expansion settings to
control printing at the edges of borderless prints.

Grayscale
Prints text and graphics in black or shades of gray.

Mirror Image
Lets you flip the printed image horizontally.

Note: If you select the Min option for the Expansion setting, you may see white borders on your printed
photo.

Parent topic: Selecting Basic Print Settings - Mac OS X

Selecting Page Setup Settings - Mac OS X
Depending on your application, you may be able to select the paper size and orientation settings from
the print window.
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Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting. If you are printing a borderless
photo, select the Borderless checkbox or a paper size with a Borderless option. You can also
select a custom setting to create a custom paper size.

Note: You must select a compatible borderless paper type and size to print without borders. Check
the borderless paper compatibility list for details.

2. Select the orientation of your document or photo as shown in the print window.

Note: If you are printing an envelope, select the icon.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.

Parent topic: Printing with Mac OS X
Related references
Borderless Paper Type Compatibility

Selecting Print Layout Options - Mac OS X
You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu on the print window.
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• To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

• To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
• To invert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.
Parent topic: Printing with Mac OS X

Selecting Double-sided Printing Settings - Mac OS X
You can print on both sides of the paper by selecting Two-sided Printing Settings from the pop-up
menu on the print window.
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Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network. This screen may be different, depending on the
version of Mac OS X you are using.

1. Select one of the Two-sided Printing options.
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2. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

3. If necessary, customize the Adjustments settings as instructed on the screen.
4. Print a test copy of your double-sided document to test the selected settings.
5. Follow any instructions displayed on the screen during printing.
Double-sided Printing Options and Adjustments - Mac OS X
Parent topic: Printing with Mac OS X

Double-sided Printing Options and Adjustments - Mac OS X
You can select any of the available options in the Two-sided Printing Settings or Output Settings
pop-up menu to set up your double-sided print job.

Two-sided Printing Options
Long-Edge binding

Orients double-sided printed pages to be bound on the long edge of the paper.
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Short-Edge binding
Orients double-sided printed pages to be bound on the short edge of the paper.

Adjustments
Print Density

Sets the level of ink coverage for double-sided printing.
Increased Ink Drying Time

Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing.

Parent topic: Selecting Double-sided Printing Settings - Mac OS X

Managing Color - Mac OS X
You can adjust the Color Matching and Color Options settings to fine-tune the colors in your printout, or
turn off color management in your printer software.
1. Select Color Matching from the pop-up menu in the print window.

2. Select one of the available options.
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3. Select Color Options from the pop-up menu in the print window.

Note: The available settings on the Color Options menu depend on the option you selected on the
Color Matching menu.

4. Select one of the available options.
Color Matching and Color Options - Mac OS X
Parent topic: Printing with Mac OS X

Color Matching and Color Options - Mac OS X
You can select from these settings on the Color Matching and Color Options menus.

Color Matching Settings
EPSON Color Controls

Lets you manage color using controls in your printer software, or turn off color management.
ColorSync

Prints using standard color profiles for your product and paper to help match image colors. You can
customize the conversion method and filter settings on the ColorSync pop-up menu in the print
window.
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Color Options Settings
Manual Settings

Lets you select manual color adjustments. Click the arrow next to Advanced Settings and select
settings for Brightness, Contrast, Saturation, and individual color tones. You can also select a color
Mode setting for printing photos and graphics and the Fix Red-Eye setting to reduce or remove red-
eye in photos. Depending on the selected color mode, you can also adjust the midtone density using
the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos. Click the arrow next to Advanced
Settings and select the Fix Red-Eye setting to reduce or remove red-eye in photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.

Off (No Color Adjustment)
Turns off color management in your printer software so you can manage color using only your
application software.

Parent topic: Managing Color - Mac OS X

Selecting Printing Preferences - Mac OS X
You can select printing preferences that apply to all the print jobs you send to your product.
1. In the Apple menu or the Dock, select System Preferences.
2. Select Print & Fax or Print & Scan, select your product, and select Options & Supplies.
3. Select Driver.

You see this screen:
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4. Select any of the available printing preferences.
5. Click OK.
Printing Preferences - Mac OS X
Parent topic: Printing with Mac OS X

Printing Preferences - Mac OS X
You can select from these settings on the Driver tab.
Thick paper and envelopes

Prevents ink from smearing when you print on envelopes or other thick paper.
Skip Blank Page

Ensures that your product does not print pages that contain no text or images.
Quiet Mode

Lessens noise during printing when you select Plain Paper/Bright White Paper as the paper Type or
Media Type setting.

Automatic Cassette Switching
Automatically switches to the other cassette when one of the cassettes runs out of paper.

High Speed Printing
Speeds up printing, but may reduce print quality.
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Warning Notifications
Lets you choose whether or not to receive warning notifications from the printer software when ink is
low.

Parent topic: Selecting Printing Preferences - Mac OS X

Printing Your Document or Photo - Mac OS X
Once you have selected your print settings, you are ready to print.
Click Print at the bottom of the print window.

Checking Print Status - Mac OS X
Parent topic: Printing with Mac OS X

Checking Print Status - Mac OS X
During printing, you can view the progress of your print job, control printing, and check ink cartridge
status.
1. Click the printer icon when it appears in the Dock.

You see the print status window:
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2. Select the following options as necessary:
• To cancel printing, click the print job and click Delete.
• To pause a print job, click the print job and click Hold. To resume a print job, click the print job

marked "Hold" and click Resume.
• To pause printing for all queued print jobs, click Pause Printer.
• To check ink status, click Supply Levels.

Parent topic: Printing Your Document or Photo - Mac OS X

Cancelling Printing Using a Product Button
If you need to cancel printing, select Cancel on the LCD display.
Parent topic: Printing From a Computer
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Scanning
You can scan original documents or photos and save them as digital files.
Starting a Scan
Selecting EPSON Scan Settings
Scanning with Mac OS X 10.6/10.7/10.8 Using Image Capture
Scanning Special Projects

Starting a Scan
After placing your original documents or photos on your product for scanning, start scanning using one of
these methods.
Starting a Scan Using the Product Control Panel
Starting a Scan Using the EPSON Scan Icon
Starting a Scan from a Scanning Program
Parent topic: Scanning
Related topics
Placing Originals on the Product

Starting a Scan Using the Product Control Panel
You can scan an image to your computer using your product's touch panel buttons.
Your product automatically selects suitable default scan settings, but you can view or change them as
necessary.
1. Make sure you installed the product software and connected the product to your computer or

network.

2. Press the home button, if necessary.
3. Select Scan.

The scan options are displayed:
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4. Scroll up or down to view additional scan options, then select the one you want.
• Scan to Memory Card saves your scan file on a memory card and lets you select the file format,

quality, and other settings.
• Scan to Cloud sends your scanned files to a destination that you have registered with EPSON

Connect.
• Scan to PC saves your scan file directly to your computer or as an image capture in Mac OS X

10.6/10.7/10.8.
• Scan to PC (PDF) saves your scan as a PDF file to your computer or as an image capture in Mac

OS X 10.6/10.7/10.8.
• Scan to PC (Email) scans your original and attaches it to a message in your e-mail program. You

can select the e-mail program you want to use and resize your image, if necessary, from an option
screen on your computer.

Note: This works with MAPI-type email such as Microsoft Outlook, Windows Live Mail, Mac Mail,
and Entourage, but not web-based email such as Gmail.

• Scan to PC (WSD) lets you manage wireless scanning in Windows 7 or Windows Vista (English
only).

5. To scan to your PC, you first need to select how you connected your product to your computer:
• If your product is connected directly to your computer with a USB cable, select USB Connection.
• If your product is connected to your computer over a network, select the computer name from the

list.
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6. Press the start button to start scanning.
Scan to Memory Card Options
Changing Default Scan Button Settings
Parent topic: Starting a Scan
Related tasks
Using EPSON Scan to Cloud

Scan to Memory Card Options
Select the Scan to Memory Card options you want to use.

Scan to Memory Card Available options Description
setting
JPEG — JPEG: for photos
PDF PDF: for documents
Color — Select color or black-and-white

scansB&W
Contrast Various levels Decrease or increase image

contrast
2-Sided Scanning Off Automatic 2-sided scanning for

documents in the ADFOn
Scan Area Letter Selects the page size for documents

or special settings for photos.Legal
Auto Cropping: for photos withA4 dark edges

Auto Cropping Max Area: for most photos
Max Area

Document Text Selects the type of original you are
scanningPhotograph
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Scan to Memory Card Available options Description
setting
Resolution 200 dpi 200 dpi: for e-mailing or posting on

the web300 dpi
300 dpi: for printing or OCR600 dpi
600 dpi: for highest quality printing

Document Orientation Portrait Specifies the orientation of your
originalsLandscape

Binding Direction Left Edge Specifies the binding edge of your
double-sided originalsTop Edge

Parent topic: Starting a Scan Using the Product Control Panel
Changing Default Scan Button Settings

You can view or change the default scan settings your product uses when you scan to your computer
using the product buttons. You do this using the Event Manager program.
1. Do one of the following to open Event Manager:

• Windows: Click or Start > All Programs or Programs > EPSON Software > Event
Manager.

• Mac OS X: Open the Applications folder, click Epson Software, and click Event Manager.
2. Open the Scanner (Windows) or Select Scanner (Mac OS X) drop-down list and select your

product, if necessary.
3. Click Make Job Settings.
4. Open the Edit Job Settings drop-down list and select the scan button settings you want to view or

change.
5. Change the settings as necessary.
6. Click OK.
Parent topic: Starting a Scan Using the Product Control Panel

Starting a Scan Using the EPSON Scan Icon
You can start the EPSON Scan program to select scan settings, scan, and save the scanned image to a
file.
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• Windows: Double-click the EPSON Scan icon on your computer desktop.
• Mac OS X: Open the Applications folder, open the Epson Software folder, and double-click the

EPSON Scan icon.

Note: With Mac OS X 10.6, 10.7, or 10.8, in addition to scanning with Image Capture, you can
download and install EPSON Scan scanning software. EPSON Scan provides additional image
adjustment and photo correction features for enhancing scanned images, and provides an interface
for TWAIN-compliant OCR scanning software, such as ABBYY FineReader. To download EPSON
Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

You see an EPSON Scan window like this:
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Parent topic: Starting a Scan
Related tasks
Scanning with Mac OS X 10.6/10.7/10.8 Using Image Capture
Related topics
Selecting EPSON Scan Settings
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Starting a Scan from a Scanning Program
You can start EPSON Scan from a scanning program to select scan settings, scan, and open the
scanned image in the program.

Note: With Mac OS X 10.6, 10.7, or 10.8, in addition to scanning with Image Capture, you can download
and install EPSON Scan scanning software. EPSON Scan provides additional image adjustment and
photo correction features for enhancing scanned images, and provides an interface for TWAIN-
compliant OCR scanning software, such as ABBYY FineReader. To download EPSON Scan, visit
Epson's driver download site (U.S. downloads or Canadian downloads).

1. Open your scanning program and select its scanning option. (See your scanning program help for
instructions.)

2. Select your product.

Note: In certain programs, you may need to select your product as the "source" first. If you see a
Select Source option, choose it and select your product. With Windows, do not select a WIA option
for your product; it will not work correctly.

You see an EPSON Scan window like this:
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Parent topic: Starting a Scan

Selecting EPSON Scan Settings
After starting EPSON Scan, you can select settings in various modes to customize your scan.
Scan Modes
Selecting the Scan Mode
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Scanning in Office Mode
Scanning in Home Mode
Scanning in Professional Mode
Image Preview Guidelines
Scan Resolution Guidelines
Selecting Scan File Settings
Parent topic: Scanning

Scan Modes
EPSON Scan provides a choice of scan modes with different levels of control over your settings.
Office Mode

You can quickly scan text documents and adjust them on a preview screen. You can also select
various image adjustment options and preview your scanned image.

Home Mode
You can select setting groups based on the type of content you are scanning. You can also select
various image adjustment options, and preview and size your scanned image.

Professional Mode
You can manually customize all available settings, and preview and size your scanned image.

Note: You have to place your original on the scanner glass when using Home mode.

Parent topic: Selecting EPSON Scan Settings
Related tasks
Selecting the Scan Mode

Selecting the Scan Mode
Select the EPSON Scan mode you want to use from the Mode box in the upper right corner of the
EPSON Scan window:
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Parent topic: Selecting EPSON Scan Settings
Related tasks
Scanning in Office Mode
Scanning in Home Mode
Scanning in Professional Mode

Scanning in Office Mode
When you scan in Office Mode, EPSON Scan automatically saves your scanned file in JPEG format in
your operating system's Pictures or My Pictures folder, or opens it in your scanning program. You can
select settings, preview, and change the scanned file settings as necessary.
1. Start EPSON Scan and select Office Mode as the Mode setting.

You see this window:
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2. Select the Image Type setting that matches your original.
3. Select the Document Source setting indicating where you placed your original. To scan a 2-sided

document in the ADF, select ADF-Double-sided.

Note: If you are using the ADF, remove any documents from the scanner glass.

4. Select the Size and Orientation settings that match your original.
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5. Select the Resolution setting you want to use for your scan.
6. Click the Preview button.

EPSON Scan previews your original and displays the result in a separate Preview window.
7. If you are using the ADF, reinsert your original into the ADF.
8. If desired, select the area in your preview image that you want to scan (scanned image area).

Note: You cannot select a scan area if you chose ADF-Double-sided as the Document Source
setting.

9. Select any of the image adjustment settings you want to use. Before making adjustments, click the
image or scanned image area in the Preview window.

10. Click Scan.
You see the File Save Settings window.

11. Change any of the necessary file save settings and click OK.
EPSON Scan scans your original, and saves the file in the selected folder or opens it in your scanning
program. If the file was saved directly to your computer, you see the file in the Windows Explorer or Mac
OS X Finder, where you can view and print the image, if desired.
Available Document Source Settings - Office Mode
Selecting a Scan Area - Office Mode
Available Image Adjustments - Office Mode
Parent topic: Selecting EPSON Scan Settings
Related concepts
Image Preview Guidelines
Scan Resolution Guidelines
Related tasks
Selecting Scan File Settings

Available Document Source Settings - Office Mode
You can select these Document Source options in EPSON Scan Office Mode.
Auto Detect

Automatically detects where the originals are placed on your product for scanning.
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ADF - Single-sided
Selects the Automatic Document Feeder as the location where the originals are placed on your
product for single-sided scanning.

ADF - Double-sided
Selects the Automatic Document Feeder as the location where the originals are placed on your
product for double-sided scanning.

Document Table
Selects the scanner glass as the location where the originals are placed on your product for scanning.

Parent topic: Scanning in Office Mode
Selecting a Scan Area - Office Mode

You can select a specific area in your preview image to include in your scanned image. You can select
the entire image area or a portion of it. You can even select multiple scan areas to create multiple
scanned images of different areas.
You can also use the scan area to select specific Image Adjustments settings for a scanned image. Just
be sure to click inside the scan area before selecting the settings.
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1. In the Preview window, click the Auto Locate icon to create a marquee (dotted line) on the
preview image.

2. Do the following, as necessary, to work with the selected scan area:
• If the marquee is correct, continue with the next step.
• To move the marquee, click inside the scan area and drag the marquee where you want it.
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• To resize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edges where you want them. (Hold down the Shift key as you resize the marquee to
retain the same width/height proportions.)

• To create additional marquees (up to 50, if available), click the Copy Marquee icon to copy the
existing marquee and paste it on the preview image.

• To delete a marquee, click the marquee, then click the Delete Marquee icon.
3. Click inside each scan area and make any necessary settings in the EPSON Scan window.
Parent topic: Scanning in Office Mode

Available Image Adjustments - Office Mode
You can select these Image Adjustments options in EPSON Scan Office Mode.

Note: Select the Image Option checkbox if you need to set any of the grayed-out image adjustments.
Not all adjustment settings may be available, depending on the Image Type setting.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)
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Text Enhancement
Sharpens the appearance of letters in text documents.

Auto Area Segmentation
Makes grayscale images clearer and text recognition more accurate by separating the text from the
graphics.

Color Enhance
Enhances the red, green, or blue shades in the scanned image.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Parent topic: Scanning in Office Mode

Scanning in Home Mode
When you scan in Home Mode, EPSON Scan automatically saves your scanned file in JPEG format in
your operating system's Pictures or My Pictures folder, or opens it in your scanning program. You can
select settings, preview, and change the scanned file settings as necessary.

Note: You must place your original on the scanner glass when using Home mode.

1. Start EPSON Scan and select Home Mode as the Mode setting.
You see this window:
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2. Select the Document Type setting that matches your original, such as Photograph or Text/Line
Art.

3. Select the Image Type setting that matches your original.
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4. Select the way you plan to use your scanned image as the Destination setting. (The Resolution
setting is selected automatically based on the Destination setting you choose.)
• Screen/Web: Select this option for images you will e-mail, view on a computer screen, or post on

the web.
• Printer: Select this option for images you will print or documents you will convert to editable text

using OCR (Optical Character Recognition) software.
• Other: Select this option if you want to select a custom resolution for your image.

5. If you selected Other in the last step, select the Resolution setting you want to use for your scan.
6. Click the Preview button.

EPSON Scan previews your original and displays the result in a separate Preview window.
7. If desired, select the area in your preview image that you want to scan (scan area).
8. Select any of the image adjustment settings you want to use. Before making adjustments, click the

image or scan area in the Preview window.
9. If you want to reduce or enlarge your image as you scan, select the Target Size setting you want to

use.
10. Click Scan.

You see the File Save Settings window.
11. Change any of the necessary file save settings and click OK.
EPSON Scan scans your original, and saves the file in the selected folder or opens it in your scanning
program. If the file was saved directly to your computer, you see the file in the Windows Explorer or Mac
OS X Finder, where you can view and print the image, if desired.
Selecting a Scan Area - Home Mode
Available Image Adjustments - Home Mode
Selecting a Scan Size - Home Mode
Parent topic: Selecting EPSON Scan Settings
Related concepts
Image Preview Guidelines
Scan Resolution Guidelines
Related tasks
Selecting Scan File Settings
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Selecting a Scan Area - Home Mode
You can select a specific area in your preview image to include in your scanned image. You can select
the entire image area or a portion of it. You can even select multiple scan areas to create multiple
scanned images of different areas (Normal Preview mode only).
You can also use the scan area to select specific Image Adjustments settings for a scanned image. Just
be sure to click inside the scan area before selecting the settings.
1. Do one of the following to select your scan area in the Preview image:

• Thumbnail preview: Your scan area is selected automatically, but you can change it. Place your
cursor in one corner of the desired scan area, then click and drag the cursor to the opposite corner
to create a marquee (dotted line) on the preview image.
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• Normal preview: Click the Auto Locate icon to create a marquee (dotted line) on the preview
image.
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2. Do the following, as necessary, to work with the selected scan area:
• If the marquee is correct, continue with the next step.
• To move the marquee, click inside the scan area and drag the marquee where you want it.
• To resize the scan area, place your cursor over the edge or corner of the marquee, then click and

drag the edges where you want them. (Hold down the Shift key as you resize the marquee to
retain the same width/height proportions.)
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• Normal preview: To create additional marquees (up to 50), click the Copy Marquee icon to
copy the existing marquee and paste it on the preview image.

• To delete a marquee, click the marquee, then click the Delete Marquee icon.
3. Click inside the scan area and make any necessary settings in the EPSON Scan window.
Parent topic: Scanning in Home Mode

Available Image Adjustments - Home Mode
You can select these Image Adjustments options in EPSON Scan Home Mode.

Note: Select the Image Option checkbox if you need to set any of the grayed-out image adjustments.
Not all adjustment settings may be available, depending on the Document Type and Image Type setting.
Click the Brightness button to access additional settings.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Color Restoration
Restores the colors in faded photos automatically.

Backlight Correction
Removes shadows from photos that have too much background light.

Dust Removal
Removes dust marks from your originals automatically.

Text Enhancement
Sharpens the appearance of letters in text documents.
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Auto Area Segmentation
Makes grayscale images clearer and text recognition more accurate by separating the text from the
graphics.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Parent topic: Scanning in Home Mode
Selecting a Scan Size - Home Mode

You can reduce or enlarge the size of your image as you scan. You can also select a specific scan size,
such as a common photo size like 4 × 6 inches (102 × 152 mm). This places a scan area of that size on
the preview image so you can use it to help crop the image in the correct proportions.
1. Click the Preview button to preview your image.
2. In the EPSON Scan window, select the size you want your scanned image to be from the Target

Size list.

Note: If you need to rotate the orientation of the target size for your image, click the Orientation
icon.

A marquee (dotted line) appears on your preview image proportioned for the size you selected.
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3. Do the following, as necessary, to work with the selected scan area:
• To move the marquee, click inside the scan area and drag the marquee where you want it.
• To resize the scan area, place your cursor over the edge or corner of the marquee, then click and

drag the edge where you want it.
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4. To create a scanned image size that is not available in the Target Size list, click the Customize
option.

5. Name the custom size, enter the size, click Save, and click OK. Then create a scan area on the
preview image.
The marquee is automatically proportioned for your custom scan size.

Parent topic: Scanning in Home Mode

Scanning in Professional Mode
When you scan in Professional Mode, EPSON Scan automatically saves your scanned file in JPEG
format in your operating system's Pictures or My Pictures folder, or opens it in your scanning program.
You can select settings, preview, and change the scanned file settings as necessary.
1. Start EPSON Scan and select Professional Mode as the Mode setting.

You see this window:
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2. Select the Document Type setting that matches your original, such as Reflective for documents or
photos.

3. Select the Document Source setting indicating where you placed your original. To scan a 2-sided
document in the ADF, select ADF - Double-sided.

Note: If you are using the ADF, remove any documents from the scanner glass.

4. Select the specific type of original you are scanning as the Auto Exposure Type setting: Document
or Photo.

5. Select the details of your original and how you want it scanned as the Image Type setting.
6. Select the Resolution setting you want to use for your scan.
7. Click the Preview button.

EPSON Scan previews your original and displays the result in a separate Preview window.
8. If you are using the ADF, reinsert your original into the ADF.
9. If desired, select the area in your preview image that you want to scan (scan area).

Note: You cannot select a scan area if you chose ADF-Double-sided as the Document Source
setting.

10. Select any of the image adjustment settings you want to use. Before making adjustments, click the
image or scanned image area in the Preview window.

11. If you want to reduce or enlarge your image as you scan, select the Target Size setting you want to
use.

Note: You cannot select a target size if you chose ADF-Double-sided as the Document Source
setting.

12. Click Scan.
You see the File Save Settings window.

13. Change any of the necessary file save settings and click OK.
EPSON Scan scans your original, and saves the file in the selected folder or opens it in your scanning
program. If the file was saved directly to your computer, you see the file in the Windows Explorer or Mac
OS X Finder, where you can view and print the image, if desired.
Available Document Source Settings - Professional Mode
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Available Image Types - Professional Mode
Selecting a Scan Area - Professional Mode
Available Image Adjustments - Professional Mode
Selecting a Scan Size - Professional Mode
Parent topic: Selecting EPSON Scan Settings
Related concepts
Image Preview Guidelines
Scan Resolution Guidelines
Related tasks
Selecting Scan File Settings

Available Document Source Settings - Professional Mode
You can select these Document Source options in EPSON Scan Professional Mode.
Document Table

Selects the scanner glass as the location where the originals are placed on your product for scanning.
ADF - Single-sided

Selects the Automatic Document Feeder as the location where the originals are placed on your
product for single-sided scanning.

ADF - Double-sided
Selects the Automatic Document Feeder as the location where the originals are placed on your
product for double-sided scanning.

Parent topic: Scanning in Professional Mode
Available Image Types - Professional Mode

You can select these Image Type options in EPSON Scan Professional Mode.
24-bit Color

Select this setting for color photos.
Color Smoothing

Select this setting for color graphic images, such as charts or graphs.
8-bit Grayscale

Select this setting for black-and-white photos.
Black & White

Select this setting for black text documents or line art.
Parent topic: Scanning in Professional Mode
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Selecting a Scan Area - Professional Mode
You can select a specific area in your preview image to include in your scanned image. You can select
the entire image area or a portion of it. You can even select multiple scan areas to create multiple
scanned images of different areas (Normal Preview mode only).
You can also use the scan area to select specific Image Adjustments settings for a scanned image. Just
be sure to click inside the scan area before selecting the settings.

Note: In Professional Mode, the default Preview mode is Normal mode. To use Thumbnail Preview
mode instead, select the Thumbnail checkbox beneath the Preview button (if available), then click the
Preview button to preview your image again.

1. Do one of the following to select your scan area in the Preview image:

• Normal preview: Click the Auto Locate icon to create a marquee (dotted line) on the preview
image.
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• Thumbnail preview: Your scan area is selected automatically, but you can change it. Place your
cursor in one corner of the desired scan area, then click and drag the cursor to the opposite corner
to create a marquee (dotted line) on the preview image.
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2. Do the following, as necessary, to work with the selected scan area:
• If the marquee is correct, continue with the next step.
• To move the marquee, click inside the scan area and drag the marquee where you want it.
• To resize the scan area, place your cursor over the edge or corner of the marquee, then click and

drag the edges where you want them. (Hold down the Shift key as you resize the marquee to
retain the same width/height proportions.)
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• Normal preview: To create additional marquees (up to 50, if available), click the Copy
Marquee icon to copy the existing marquee and paste it on the preview image.

• To delete a marquee, click the marquee, then click the Delete Marquee icon.
3. Click inside the scan area and make any necessary settings in the EPSON Scan window.
Parent topic: Scanning in Professional Mode

Available Image Adjustments - Professional Mode
You can select these Adjustments options in EPSON Scan Professional Mode.

Note: Not all adjustment settings may be available, depending on the Image Type setting.

Click the image adjustment icon to access additional settings.
Click the + (Windows) or (Mac OS X) icon next to a setting to change the level of adjustment.
Unsharp Mask

Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.
Descreening

Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)
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Color Restoration
Restores the colors in faded photos automatically.

Backlight Correction
Removes shadows from photos that have too much background light.

Dust Removal
Removes dust marks from your originals automatically.

Auto Exposure
Automatically adjusts the image exposure settings when you click the Auto Exposure icon. To
automatically adjust image exposure settings continuously, click the Configuration button, click the
Color tab, and select Continuous auto exposure. You can adjust the level of exposure adjustment
using a slider.

Histogram Adjustment
Provides a graphical interface for adjusting highlight, shadow, and gamma levels individually. (For
advanced users only.) Click the histogram icon to access the settings.

Tone Correction
Provides a graphical interface for adjusting tone levels individually. (For advanced users only.) Click
the tone correction icon to access the settings.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Saturation
Adjusts the density of colors in the overall image.

Color Balance
Adjusts the balance of colors in the overall image.

Color Palette
Provides a graphical interface for adjusting mid-tone levels, such as skin tones, without affecting the
highlight and shadow areas of the image. (For advanced users only.) Click the Color Palette icon
to access the settings.

Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Parent topic: Scanning in Professional Mode
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Selecting a Scan Size - Professional Mode
You can reduce or enlarge the size of your image as you scan. You can also select a specific scan size,
such as a common photo size like 4 × 6 inches (102 × 152 mm). This places a scan area of that size on
the preview image so you can use it to help crop the image in the correct proportions.
1. Click the Preview button to preview your image.
2. In the EPSON Scan window, select the size you want your scanned image to be from the Target

Size list.

Note: If you need to rotate the orientation of the target size for your image, click the orientation
icon.

A marquee (dotted line) appears on your preview image proportioned for the size you selected.
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3. Do the following, as necessary, to work with the selected scan area:
• To move the marquee, click inside the scan area and drag the marquee where you want it.
• To resize the scan area, place your cursor over the edge or corner of the marquee, then click and

drag the edge where you want it.
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4. To create a scanned image size that is not available in the Target Size list, click the Customize
option.

5. Name the custom size, enter the size, click Save, and click OK. Then create a scan area on the
preview image.
The marquee is automatically proportioned for your custom scan size.

6. To use additional sizing tools, click the + (Windows) or (Mac OS X) icon next to the Target Size
setting and select options as desired.

• Scale: Reduces or enlarges your image by the percentage you enter.
• Trimming: Turns automatic image cropping on or off.
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• Unlock icon: Unlocks the width/height proportions of the scanned image size so you can adjust
it without constraint.

Parent topic: Scanning in Professional Mode

Image Preview Guidelines
You can preview your scanned image so you can adjust the scan settings using the preview as a guide.
There are two types of preview available, depending on the scan mode and selected settings:
Thumbnail preview

A thumbnail preview displays your previewed images as thumbnails with the scanned image area and
exposure automatically selected. If the Thumbnail checkbox is selected, clicking the Preview button
opens a thumbnail preview.

Normal preview
A normal preview displays your previewed images in their entirety so you can select the scanned
image area and other settings manually. If the Thumbnail checkbox is deselected, clicking the
Preview button opens a normal preview.

Parent topic: Selecting EPSON Scan Settings

Scan Resolution Guidelines
If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the
resolution from the default resolution set by EPSON Scan. Follow these guidelines to determine the
resolution setting you need:
• You will enlarge the image as you scan it.

If you will enlarge the image using EPSON Scan's Target Size setting (Home and Professional modes
only), you do not need to increase the Resolution setting.

• You will scan the image at its original size, but enlarge it later in an image-editing program.
Increase EPSON Scan's Resolution setting in your scan. Increase the resolution by the same amount
you will increase the image size to retain a high image quality. For example, if the resolution is 300 dpi
(dots per inch) and you will double the image size later, change the Resolution setting to 600 dpi.

• You will scan the image at 100% or smaller size.
Select EPSON Scan's Resolution setting based on how you will use the scanned image:
• E-mail/view on a computer screen/post on the web: 96 to 150 dpi
• Print/convert to editable text (OCR): 300 dpi
• Fax: 200 dpi
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Parent topic: Selecting EPSON Scan Settings

Selecting Scan File Settings
You can select the location, name, and format of your scan file on the File Save Settings window. You
can also select various optional settings that control how EPSON Scan behaves when you scan and
save files.

The File Save Settings window may appear after you click Scan on the EPSON Scan window. You may
also be able to access the window by clicking the icon on the EPSON Scan window.
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1. Do one of the following to select the folder in which you want to save your scanned image:
• Click the button for one of the displayed folders.
• Click the Other button, click the Browse or Choose button, and select a folder.

2. Type in a stem file name in the Prefix field. This name is used along with numbers to automatically
name your scanned files.

3. Select a different number as the Start Number setting, if you like.
4. Select the file format you want to use in the Image Format Type menu.
5. If your file format provides optional settings, click the Options button to select them.
6. Choose any of the optional settings you want to use by selecting their checkboxes.
7. Click OK.
Available Scanned File Types and Optional Settings
Parent topic: Selecting EPSON Scan Settings

Available Scanned File Types and Optional Settings
You can select from a variety scanned file types and optional settings on the File Save Settings window
in EPSON Scan.

File Formats
Bitmap (*.bmp)

A standard image file format for most Windows programs.
JPEG (*.jpg)

An image format that lets you highly compress image data. However, the higher the compression, the
lower the image quality. (The Tiff format is recommended when you need to modify or retouch your
scanned image.)

Multi-Tiff (*.tif)
A Tiff file format when multiple pages are saved to the same file, allowing you to edit the images using
a compatible program.

PDF (*.pdf)
A document format that is readable by Windows and Mac OS X systems using Adobe Reader,
Acrobat, or other programs. You can save multi-page documents in one PDF file.

PICT (*.pct)
A standard image file format for most Mac OS X programs.
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PRINT Image Matching II (*.jpg or *.tif)
File formats that include EPSON PRINT Image Matching II data for enhanced quality and a wider
color range (does not affect the way the image displays on the screen).

Tiff (*.tif)
A file format created for exchanging data between many programs, such as graphic and DTP
software.

Optional Settings
Overwrite any files with the same name

Select to overwrite previous files with the same names.
Show this dialog box before next scan

Select to have the File Save Settings window appear automatically before you scan.
Open image folder after scanning

Select to have Windows Explorer or Mac OS X Finder automatically open to the folder where your
scanned image is saved after scanning.

Show Add Page dialog after scanning
If you are scanning a multi-page document using the PDF or Multi-Tiff format, select to display a
prompt for scanning additional pages after the first page is scanned.

Parent topic: Selecting Scan File Settings

Scanning with Mac OS X 10.6/10.7/10.8 Using Image Capture
With Mac OS X 10.6/10.7/10.8, you can scan with your product using an image-editing application such
as Image Capture.

Note: With Mac OS X 10.6, 10.7, or 10.8, in addition to scanning with Image Capture, you can download
and install EPSON Scan scanning software. EPSON Scan provides additional image adjustment and
photo correction features for enhancing scanned images, and provides an interface for TWAIN-
compliant OCR scanning software, such as ABBYY FineReader. To download EPSON Scan, visit
Epson's driver download site (U.S. downloads or Canadian downloads).

1. Open an image editing application, such as Image Capture.
2. Select your EPSON product from the DEVICES or SHARED list, if necessary.
3. If you see the Show Details button, click it.

If you are scanning an item on the scanner glass, your product begins a preview scan.

140

http://www.epson.com/support
http://www.epson.ca/support


4. Select the Scan Mode setting indicating where you placed your original (if available). Select any
other scan settings as necessary.

5. Select the folder in which you want to save your scanned file in the Scan To pop-up menu.
6. Click Scan.
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Your scanned file is saved in the folder you selected.
Available Scan Settings - Mac OS X Image Capture
Parent topic: Scanning

Available Scan Settings - Mac OS X Image Capture
You can select these scan settings in your imaging editing application for Mac OS X.
Unsharp Mask

Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.
Descreening

Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Backlight Correction
Removes shadows from photos that have too much background light.

Dust Removal
Removes dust marks from your originals automatically.

Color Restoration
Restores the colors in faded photos automatically.

Parent topic: Scanning with Mac OS X 10.6/10.7/10.8 Using Image Capture

Scanning Special Projects
Your product's scanning software offers various options to help you quickly complete special scan
projects.
Scanning to a PDF File
Restoring Photo Colors as You Scan
Convert Scanned Documents to Editable Text (OCR)
Parent topic: Scanning

Scanning to a PDF File
Using EPSON Scan, you can scan a multi-page document and save it in one PDF (Portable Document
Format) file on your computer.
1. Place your original on your product for scanning.
2. Start EPSON Scan.

142



3. Select the scan mode you want to use.
4. Select the scan settings for your scan.
5. Preview your image.
6. When you finish selecting all your settings, click Scan.

You see the File Save Settings window.

7. Select PDF as the Type setting.
8. Select any other settings you want to use on the File Save Settings window. Click the Options

button to access additional settings.
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9. Click OK.
EPSON Scan scans your document and you see this window:

10. Choose one of the following options on the screen:
• If you are scanning only one page, click Save File.
• If you need to scan additional pages in a document, click Add page. Place additional pages on

the product for scanning, click Scan, and repeat until you have scanned all the pages. When you
are finished, click Save File.

• If you need to delete or reorder the scanned pages, click Edit page. Delete or reorder the pages
using the icons that appear on the bottom of the editing window. When you are finished, click OK.

Note: If you installed an OCR (Optical Character Recognition) program, you may see a screen
indicating the program is converting your page to text. Wait until the program re-scans the page and
close the program, if necessary.

11. Click Close to exit the EPSON Scan window, if necessary.
EPSON Scan scans your original, and saves the PDF file in the selected folder or opens it in your
scanning program. If the file was saved directly to your computer, you see the file in the Windows
Explorer or Mac OS X Finder, where you can view and print the document, if desired.
Parent topic: Scanning Special Projects
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Related tasks
Starting a Scan Using the EPSON Scan Icon
Selecting the Scan Mode
Selecting Scan File Settings
Related topics
Placing Originals on the Product

Restoring Photo Colors as You Scan
You can restore the colors in faded photos as you scan them using EPSON Scan's Color Restoration
setting. You can select this setting in any of the available scan modes.

Note: Color restoration is not available in Office Mode, if EPSON Scan offers that mode.

1. Place your original on your product for scanning.
2. Start EPSON Scan.
3. Select the scan mode you want to use.
4. Select the scan settings for your scan.
5. Preview your image.
6. Locate or access the image adjustment settings.
7. Select the Color Restoration checkbox.

8. When you finish selecting all your settings, click Scan.
9. Click Close to exit the EPSON Scan window, if necessary.
EPSON Scan scans your original, and saves the color-restored file in the selected folder or opens it in
your scanning program. If the file was saved directly to your computer, you see the file in the Windows
Explorer or Mac OS X Finder, where you can view and print the image, if desired.
Parent topic: Scanning Special Projects
Related tasks
Starting a Scan Using the EPSON Scan Icon
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Selecting the Scan Mode
Related topics
Placing Originals on the Product
Selecting EPSON Scan Settings

Convert Scanned Documents to Editable Text (OCR)
You can scan a document and convert the text into data that you can edit with a word processing,
spreadsheet, or HTML-editing program. This process is called OCR (Optical Character Recognition).
To scan and use OCR, you need to install an OCR program, such as ABBYY FineReader.
In Mac OS X 10.6/10.7/10.8, you can use ABBYY FineReader to convert scanned documents to editable
text by first using an application such as Image Capture. Scan and save your document in Image
Capture, then open ABBYY FineReader, open the Get Images From pop-up menu, and select File.
Select the conversion option you want to use, then select your scanned file and follow the instructions on
the screen.

Note: With Mac OS X 10.6, 10.7, or 10.8, in addition to scanning with Image Capture, you can download
and install EPSON Scan scanning software. EPSON Scan provides additional image adjustment and
photo correction features for enhancing scanned images, and provides an interface for TWAIN-
compliant OCR scanning software, such as ABBYY FineReader. To download EPSON Scan, visit
Epson's driver download site (U.S. downloads or Canadian downloads).

Scanning Using OCR - Windows
Scanning Using OCR - Mac OS X
Parent topic: Scanning Special Projects

Scanning Using OCR - Windows
You can use the ABBYY FineReader OCR program to convert scanned documents to editable text.
1. Place your original on your product for scanning.

2. Click or Start > All Programs or Programs > ABBYY FineReader 9.0 Sprint > ABBYY
FineReader 9.0 Sprint.
You see this window:
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3. Select the language used in the document you are going to scan as the Document Language
setting.

4. Click either the Scan to Other Formats icon or the icon that corresponds with the program you want
to scan to.

5. If you see the Select Scanner window, select your product and click OK.

Note: Do not select a WIA option for your product; it will not work correctly.

You see the scan settings window.
6. Select your scan settings.
7. Click Preview and adjust the area you want to scan, if necessary.
8. Click Scan.

Note: To scan a multi-page document, select settings in the Multi-Page Scanning section and click
Scan for each page.

9. When you are finished scanning, click Close.
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Your document is scanned and processed into editable text, then you see the Save As window.
10. Select a name and a file format for your document and click Save.

The file is saved and then opened in an application associated with the file type you selected, if
available on your system.

Parent topic: Convert Scanned Documents to Editable Text (OCR)
Related topics
Placing Originals on the Product

Scanning Using OCR - Mac OS X
You can use the ABBYY FineReader OCR program to convert scanned documents to editable text.
In Mac OS X 10.6/10.7/10.8, you can use ABBYY FineReader to convert scanned documents to editable
text by first using an application such as Image Capture. Scan and save your document in Image
Capture, then open ABBYY FineReader, open the Get Images From pop-up menu, and select File.
Select the conversion option you want to use, then select your scanned file and follow the instructions on
the screen.

Note: With Mac OS X 10.6, 10.7, or 10.8, in addition to scanning with Image Capture, you can download
and install EPSON Scan scanning software. EPSON Scan provides additional image adjustment and
photo correction features for enhancing scanned images, and provides an interface for TWAIN-
compliant OCR scanning software, such as ABBYY FineReader. To download EPSON Scan, visit
Epson's driver download site (U.S. downloads or Canadian downloads).

1. Place your original on your product for scanning.
2. Open the Applications folder and click the ABBYY FineReader Sprint icon.

You see this window:
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3. Open the Get Images From pop-up menu and select your product.
4. Select the language used in the document you are going to scan as the Document Language

setting.
5. Select the type of document you are going to scan.

EPSON Scan starts in the last scan mode you used.
6. Select your scan settings and click Scan.

Your document is scanned and you see the EPSON Scan window while your document is converted
to editable text.

7. Click Close to close the EPSON Scan window and Preview window, if necessary.
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You see the Save Converted File As window:

8. Click the Save button.
The file is saved and then opened in an application associated with the file type you selected, if
available on your system.

Parent topic: Convert Scanned Documents to Editable Text (OCR)
Related tasks
Scanning with Mac OS X 10.6/10.7/10.8 Using Image Capture
Related topics
Placing Originals on the Product
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Faxing
See these sections to fax using your product.

Note: This product allows you to store names, telephone numbers, and fax data in its memory even
when the power is turned off. Make sure you restore all of the default settings if you give away or dispose
of the product. This will erase all of your network settings and fax data.

Connecting a Telephone or Answering Machine
Setting Up Fax Features
Setting Up Speed Dial and Group Dial Lists
Sending Faxes
Receiving Faxes

Connecting a Telephone or Answering Machine
You must connect your product to a telephone wall jack to send or receive faxes. If you want to use the
same telephone line to receive calls, you can connect a telephone or answering machine to your product
using an additional phone cable.

Note: If you do not connect a telephone to your product, make sure to turn on Auto Answer. Otherwise,
you cannot receive faxes.

1. Connect the phone cable to your telephone wall jack and to the LINE port on your product.
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Note: If you have a DSL or ISDN connection, you must connect the appropriate DSL filter, or ISDN
terminal adapter or router to the wall jack to be able to use the line for faxing or voice calls using your
product. Contact your DSL or ISDN provider for the necessary equipment.

DSL connection

1 Telephone wall jack
2 DSL filter
3 DSL modem

ISDN connection (one phone number)
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1 ISDN wall jack
2 Terminal adapter or ISDN router

ISDN connection (two phone numbers)

1 ISDN wall jack
2 Terminal adapter or ISDN router

2. If you are connecting a telephone or answering machine to your product using a second phone
cable, remove the cap from the EXT port on your product.
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3. Connect the second phone cable to your telephone or answering machine and to the EXT port on
your product.

Note: If you connect an answering machine and Auto Answer is turned on, make sure the product's
Rings to Answer setting is set higher than the number of rings your answering machine is set to
answer a call.
Any phone or answering machine must be connected to the EXT port for your product to detect an
incoming fax call when the phone is picked up. Epson cannot guarantee compatibility with VoIP,
cable phone systems, or fiberoptic digital services such as FIOS.

Parent topic: Faxing
Related tasks
Receiving Faxes Automatically (Auto Answer)

Setting Up Fax Features
Before faxing with your product, set up your fax header and select the fax features you want to use.

Note: If you leave your product unplugged for a long period of time, you may need to reset the date and
time settings for faxes.

Setting Up Fax Features Using the Product Control Panel
Setting Up Fax Features Using the Fax Utility - Windows
Setting Up Fax Features Using the Fax Utility - Mac OS X
Parent topic: Faxing
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Setting Up Fax Features Using the Product Control Panel
See these sections to set up fax features using the product control panel.
Selecting Your Country or Region
Selecting the Date and Time
Entering Fax Header Information
Entering Numbers and Characters for Faxing
Selecting Fax Send and Receive Settings
Selecting Fax Communication Settings
Printing Fax Reports
Restoring Default Fax Settings
Fax Send Options
Fax Receive Options
Fax Communications Options
Fax Report Options
Restore Default Settings Options
Parent topic: Setting Up Fax Features
Related tasks
Setting Up Fax Features Using the Fax Utility - Windows
Setting Up Fax Features Using the Fax Utility - Mac OS X

Selecting Your Country or Region
Before faxing, select the country or region in which you are using your product.

Note: If you change the country or region, your fax settings return to their defaults and you must select
them again.

1. Press the home button, if necessary.
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2. Press the left or right arrow button and then select Setup.

3. Scroll down and select Basic Setup.

4. Select Country/Region.
5. Scroll up or down, if necessary, then select your country or region.

You see a confirmation screen.
6. If the setting is correct, select Yes. (If not, select No and retry.)

Note: Changing the country or region restores the fax settings to the default settings.
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Parent topic: Setting Up Fax Features Using the Product Control Panel
Selecting the Date and Time

Before faxing, select the current date, time, and daylight saving phase in your area, and choose your
preferred date and time format.

1. Press the home button, if necessary.
2. Press the left or right arrow button and then select Setup.

3. Select Basic Setup.
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4. Select Daylight Saving Time.
5. Select the setting that applies to your area:

• Winter: it is winter or your region does not use Daylight Saving Time (DST)
• Summer: it is spring or summer and your region uses Daylight Saving Time (DST)
After making a selection, you return to the Basic Setup screen.

Note: If your region uses Daylight Saving Time (DST), you must change this setting to match the
season. When you change from Winter to Summer, your product automatically sets its clock ahead
one hour. When you change from Summer to Winter, it sets its clock back one hour.

6. Select Date/Time.

7. Select the date format you want to use.
8. Use the numeric keypad to enter the current date, then select Done.
9. Select the time format you want to use.
10. Use the numeric keypad to enter the current time, select AM or PM if you selected a 12-hour time

format, then select Done.
You return to the Basic Setup screen.

Parent topic: Setting Up Fax Features Using the Product Control Panel
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Entering Fax Header Information
Before faxing, add your sender name and fax number to the fax header to identify the source of the faxes
you send.

1. Press the home button, if necessary.
2. Press the left or right arrow button and then select Setup.

3. Scroll down and then select Fax Settings.

4. Select Communication.
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5. Scroll down and then select Header.
6. Select Fax Header.

7. Use the numeric keypad to enter the sender name for your fax source, such as your name or a
business name. You can enter up to 40 characters.

8. Select Done.
You return to the Header screen.

9. Select Your Phone Number.
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10. Use the numeric keypad to enter your fax number, up to 20 characters. For international numbers
that require use of a + symbol, press the # key.

Note: When entering a phone number, the * key does not work.

11. Select Done.
You return to the Header screen.

Parent topic: Setting Up Fax Features Using the Product Control Panel
Related tasks
Entering Numbers and Characters for Faxing

Entering Numbers and Characters for Faxing
Follow these guidelines to enter numbers and characters for faxing and setting up your fax settings.

• To enter text or characters, press the keys on the numeric keypad until the desired character or
number appears.

• To enter symbols, press the 1 Symb. key until the desired symbol appears.
• To enter a pause symbol (–) in phone numbers requiring a brief pause during dialing, press .
• To move the cursor to the next space, press .
• To delete the previous character, press .
Parent topic: Setting Up Fax Features Using the Product Control Panel
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Selecting Fax Send and Receive Settings
You can select the fax quality and other settings for incoming and outgoing faxes.

1. Press the home button, if necessary.
2. Press the left or right arrow button and then select Setup.

3. Scroll down and then select Fax Settings.

4. Select Send Settings or Receive Settings.
5. Change any of the available settings.
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6. Press the home button to exit.
Parent topic: Setting Up Fax Features Using the Product Control Panel
Related references
Fax Send Options
Fax Receive Options

Selecting Fax Communication Settings
You can customize how your product sends and receives faxes over your phone line.

1. Press the home button, if necessary.
2. Press the left or right arrow button and then select Setup.
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3. Scroll down and then select Fax Settings.

4. Select Communication.
5. Change any of the available settings.

6. Press the home button to exit.
Parent topic: Setting Up Fax Features Using the Product Control Panel
Related references
Fax Communications Options

Printing Fax Reports
You can run a variety of reports on your fax transmissions and print your speed and group dial lists.

Note: You can also select to print a report automatically after a fax is sent by going to Setup > Fax
Settings > Send Settings > Last Transmission Report.

1. Make sure you loaded letter-size or larger paper in your product.

2. Press the home button, if necessary.
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3. Select Fax.

4. Select Advanced Options.
5. Scroll down and then select Fax Report.

6. Select one of the available reports.
7. Press the start button to print the report.
Parent topic: Setting Up Fax Features Using the Product Control Panel
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Related references
Fax Report Options

Restoring Default Fax Settings
You can restore your fax settings to their default options, if necessary.

1. Press the home button, if necessary.
2. Press the left or right arrow button and then select Setup.

3. Scroll down and then select Restore Default Settings.
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4. Select one of the available options.
You see a confirmation screen.

5. Select Yes or No.
Parent topic: Setting Up Fax Features Using the Product Control Panel
Related references
Restore Default Settings Options

Fax Send Options
Set the Send Settings options you want to use for outgoing faxes.

Setting Options Description
Resolution Standard Provides good scan resolution and print quality for

most faxes.
Fine Provides best scan resolution and print quality for

faxes of small print and line art.
Photo Provides best scan resolution and print quality for

faxed photos.
Contrast –4 to +4 Adjusts the contrast for faxes; negative settings make

faxes lighter and positive settings make faxes darker.
2-Sided Faxing Off Lets you fax 2-sided originals placed in the ADF.

On
Last Transmission On Error Prints a report on the last transmitted fax only if a fax
Report error occurs (default setting).

On Send Prints a report on the last transmitted fax after every
fax you send.

Off Does not print a report on the last transmitted fax after
you send a fax.

Parent topic: Setting Up Fax Features Using the Product Control Panel
Fax Receive Options

Set the printing options you want to use for incoming faxes.
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Setting Options Description
Auto Answer Off Allows you to confirm if an incoming fax should be

printed. (A telephone must be connected to the
product.)

On Automatically receive and print faxes.
Paper Size Letter Sets the size of the paper loaded for incoming faxes.

Legal
A4

Auto Reduction On Reduces size of incoming faxes to fit on the size of
paper selected as the Paper Size setting.

Off Prints incoming faxes in original size or on multiple
sheets, if loaded paper size is smaller.

Parent topic: Setting Up Fax Features Using the Product Control Panel
Fax Communications Options

Set the communication options you want to use for faxing over your phone line.

Setting Options Description
DRD All If you are using a Distinctive Ring Service on your

phone line, your telephone company can assign twoSingle or more phone numbers to the same line and assign
Double different ring patterns to each. If you use this service,

select the number of rings for your fax number as theTriple DRD setting so your product can receive faxes on
Double & Triple the correct number of rings. All is the default setting

and works for phone lines that do not use this
service.

ECM On Turns on Error Correction Mode (ECM) to
automatically request retransmission of faxes
received with detected errors (default setting).

Off Turns off Error Correction Mode (ECM).
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Setting Options Description
Fax Speed Fast(33,600bps) Transmits faxes at 33.6 Kbps

Medium(14,400bps) Transmits faxes at 14.4 Kbps (default setting)
Slow(9,600bps) Transmits faxes at 9.6 Kbps

Rings to Answer 1 to 9 Sets the number of rings before your product
receives a fax. The default setting is 4. If Auto
Answer is turned on and an answering machine is
connected to the product, make sure this setting is
set higher than the number of rings your answering
machine is set to answer a call.

Dial Tone Detection On Automatically dials the phone number you enter to
send a fax when the product detects a dial tone on
the line.

Off Turns off automatic dial tone detection. This is
necessary if you connected your product to a phone
line on a Private Branch Exchange (PBX) or
Terminal Adapter (TA) system.

Header Fax Header Lets you set up the header information for outgoing
faxes.Your Phone

Number

Parent topic: Setting Up Fax Features Using the Product Control Panel
Fax Report Options

Select the fax report or list you want to print.
Fax Log

View or print a report on recent fax transmissions.
Last Transmission

Print a report on your last fax transmission.
Contact List

Print a list of your contacts.
Speed Dial List

Print a list of your speed dial entries.
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Group Dial List
Print a list of your group dial entries.

Reprint Faxes
Reprint the most recent incoming fax.

Protocol Trace
Print a protocol trace of your last fax transmission.

Parent topic: Setting Up Fax Features Using the Product Control Panel
Restore Default Settings Options

Select the product settings you want to restore.
Fax Send/Receive Settings

Restores all of the default fax settings on the Send Settings, Receive Settings, and
Communication screens.

Fax Data Settings
Erases the speed dial list, group dial list, header, and fax log.

Wi-Fi/Network Settings
Restores all of the default network settings.

All Except Wi-Fi/Network & Fax Settings
Restores all of the default settings on the control panel, except for the network and fax settings.

All Settings
Restores all of the default settings on the control panel.

Parent topic: Setting Up Fax Features Using the Product Control Panel

Setting Up Fax Features Using the Fax Utility - Windows
You can set up your fax header and select your fax settings using the FAX Utility for Windows.

1. Click or Start.
2. Select Programs or All Programs.
3. Select EPSON Software.
4. Select FAX Utility.

You see this window:
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5. Select Fax Settings for Printer. (Select your product, if prompted.)
You see this window:
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6. Select Fax Settings.
7. Follow the prompts that appear on the screen to enter your fax header information and select your

fax settings.

Note: For detailed information, select the FAX Utility Help option.

Parent topic: Setting Up Fax Features
Related topics
Setting Up Fax Features Using the Product Control Panel

Setting Up Fax Features Using the Fax Utility - Mac OS X
You can set up your fax header and select your fax settings using the FAX Utility for Mac OS X.
1. Do one of the following:

• Mac OS X 10.6/10.7/10.8: In the Apple menu or the Dock, select System Preferences. Select
Print & Fax or Print & Scan, select the FAX option for your product, and select Options &
Supplies. Select Utility and select Open Printer Utility.

• Mac OS X 10.5: In the Apple menu or the Dock, select System Preferences. Select Print & Fax,
select the FAX option for your product, and select Open Print Queue. Select Utility.

2. Double-click FAX Utility, if necessary.
You see this window:
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3. Select your FAX product in the Printer list.
4. Select Fax Settings.
5. Follow the prompts that appear on the screen to enter your fax header information and select your

fax settings.

Note: For detailed information, select the FAX Utility ? icon.

Parent topic: Setting Up Fax Features
Related topics
Setting Up Fax Features Using the Product Control Panel

Setting Up Speed Dial and Group Dial Lists
You can set up a speed dial list of fax numbers so you can quickly select them for faxing. You can also
set up a group dial list to send a fax message to multiple speed dial numbers.
See these sections to set up speed dial and group dial lists.
Setting Up Speed/Group Dial Lists Using the Product Control Panel
Setting Up Speed/Group Dial Lists Using the Fax Utility - Windows
Setting Up Speed/Group Dial Lists Using the Fax Utility - Mac OS X
Parent topic: Faxing

Setting Up Speed/Group Dial Lists Using the Product Control Panel
You can set up your speed dial and group dial lists using the control panel on your product.
Creating Speed Dial List Entries
Printing Your Speed Dial List
Creating Group Dial List Entries
Printing Your Group Dial List
Parent topic: Setting Up Speed Dial and Group Dial Lists
Related tasks
Setting Up Speed/Group Dial Lists Using the Fax Utility - Windows
Setting Up Speed/Group Dial Lists Using the Fax Utility - Mac OS X

Creating Speed Dial List Entries
You can create a speed dial list of fax numbers to help you quickly send faxes.
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Note: You can create up to 60 speed dial and group dial entries combined.

1. Press the home button, if necessary.
2. Select Fax.

3. Select Contacts.
4. Select Add/Edit Contacts.
5. Select Speed Dial Setup.

6. Select the number you want to use for the fax number you are adding.
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7. Use the numeric keypad to enter the fax number. You can enter up to 64 characters.
8. Select Done.

You see this screen:

9. Use the numeric keypad to enter a name for the speed dial entry. You can enter up to 30 characters.
10. Select Done.

You return to the Add/Edit Contacts screen.
11. Do the following as necessary:

• To create additional entries, select Speed Dial Setup and repeat the steps above.
• To edit an existing entry, select Edit Contacts, select the entry, and change the information.
• To delete an entry, select Delete Contacts, select the entry, select Proceed, and confirm the

deletion.
Parent topic: Setting Up Speed/Group Dial Lists Using the Product Control Panel
Related tasks
Printing Your Speed Dial List

Printing Your Speed Dial List
You can print your speed dial list for easy reference.
1. Load paper in your product.

2. Press the home button, if necessary.
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3. Select Fax.

4. Select Advanced Options.
5. Scroll down and then select Fax Report.

6. Scroll down and then select Speed Dial List.
7. Press the start button to print the report.
Parent topic: Setting Up Speed/Group Dial Lists Using the Product Control Panel
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Creating Group Dial List Entries
You can create a group dial list after creating a speed dial list. Each group dial list can include up to 30
fax numbers.

Note: You can create up to 60 speed dial and group dial entries combined.

1. Press the home button, if necessary.
2. Select Fax.

3. Select Contacts.
4. Select Add/Edit Contacts.
5. Select Group Dial Setup.
6. Select the number you want to use for the group dial entry you are adding.
7. Use the numeric keypad to enter a name for the group dial entry. You can enter up to 30 characters.
8. Select Done.

9. Select the speed dial entry you want to add to the group and press to select it.
10. Continue selecting speed dial entries as necessary.
11. When you are finished, select Done.

You return to the Add/Edit Contacts screen.
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12. Do the following as necessary:
• To create additional entries, select Group Dial Setup and repeat the steps above.
• To edit an existing entry, select Edit Contacts, select the entry, and change the information.
• To delete an entry, select Delete Contacts, select the entry, select Proceed, and confirm the

deletion.
Parent topic: Setting Up Speed/Group Dial Lists Using the Product Control Panel
Related tasks
Creating Speed Dial List Entries
Printing Your Group Dial List

Printing Your Group Dial List
You can print your group dial list for easy reference.
1. Load paper in your product.

2. Press the home button, if necessary.
3. Select Fax.

4. Select Advanced Options.
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5. Scroll down and then select Fax Report.

6. Scroll down and then select Group Dial List.
7. Press the start button to print the report.
Parent topic: Setting Up Speed/Group Dial Lists Using the Product Control Panel

Setting Up Speed/Group Dial Lists Using the Fax Utility - Windows
You can set up your speed dial and group dial lists using the FAX Utility for Windows. The utility also lets
you import fax numbers from the Windows Address Book and back up fax numbers stored in your
product's memory.

Note: You can create up to 60 speed dial and group dial entries combined.

1. Click or Start.
2. Select Programs or All Programs.
3. Select EPSON Software.
4. Select FAX Utility.

You see this window:
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5. Select Fax Settings for Printer. (Select your product, if prompted.)
You see this window:
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6. Select Speed Dial/Group Dial List.
You see this window:

7. Select an empty entry and click the icon.

Note: To edit an entry, select it and click the icon. To delete an entry, select it and click the
icon.

8. Do one of the following:
• To create a speed dial entry, select Speed Dial, enter a name and fax number, and click OK.
• To create a group dial entry, select Group, enter a name, select your desired fax numbers, and

click OK.
9. Repeat the previous steps as necessary to add all your speed dial or group dial entries.

10. When you are finished, click the icon to save the entries to your product's memory.
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Parent topic: Setting Up Speed Dial and Group Dial Lists
Related topics
Setting Up Speed/Group Dial Lists Using the Product Control Panel

Setting Up Speed/Group Dial Lists Using the Fax Utility - Mac OS X
You can set up your speed dial and group dial lists using the FAX Utility. The utility also lets you import
fax numbers from the MacAddress Book and back up fax numbers to your product's memory.

Note: You can create up to 60 speed dial and group dial entries combined.

1. Do one of the following:
• Mac OS X 10.6/10.7/10.8: In the Apple menu or the Dock, select System Preferences. Select

Print & Fax or Print & Scan, select the FAX option for your product, and select Options &
Supplies. Select Utility and select Open Printer Utility.

• Mac OS X 10.5: In the Apple menu or the Dock, select System Preferences. Select Print & Fax,
select the FAX option for your product, and select Open Print Queue. Select Utility.

2. Double-click FAX Utility, if necessary.
You see this window:

3. Select your FAX product in the Printer list.
4. Select Speed Dial/Group Dial List.

182



You see this window:

5. To add an entry, double-click an empty entry.

Note: To edit an entry, select it and change the information. To delete an entry, select it and press
the Delete key on your keyboard.

6. Do one of the following:
• To create a speed dial entry, select Speed Dial, enter a name and fax number, and click OK.
• To create a group dial entry, select Group Dial, enter a name, select your desired fax numbers,

and click OK.
7. Repeat the previous steps as necessary to add all your speed dial or group dial entries.

8. To import entries from your MacAddress book, click the icon.

9. When you are finished, click the icon to save the entries to your product's memory.
Parent topic: Setting Up Speed Dial and Group Dial Lists
Related topics
Setting Up Speed/Group Dial Lists Using the Product Control Panel
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Sending Faxes
See these sections to send faxes using your product.
Sending Faxes from the Product Control Panel
Sending Faxes Using the Fax Utility - Windows
Sending Faxes Using the Fax Utility - Mac OS X
Parent topic: Faxing

Sending Faxes from the Product Control Panel
See these sections to send faxes using the product's control panel.
Manually Dialing or Redialing Fax Numbers
Selecting Fax Numbers from Speed or Group Dial Lists
Dialing Fax Numbers from a Connected Telephone
Broadcasting a Fax
Sending a Fax at a Specified Time
Fax Sending Options
Parent topic: Sending Faxes

Manually Dialing or Redialing Fax Numbers
You can send a fax from your product control panel by manually dialing the fax number or redialing the
last dialed fax number.
1. Place your original on the product for faxing.

2. Press the home button, if necessary.
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3. Select Fax.

4. Do one of the following:
• Select the Enter Fax Number area on the LCD display, then use the numeric keypad to enter the

fax number. You can enter up to 64 characters.
• Press Redial to redial the last dialed fax number.

5. If you need to change any fax settings, scroll down and select your settings.

Note: If your recipient's fax machine does not print in color, your fax is automatically sent in black-
and-white.

6. Press the start button. If prompted, select where you placed your document (ADF or scanner
glass).

Note: To cancel faxing, select Cancel.

Your product scans your original and prompts you to place additional pages, if necessary.
After scanning your originals, your product dials the number and sends the fax.

Note: If the number is busy or there is a communication problem, your product displays a redialing
message and will redial the number in a few minutes.

Parent topic: Sending Faxes from the Product Control Panel
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Related references
Fax Sending Options
Related tasks
Entering Numbers and Characters for Faxing
Related topics
Placing Originals on the Product

Selecting Fax Numbers from Speed or Group Dial Lists
You can send a fax from your product control panel by selecting a speed dial or group dial entry from the
list.
1. Place your original on the product for faxing.

2. Press the home button, if necessary.
3. Select Fax.

4. Select Contacts.
5. Select the speed dial or group dial entry you want to use.
6. If you need to change any fax settings, scroll down and select your settings.

Note: If your recipient's fax machine does not print in color, your fax is automatically sent in black-
and-white.
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7. Press the start button. If prompted, select where you placed your document (ADF or scanner
glass).

Note: To cancel faxing, select Cancel.

Your product scans your original and prompts you to place additional pages, if necessary.
After scanning your originals, your product dials the number and sends the fax.

Note: If the number is busy or there is a communication problem, your product displays a redialing
message and will redial the number in a few minutes.

Parent topic: Sending Faxes from the Product Control Panel
Related references
Fax Sending Options
Related topics
Placing Originals on the Product
Setting Up Speed Dial and Group Dial Lists

Dialing Fax Numbers from a Connected Telephone
If you have connected a telephone to the EXT port on your product, you can send a fax by dialing the fax
number from the connected telephone.
1. Place your original on the product for faxing.

2. Press the home button, if necessary.
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3. Select Fax.

4. Dial the fax number from the connected telephone.
5. Select Send on the LCD display.

Note: Your product now communicates with the recipient's fax machine. Do not hang up the
telephone.

6. If you need to change any fax settings, scroll down and select your settings.

Note: If your recipient's fax machine does not print in color, your fax is automatically sent in black-
and-white.

7. Press the start button. If prompted, select where you placed your document (ADF or scanner
glass).

Note: To cancel faxing, select Cancel.

Your product scans your original and prompts you to place additional pages, if necessary.
8. Hang up the telephone.
After scanning your originals, your product sends the fax.
Parent topic: Sending Faxes from the Product Control Panel
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Related references
Fax Sending Options
Related topics
Placing Originals on the Product

Broadcasting a Fax
You can easily send a fax to several recipients at the same time using your speed dial list or group dial
list, or by entering phone numbers. You can send the same fax to up to 30 phone numbers.

Note: You can only send faxes in black-and-white when you use this option.

1. Place your original on the product for faxing.

2. Press the home button, if necessary.
3. Select Fax.

4. Select Advanced Options.
5. Select Broadcast Fax.
6. Select Add New then do one of the following:

• Select Enter Fax Number then use the numeric keypad to manually enter fax numbers.
• Select Select From Contacts then select a speed or group dial entry.

7. Repeat the step above to add additional fax recipients, if necessary.
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8. When you have finished selecting your recipients, select Done.
9. If you need to change any fax settings, scroll down and select your settings.
10. Press the start button. If prompted, select where you placed your document (ADF or scanner

glass).

Note: To cancel faxing, select Cancel.

Your product scans your original and prompts you to place additional pages, if necessary.
After scanning your originals, your product dials the number and sends the fax.

Note: If the number is busy or there is a communication problem, your product displays a redialing
message and will redial the number in a few minutes.

Parent topic: Sending Faxes from the Product Control Panel
Related references
Fax Sending Options
Related topics
Placing Originals on the Product

Sending a Fax at a Specified Time
You can send a fax at a time of your choice.

Note: You can only send faxes in black-and-white when you use this option.

1. Place your original on the product for faxing.

2. Press the home button, if necessary.
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3. Select Fax.

4. Enter a phone number or select a number from a speed or group dial list.
5. Select Advanced Options.
6. Select Send Fax Later.
7. Select On, use the number pad to enter your desired time, then select Done.
8. If you need to change any fax settings, scroll down and select your settings.
9. Press the start button. If prompted, select where you placed your document (ADF or scanner

glass).

Note: To cancel faxing, select Cancel.

Your product scans your original and prompts you to place additional pages, if necessary.
After scanning your originals, your product dials the number and sends the fax at the specified time. You
cannot send additional faxes until the timed fax has been sent.

Note: If the number is busy or there is a communication problem, your product displays a redialing
message and will redial the number in a few minutes.

Parent topic: Sending Faxes from the Product Control Panel
Fax Sending Options

While sending a fax, you can select these options.
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Setting Options Description
Resolution Standard Provides good scan resolution and print quality for

most faxes.
Fine Provides best scan resolution and print quality for

faxes of small print and line art.
Photo Provides best scan resolution and print quality for

faxed photos.
Contrast Various levels Adjusts the contrast for faxes; negative settings make

faxes lighter and positive settings make faxes darker.
2-Sided Faxing Off Lets you fax 2-sided originals placed in the ADF.

On

Parent topic: Sending Faxes from the Product Control Panel

Sending Faxes Using the Fax Utility - Windows
You can send a fax from a printing program in Windows. You can fax up to 100 pages at a time,
including a cover sheet.
1. Open the file you want to fax and select the print command.

You see a window like this:

192



2. Select your product with the FAX option as the printer.
3. To change the Paper Size, Orientation, Color, Image Quality, or Character Density settings, click the

Preferences or Properties button.

Note: If you see a Setup, Printer, or Options button, click it. Then click Preferences or Properties
on the next screen. For more information about selecting fax print settings, click Help.

4. Select the Page Range as necessary. (Leave the Number of copies set to 1.)
5. Click Print.

If you’re faxing for the first time, you see a window like this one:
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6. Enter your sender information so that recipients can identify the origin of the fax. Then click OK to
save the sender information.

7. Add a cover sheet, input a fax number, or set up a phone book of numbers for future use, then click
Next.

Note: For detailed instructions on using the EPSON FAX Utility, click Help.

8. If you added a cover sheet to your fax, select a cover sheet style, enter your subject and comment
information, then click Next.

9. Click Send to transmit your fax.
Parent topic: Sending Faxes

Sending Faxes Using the Fax Utility - Mac OS X
You can send a fax from a Mac OS X printing program using the FAX Utility. You can fax up to 100
pages at a time, including a cover sheet.
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1. Open the file you want to fax.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product FAX option as the Printer setting.
4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the

print window.
5. Select the number of pages you are faxing as the Pages setting.

Note: Leave the Copies setting set to 1.

6. Select Recipient Settings from the pop-up menu.
You see this window:
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7. Do one of the following to choose your recipient:
• Select a name or group from the Recipient List.
• Enter a name, company, and fax number and click the + button.

• Click the icon and select a recipient from your address book.
8. Select Fax Settings from the pop-up menu.

You see this window:
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9. Select the Color and Image Quality settings you want to use for your fax.
10. Click Fax.
Parent topic: Sending Faxes

Receiving Faxes
See these sections to receive faxes with your product.
Fax Reception
Receiving Faxes Automatically (Auto Answer)
Receiving Faxes Manually
Parent topic: Faxing

Fax Reception
Your product will automatically receive and print faxes when you set fax reception mode to Auto
Answer.
If you connected a telephone to your product so you can use the same phone line for faxes and voice
calls, you can also set your product to receive faxes manually. This allows you to check for a fax tone
using the telephone and press a button on your product to receive the fax.
Make sure to load paper in your product and select your fax settings before receiving a fax.

Note: If you run out of paper during fax printing, load more paper and press the button indicated on your
product's LCD screen to continue.

Parent topic: Receiving Faxes
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Receiving Faxes Automatically (Auto Answer)
To receive and print faxes automatically, you can turn on Auto Answer mode.
Check the auto answer icon on your product's Home screen to see if Auto Answer mode is turned
on or not.

To turn Auto Answer mode on or off, select Setup > Fax Settings > Receive Settings > Auto Answer.
If an answering machine is connected, make sure the product's Rings to Answer setting is set higher
than the number of rings your answering machine is set to answer a call. For example, if the answering
machine is set to pick up on the fourth ring, set the product to pick up on the fifth ring or later.
If a telephone is connected, and you use it to answer a call that turns out to be a fax, wait until the
product's LCD screen displays a message that a connection has been made before hanging up.
Parent topic: Receiving Faxes
Related references
Fax Receive Options
Fax Communications Options
Related tasks
Receiving Faxes Manually

Receiving Faxes Manually
You can set up your product to receive faxes manually by turning off Auto Answer mode. This lets you
check for a fax tone on the connected telephone before receiving a fax.
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1. When the connected telephone rings, answer the call.
2. If you hear a fax tone, select Receive on the LCD display.
3. Press the start button, then hang up the phone.
4. Press the start button again to print the fax.
Parent topic: Receiving Faxes
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Using Memory Cards With Your Product
Follow the instructions here to work with a memory card inserted into your product.
Inserting a Memory Card
Printing from a Memory Card
Transferring Photos on a Memory Card

Inserting a Memory Card
Insert only one memory card at a time into a memory card slot on your product.
1. Make sure the memory card and the files on it are compatible with your product before inserting the

card.
2. Open the cover and insert your memory card into the correct slot, making sure the card is oriented

correctly.

1 Memory card access light

Note: Do not force the card all the way into the slot. Insert it only until it meets resistance.
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The memory card access light flashes and then stays lit.

Caution: Do not remove a memory card or turn off your product while the memory card access light is
flashing or you may lose data from the memory card.

Memory Card Types
Memory Card File Specifications
Removing a Memory Card
Parent topic: Using Memory Cards With Your Product

Memory Card Types
You can insert these types of memory cards in your product.

Note: Cards marked with an asterisk (*) require an adapter; consult your adapter documentation for
details on using it.

Left Slot
You can insert the following cards in the left slot:
• Memory Stick Duo
• Memory Stick PRO Duo
• Memory Stick PRO-HG Duo
• Memory Stick Micro*
• MagicGate Memory Stick Duo
• SDXC
• SDHC
• SD
• MultiMediaCard
• MMCplus
• MMCmobile*
• MMCmicro*
• miniSDHC*
• miniSD*
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• microSDXC*
• microSDHC*
• microSD*

Right Slot
You can insert the following cards in the right slot:
• CompactFlash
• Microdrive
Parent topic: Inserting a Memory Card

Memory Card File Specifications
You can insert memory cards in your product containing files that meet these specifications.

File format JPEG with the Exif version 2.3 standard
Image size 80 × 80 pixels to 9200 × 9200 pixels
Number of files Up to 9990

Parent topic: Inserting a Memory Card

Removing a Memory Card
After you finish working with a memory card, you can check to make sure it is safe to remove it from your
product.

Caution: Do not remove a memory card or turn off your product while the memory card access light is
flashing or you may lose data from the memory card.
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1. Make sure the memory card access light is not flashing.

2. If your product is connected to your computer using a USB cable, do one of the following:
• Windows: Open the My Computer, Computer, or Windows Explorer utility. Then right-click the

name of your memory card (listed as a removable disk) and select Eject.
• Mac OS X: Drag the removable disk icon for your memory card from the desktop into the trash.

3. Pull the memory card straight out of its slot.
Parent topic: Inserting a Memory Card

Printing from a Memory Card
See these sections to print photos from a memory card inserted into your product:
Viewing and Printing Photos
Printing Photo Layouts from a Memory Card
Printing Photo Greeting Cards
Parent topic: Using Memory Cards With Your Product

Viewing and Printing Photos
See these sections to view and print photos displayed on your product's LCD screen:
Viewing and Printing Photos
Cropping Photos Displayed on the LCD Screen
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Photo Adjustment Options - Memory Card
Print Setting Options - Memory Card
Paper Type Settings - Memory Card
Parent topic: Printing from a Memory Card

Viewing and Printing Photos
You can select photos for printing as you view them on the LCD screen.
1. Select Print Photos.

2. Do one of the following to select your photos:
• To select individual photos, select the thumbnail image of the photo you want to print, then press +

or – to select the number of copies (up to 99). Press the left or right arrow button to scroll through
and select additional photos, or press the back button to return to the thumbnail image view and
select another photo.

• To select all photos, select Options > Select Photos > Select All Photos, then press + or – to
select the number of copies (up to 99). Select Done when finished.

• To select photos based on the date they were taken, select Options > Select Photos > Select by
Date, then select any of the dates shown. Select Proceed, then press + or – to select the number
of copies (up to 99). Select Done when finished.
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3. To adjust your photos, do either of the following as necessary (adjustments modify only your printed
copy, not the original file):
• To crop, zoom into, or rotate a photo, select the thumbnail image of the photo you want to modify,

then select Edit > Crop/Zoom. Make the necessary adjustments, select OK, then Done when
finished.

• To change the appearance (e.g., brightness and contrast) of your printed photos, select the
thumbnail image of a photo, select Edit > Photo Adjustments, and select the necessary settings.
When you are finished, press the back button twice.

4. To change the print settings, select Settings, then select the necessary settings. When you are
finished, press the back button.

5. When you are ready to print, press the start button.

Note: To cancel printing, select Cancel.

Parent topic: Viewing and Printing Photos
Related references
Photo Adjustment Options - Memory Card
Print Setting Options - Memory Card
Related tasks
Cropping Photos Displayed on the LCD Screen

Cropping Photos Displayed on the LCD Screen
If you want to crop or rotate photos displayed on the LCD screen, select the thumbnail image of the
photo you want to modify, select Edit > Crop/Zoom, and select the necessary options.
• To crop the photo, press + to move the yellow crop area inward or – to move the crop area outward.
• To move the crop area, press the arrow buttons.
• To rotate the crop area, press .
• To check the cropped image, press OK.
Parent topic: Viewing and Printing Photos

Photo Adjustment Options - Memory Card
Select the Photo Adjustment options you want to use when viewing and printing photos displayed on
the LCD screen. The modifications affect only the printed copy of the photo, not the original file.
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Photo Adjustment Available options Description
settings
Fix Photo Fix Photo On Automatically adjusts the brightness, contrast, and

saturation of the photo based on the Scene
Detection setting that is selected.

Fix Photo Off Turns off automatic adjustments; see Note below
P.I.M. Uses your camera's PRINT Image Matching or Exif

Print adjustments
Scene Detection Automatic Optimizes the Fix Photo adjustments for specific

types of photos; select the option that best matchesPeople your photo content
Landscape
Night Scene

Fix Red-Eye Off - Current Automatically fixes the red-eye effect in photos
On - Current
Off - All Photos
On - All Photos

Filter Sepia Applies a sepia tone filter to the viewed or printed
photo

B&W Applies a black-and-white filter to the viewed or
printed photo

Brightness Various settings Adjust individual qualities in your photo
Contrast
Sharpness
Saturation

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces.
For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a
face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the
special color effects.

Parent topic: Viewing and Printing Photos
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Print Setting Options - Memory Card
Select the Print Settings options you want to use when printing photos displayed on the LCD screen.

Print settings Available Description
options

Paper Size Various paper Indicates the size of paper you have loaded
sizes

Paper Type Various paper Indicates the type of paper you have loaded; see the list of
types paper types for memory card (available options depend on

the selected Paper Size setting)
Paper Source Cassette 1 Prints onto paper loaded in Cassette 1 (upper cassette)

Cassette 2 Prints onto paper loaded in Cassette 2 (lower cassette)
Cassette Prints onto paper loaded in Cassette 1 and then onto paper
1>Cassette 2 loaded in Cassette 2 when the first cassette is empty (load

the same size and type of paper in both cassettes when
selecting this option)

Rear Paper Prints onto paper loaded in the rear paper feed slot
Feed Slot

Borderless Borderless Expands the image to the edge of the paper (slight cropping
may occur)

With Border Leaves a small margin around the image
Quality Draft Provides lower quality for draft printing

Standard Provides good quality for most prints
Quality
Best Provides the highest quality for important prints

Expansion Standard Expands images correctly for most borderless prints
Medium Expands images slightly less for borderless prints
Minimum Expands images the least for borderless prints (you may see

some white border)
Date Various date Prints the date the photo was taken on the photo in the

formats format you select
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Print settings Available Description
options

Print Info. On Camera Prints settings that you added in your camera
Photos Settings

Camera Text Prints text that you added in your camera
Landmark Prints location information embedded in a photo by cameras

that have a built-in GPS feature
Fit Frame On Automatically crops the photo to fit into the selected photo

layout
Off Turns off automatic cropping

Bidirectional On Prints at normal speed
Off Slows down printing to improve print quality

Clear All Settings Yes Clears all print settings.
No

Parent topic: Viewing and Printing Photos
Related references
Paper Type Settings - Memory Card

Paper Type Settings - Memory Card
Select a Paper Type setting that matches the paper you loaded.

Paper type loaded Paper Type setting
Plain paper Plain Paper
EPSON Bright White Paper
EPSON Presentation Paper Matte
EPSON Iron-on Cool Peel Transfer paper
EPSON Photo Quality Self-adhesive Sheets
EPSON Premium Presentation Paper Matte Matte
EPSON Ultra Premium Presentation Paper Matte
EPSON Premium Presentation Paper Matte Double-sided
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Paper type loaded Paper Type setting
EPSON Premium Photo Paper Glossy Prem. Glossy
EPSON Premium Photo Paper Semi-gloss
EPSON Ultra Premium Photo Paper Luster
EPSON Ultra Premium Photo Paper Glossy Ultra Glossy
EPSON Photo Paper Glossy Glossy
EPSON Velvet Fine Art Paper Velvet Fine Art Paper

Parent topic: Viewing and Printing Photos

Printing Photo Layouts from a Memory Card
You can print one or more photos from a memory card in special layouts on various sizes of photo paper.

1. Press the home button, if necessary.
2. Select More Functions.
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3. Select Photo Layout Sheet.

4. Scroll down to view all of the layout options, then select the option you want.
5. Select the paper size and paper type that matches the paper you loaded, then select Proceed.
6. If you see a screen asking you to choose between automatic and manual placement of photos, do

one of the following:
• Select Automatic layout if you want to allow your product to place the photos in the layout

automatically.
• Select Place photos manually to place photos in the layout manually.

7. Select the photos you want to print, then select Proceed. If you chose to place the photos manually,
follow the instructions on the LCD screen to select and place your photos on the layout, then select
Proceed.

8. Press + or – to select the number of layout sheets to print (up to 99), then select Proceed.
9. Select additional print settings for your layout as necessary.
10. When you are ready to print, press the start button.

Note: To cancel printing, select Cancel.

Photo Layout Options
Parent topic: Printing from a Memory Card
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Photo Layout Options
Select the layout you want to use when printing your photos in a layout.
Picture Package

Prints one photo in multiple sizes on one sheet.
2-up, 4-up, 8-up, or 20-up

Print 2, 4, 8, or 20 photos on one sheet.
Upper ½ or Lower ½

Print one photo in the upper or lower half of the sheet.
Photo ID

Prints 4 ID-sized photos on one sheet.
Jewel Upper

Prints one photo on the upper half of a folded jewel case insert.
Jewel Index

Prints 24 to 48 thumbnail images on a folded jewel case insert.
Parent topic: Printing Photo Layouts from a Memory Card

Printing Photo Greeting Cards
You can create custom greeting cards using photos on your memory card or other device, and add your
own handwritten or printed text.
First you select your photo and print a template on plain paper. Then you fill out the template, add your
message, and print your cards.
Creating and Printing a Greeting Card Template
Printing a Greeting Card from a Template
Parent topic: Printing from a Memory Card

Creating and Printing a Greeting Card Template
Before you start, make sure plain paper is loaded and your memory card is inserted.

1. Press the home button, if necessary.
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2. Select More Functions.

3. Select Greeting Card.

4. Select Select Photo and Print Template.
5. Select the photo you want, then select Proceed.
6. Select Paper Size, then select Letter to print three cards on one letter-size sheet or 4x6in to print

one card.
7. Select Paper Type, then select the type of paper you plan to use.
8. Select the other print settings as necessary, then select Proceed.
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9. When you are ready to print your greeting card template on plain paper, press the start button.
Parent topic: Printing Photo Greeting Cards
Related tasks
Inserting a Memory Card
Related topics
Loading Paper

Printing a Greeting Card from a Template
After your greeting card template is printed, you fill it out to create your card and add your message.
1. Use a dark pen or pencil to fill in the circles and select the Text Style and Text Effects.

2. Add your greeting card message within the box. You can write it in by hand, print a message and
paste it into the box, or draw a picture.

Tip: When adding text, place it in the direction that your photo faces.

3. Load photo paper either in Cassette 2 (lower) for this size: Letter (8.5 × 11 inches [216 × 279 mm]),
or in Cassette 1 (upper) for this size: 4 × 6 inches (102 × 152 mm).

4. Select Print Greeting Cards from Template. (If you don't see the option, press the home button
and select More Functions > Greeting Card > Print Greeting Cards from Template.)

5. Follow the instructions on the LCD screen to place the template facedown on the scanner glass, with
the blue triangle facing into the front right corner.
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6. Close the document cover, then select Proceed.
7. To print more than one copy, press + or – to select the number (up to 99).
8. When you are ready to print, press the start button.

Note: To cancel printing, select Cancel.

When you finish printing, cut your greeting cards apart, if necessary.
Parent topic: Printing Photo Greeting Cards
Related tasks
Creating and Printing a Greeting Card Template

Transferring Photos on a Memory Card
You can transfer photos to and from a memory card inserted into a memory card slot on your product.
Setting Up File Sharing for Photo Transfers From Your Computer
Transferring Photos from a Memory Card to Your Computer
Parent topic: Using Memory Cards With Your Product

Setting Up File Sharing for Photo Transfers From Your Computer
Before you transfer photos from a computer to a memory card inserted into a memory card slot on your
product, you may need to set up your product's file sharing settings.
1. Remove any memory cards from the product.

Caution: Remove the memory card before you change the file sharing settings or you may lose data
from the memory card. Do not remove a memory card or turn off your product while the memory card
access light is flashing or you may lose data from the memory card.

2. Press the home button, if necessary.
3. Press the left or right arrow button and then select Setup.
4. Scroll down and select File Sharing Setup.
5. Select the connection type between the printer and your computer.
Parent topic: Transferring Photos on a Memory Card
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Related tasks
Removing a Memory Card

Transferring Photos from a Memory Card to Your Computer
You can transfer photos to and from a memory card inserted into a memory card slot on your product
and a computer connected to your product.

Note: Do not transfer photos to and from a memory card while you are printing from the memory card.

1. Make sure your product is connected to a computer.
2. Insert a memory card into a memory card slot on your product.
3. Do one of the following to access your memory card files from your computer:

• Windows: Select the Computer or My Computer utility, then select the removable disk icon.
• Mac OS X with a USB connection: Look for the removable disk icon on your desktop, then select

it.
• Mac OS X with a network connection: Select the hard drive icon on your desktop or select

Computer from the Go menu, select your product in the SHARED section of the sidebar (you may
need to widen the sidebar to see the name), then select the MEMORYCARD icon.

4. Select the folder that contains your photos.
5. Drag the photos you want to transfer to the desired folder on your computer or on your memory card.

Note: Your product's LCD screen does not update to display new photos transferred to the memory
card. Wait until the memory card access light stops flashing, then remove and insert the memory card to
update the photos displayed.

Parent topic: Transferring Photos on a Memory Card
Related tasks
Inserting a Memory Card
Removing a Memory Card
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Using an External Device with Your Product
Follow the instructions in these sections to use your product with an external device, such as a camera,
smartphone, or other device.
Printing from a Camera Connected to Your Product
Viewing or Printing from a USB Flash Drive or External Device

Printing from a Camera Connected to Your Product
If you have a digital camera that supports PictBridge printing, you can connect it to the product and print
your photos directly from the camera. Check your camera manual to see if it is compatible.

Note: Your photos must be in JPG format and sized from 80 × 80 to 9200 × 9200 pixels. Epson cannot
guarantee the compatibility of your camera. Some combinations of paper type, size, and layout may not
be supported, depending on your camera and the product settings.

Selecting Print and Photo Adjustment Settings
Connecting and Printing from a Camera
Parent topic: Using an External Device with Your Product

Selecting Print and Photo Adjustment Settings
Before printing from your camera, you can make image adjustments and select the print settings for your
photos. Image adjustments affect only the printed copy of the photo, not the original file.

1. Press the home button, if necessary.
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2. Press the left or right arrow button and then select Setup.

3. Scroll down and select External Device Setup.
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4. Select Print Settings.

5. Select the print settings you want to use.
6. When you are done, press the back button.
7. Select Photo Adjustments.

8. Select the photo adjustments you want to use, then press the home button to exit.
After you select settings, you are ready to connect your camera and print your photos.
Print Settings - Camera
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Photo Adjustments - Camera
Parent topic: Printing from a Camera Connected to Your Product

Print Settings - Camera
Select the Print Settings options you want to use when printing photos from your camera.

Print settings Available options Description
Paper Size Various paper sizes Indicates the size of paper you have loaded
Paper Type Various paper types Indicates the type of paper you have loaded; see

the list of paper types for copying (available
options depend on the selected Paper Size
setting)

Paper Source Cassette 1 Prints onto paper loaded in Cassette 1 (upper
cassette)

Cassette 2 Prints onto paper loaded in Cassette 2 (lower
cassette)

Cassette 1> Cassette 2 Prints onto paper loaded in Cassette 1 and then
onto paper loaded in Cassette 2 when the first
cassette is empty (load the same size and type of
paper in both cassettes when selecting this
option)

Rear Paper Feed Slot Prints onto paper loaded in the rear paper feed
slot
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Print settings Available options Description
Layout Borderless Expands the image to the edge of the paper (slight

cropping may occur)
With Border Leaves a small margin around the image
Picture Package Prints one photo in multiple sizes on one sheet
1-up, 2-up, 4-up, 8-up, 20-up, Prints the selected number of photos on one sheet
30-up, 80-up, or Variety or CD/DVD
Upper ½ or Lower ½ Print one photo in the upper or lower half of the

sheet
Jewel Upper Prints one photo on the upper half of a folded

jewel case insert
Jewel Index Prints 24 to 48 thumbnail images on a folded jewel

case insert
Quality Draft Provides lower quality for draft printing

Standard Quality Provides good quality for most prints
Best Provides the highest quality for important prints

Expansion Standard Expands images correctly for most borderless
prints

Medium Expands images slightly less for borderless prints
Minimum Expands images the least for borderless prints

(you may see some white border)
Date Off Does not print the date on which the photo was

taken
On Prints the date on which the photo was taken

Print Info. on Camera Settings Prints your camera's shutter speed, aperture, and
Photos ISO speed

Camera Text Prints text that you added in your camera
Landmark Prints location information embedded in a photo

by cameras that have a built-in GPS feature
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Print settings Available options Description
Fit Frame On Automatically crops the photo to fit into the

selected photo layout
Off Turns off automatic cropping

Bidirectional On Prints at normal speed
Off Slows down printing to improve print quality

CD Inner/Outer Range of measurements Selects inner and outer diameter for printing on
CDs/DVDs from your camera

CD Density Standard Density Adjusts the print density when printing on
CDs/DVDs from your cameraDarker

Darkest

Parent topic: Selecting Print and Photo Adjustment Settings
Related references
Paper Type Settings - Copying

Photo Adjustments - Camera
Select the Photo Adjustments options you want to use when printing photos from your camera. The
modifications affect only the printed copy of the photo, not the original file.

Photo Available options Description
Adjustments
settings
Fix Photo Fix Photo On Automatically adjusts the brightness, contrast, and

saturation of the photo based on the Scene Detection
setting that is selected

Fix Photo Off Turns off automatic adjustments; see Note below
P.I.M Uses your camera's PRINT Image Matching or Exif Print

adjustments
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Photo Available options Description
Adjustments
settings
Scene Detection Automatic Optimizes the Fix Photo adjustments for specific types of

photos; select the option that best matches your photoPeople content
Landscape
Night Scene

Fix Red-Eye Off Does not automatically fix the red-eye effect in photos
On Automatically fixes the red-eye effect in photos

Filter Off Turns off the filter setting
Sepia Applies a sepia tone filter to the viewed or printed photo
B&W Applies a black-and-white filter to the viewed or printed

photo
Brightness Various settings Adjust individual qualities in your photo
Contrast
Sharpness
Saturation

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces.
For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a
face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the
special color effects.

Parent topic: Selecting Print and Photo Adjustment Settings

Connecting and Printing from a Camera
Before you connect your camera, make sure the product is turned on but not printing.
1. Remove any memory cards from the product.
2. Load the paper you want to use for printing.
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3. Connect the USB cable that came with your camera to the USB port on the front of your product.

Note: You cannot use the USB port to transfer images from your camera to your computer.

4. Turn on your camera.
5. Follow the instructions that came with your camera to select and print your photos.
When you finish printing, turn off your camera and disconnect it from the product.
Parent topic: Printing from a Camera Connected to Your Product
Related tasks
Removing a Memory Card
Related topics
Loading Paper

Viewing or Printing from a USB Flash Drive or External Device
You can view and print photos from a USB thumb drive or other external storage device, such as an
external hard drive or CD/DVD burner.

Note: Make sure the files on your device are compatible with the product.

USB Device File Specifications
Connecting and Using a USB Flash Drive or External Device
Parent topic: Using an External Device with Your Product
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Related tasks
Removing a Memory Card
Related topics
Loading Paper
Viewing and Printing Photos

USB Device File Specifications
You can print external device files that meet these specifications.

File format JPEG with the Exif version 2.3 standard
Image size 80 × 80 pixels to 9200 × 9200 pixels
Number of files Up to 9990

Parent topic: Viewing or Printing from a USB Flash Drive or External Device

Connecting and Using a USB Flash Drive or External Device
Before you connect your thumb drive or device, make sure the product is turned on but not printing.

Note: Epson cannot guarantee the compatibility of your drive.

1. Remove any memory cards from the product.
2. Load the paper you want to use for printing.
3. Insert your USB thumb drive or the USB cable that came with your device into the USB port on

the front of your product.
4. Insert storage media (such as a CD) into your drive, if necessary.
5. Select the photos to print from the LCD screen.
When you finish printing, make sure the access light on the drive is not flashing, then remove or
disconnect it from the product.

Caution: Do not remove the USB drive or turn off the product when the access light is flashing, or you
may lose photos on the drive.

Parent topic: Viewing or Printing from a USB Flash Drive or External Device
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Printing Personalized Projects
You can turn any photo or drawing into a coloring book page, or print lined paper, graph paper, or
stationery with a photo background.
Printing Coloring Book Pages
Printing Personalized Note Paper
Printing Lined Paper and Graph Paper

Printing Coloring Book Pages
You can create a coloring book page from a photo on your memory card, or from a photo or drawing
placed on the scanner glass.
1. Load one of these types of paper in either Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7

inches [210 × 297 mm]) size:
• Plain paper
• EPSON Bright White Paper
• EPSON Presentation Paper Matte
• EPSON Premium Presentation Paper Matte
• EPSON Velvet Fine Art Paper (letter-size only)

2. Press the home button, if necessary.
3. Select More Functions.
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4. Scroll down and select Coloring Book.

5. Do one of the following:
• Select Photo or Drawing on Scanner Glass to print a design from an original placed facedown

on the scanner glass, in the front right corner.
• Select Photo on Memory Card to print a design from a memory card inserted in your product,

then select a photo.
6. Select Proceed.
7. Select Paper Settings and select the size and type of paper that you loaded.
8. Select Paper Source and select where you loaded your paper.
9. If necessary, adjust the following settings:

• Density to make the print lighter or darker
• Line Detection to change the amount of detail in the print

10. When you are ready to print, press the start button.

Note: To cancel printing, select Cancel.

Parent topic: Printing Personalized Projects
Related tasks
Inserting a Memory Card
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Related topics
Loading Paper
Placing Originals on the Product

Printing Personalized Note Paper
You can print lined or unlined note paper with one of your own photos in the background.
1. Load plain paper in either Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7 inches

[210 × 297 mm]) size.
2. Insert a memory card into your product's memory card slot.

3. Press the home button, if necessary.
4. Select More Functions.
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5. Scroll down and select Print Ruled Papers.

6. Scroll down and select one of the following settings:
• Watermark without Rule
• Watermark Horizontal Rule
• Watermark Vertical Rule

Note: View the thumbnails next to each option to preview the design layout.

7. Select the size of paper you loaded.
8. Select the photo you want to use for your note paper, then select Proceed.

Note: To rotate the layout, select Rotate.

9. When you see a message asking you to load paper, select Proceed.
10. To print more than one sheet, press + or – to select the number (up to 99).
11. When you are ready to print, press the start button.

Note: To cancel printing, select Cancel.

Parent topic: Printing Personalized Projects
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Related tasks
Inserting a Memory Card
Related topics
Loading Paper

Printing Lined Paper and Graph Paper
You can print wide-rule or narrow-rule notebook paper and graph paper.
1. Load plain paper in either Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7 inches

[210 × 297 mm]) size.

2. Press the home button, if necessary.
3. Select More Functions.
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4. Scroll down and select Print Ruled Papers.

5. Select one of the following settings:
• Wide Rule Only
• Thin Rule Only
• Graph Paper Only

Note: View the thumbnails next to each option to preview the design layout.

6. Select the size of paper you loaded.
7. When you see a message asking you to load paper, select Proceed.
8. To print more than one sheet, press + or – to select the number (up to 99).
9. When you are ready to print, press the start button.

Note: To cancel printing, select Cancel.

Parent topic: Printing Personalized Projects
Related topics
Loading Paper
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Printing on CDs/DVDs
Follow the instructions here to print a design onto ink jet-printable CDs or DVDs to create a custom label.
CD/DVD Printing Features
Loading a CD/DVD
Removing a Printed CD/DVD
Placing a CD/DVD on the Scanner Glass
Copying onto a CD/DVD
Printing Photos from a Memory Card Onto a CD/DVD
Printing a Jewel Case Insert from a Memory Card
Printing on CDs/DVDs from a Computer

CD/DVD Printing Features
You can use any of the following features to print custom CD/DVD labels and accessories:
• Copy an existing CD/DVD label onto a new CD/DVD
• Use your product's control panel to print photos from a memory card onto a CD/DVD
• Print text and images from your computer using the EPSON Print CD software that came with your

product
You can also use your product's control panel to create a jewel case insert with photos from a memory
card.
Parent topic: Printing on CDs/DVDs
Related tasks
Copying onto a CD/DVD
Printing Photos from a Memory Card Onto a CD/DVD
Printing a Jewel Case Insert from a Memory Card

Loading a CD/DVD
You can print on any compatible, ink jet-printable CDs or DVDs, including Blu-ray Discs.

Caution: Do not insert the CD/DVD tray while the product is printing, copying, or performing other
operations. Otherwise, your product may be damaged or the surface of the CD/DVD may become dirty
or scratched.
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Note: If you are using discs where the printable area extends to within 0.16 inch (4 mm) of the center
hole, you may need to adjust the inner diameter setting using the control panel or EPSON Print CD
software.

1. Burn your files, music, or video onto your disc before printing on it.

2. Press the home button, if necessary.
3. Press the CD button and select Load CD/DVD.
4. When you see a message asking if you want to prepare for CD loading, select Yes.
5. Raise the control panel all the way up.

6. Make sure nothing is on the output tray, then close it.

7. Close the front cover.
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8. Remove the CD/DVD tray from the bottom of the product.

9. Place a CD or DVD on the CD/DVD tray with the printable side faceup, and insert the tray into the
slot above the output tray.

Note: Make sure the marks on the tray and the marks on the product line up.

10. Select Ready > OK on the touch panel.

Note: The CD/DVD tray ejects automatically after a certain period of time.

Caution: Do not turn off the product with a CD or DVD loaded in it. Always remove the disc first.
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Parent topic: Printing on CDs/DVDs

Removing a Printed CD/DVD
After your CD or DVD is printed, the tray extends automatically.
1. Pull the CD/DVD tray out of the product, and then remove your CD or DVD from the tray.

2. Insert the CD/DVD tray into the storage slot on the bottom of the product.

After printing, handle the CD or DVD carefully. You may need to wait up to 24 hours for the ink to dry fully
before inserting it in a drive, depending on the type of disc you used. Keep printed discs away from
moisture and direct sunlight.
Parent topic: Printing on CDs/DVDs
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Placing a CD/DVD on the Scanner Glass
You can place a CD or DVD on the scanner glass and copy the label design onto another CD or DVD.
1. Open the document cover.
2. Place your CD or DVD facedown in the center of the scanner glass.

3. Close the document cover gently to keep your disc in place.
Parent topic: Printing on CDs/DVDs

Copying onto a CD/DVD
You can copy a printed photo or CD/DVD label directly onto an ink jet-printable CD or DVD. If you want,
you can first print a test design on plain paper.
1. Load the CD, DVD, or plain paper you want to print on.

2. Press the home button, if necessary.
3. Press the CD button.
4. Select CD/DVD Copy.
5. Follow the instructions on the LCD screen to place your original CD, DVD, or photo on the scanner

glass, then select Proceed.
6. If necessary, adjust the inner and outer diameter of your CD as shown on the screen, then select

Proceed.
You see this screen:
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7. Select one of the options shown on the screen to print on a CD/DVD or a test print on plain paper. If
printing on plain paper, select Proceed.

8. Select any copy settings as needed.

9. When you are ready to print, press the start button.

Note: To cancel printing, select Cancel.

Parent topic: Printing on CDs/DVDs
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Related tasks
Loading a CD/DVD
Placing a CD/DVD on the Scanner Glass
Related topics
Loading Paper
Placing Originals on the Product

Printing Photos from a Memory Card Onto a CD/DVD
You can print one or more photos from a memory card directly onto a CD/DVD. If you want, you can first
print a test design on plain paper.
1. Insert a memory card into a memory card slot on your product.
2. Load the CD, DVD, or plain paper you want to print on.

3. Press the home button, if necessary.
4. Press the CD button.
5. Select Print on CD/DVD.

6. Select a layout.
7. Follow the instructions on the screen to select your photo or photos.
8. When you see the screen to adjust the inner and outer diameter of your CD, adjust the settings if

necessary, then select Proceed.
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You see this screen:

9. Select one of the options shown on the screen to print on a CD/DVD or a test print on plain paper. If
printing on plain paper, select Proceed.

10. Adjust the CD Density setting if necessary, then press the start button to print.

Note: To cancel printing, select Cancel.

Parent topic: Printing on CDs/DVDs
Related tasks
Loading a CD/DVD
Inserting a Memory Card
Related topics
Loading Paper

Printing a Jewel Case Insert from a Memory Card
You can print a photo from a memory card, automatically sized to fit on a CD/DVD jewel case insert. You
can also print thumbnail images formatted to fit on a jewel case insert. After the insert is printed, you can
cut and fold it to fit.
1. Insert a memory card into a memory card slot on your product.
2. Load the paper you want to print on.
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3. Press the home button, if necessary.
4. Select More Functions.

5. Select Photo Layout Sheet.

6. Scroll down and then select one of the following:
• Jewel Upper to print one photo on the upper half of the insert.
• Jewel Index to print 24 or 48 thumbnail images on the insert.

7. Select your paper size and type, then select Proceed.
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8. Follow the instructions on the LCD display to select your photos and set the number of copies.
9. When you see the Print Settings screen, change your print settings if necessary.
10. When you are ready to print, press the start button.

Note: To cancel printing, select Cancel.

11. After your insert is printed, cut and fold it following the crop lines.
Parent topic: Printing on CDs/DVDs
Related tasks
Inserting a Memory Card
Related topics
Loading Paper

Printing on CDs/DVDs from a Computer
Before printing directly on CDs or DVDs from your computer, make sure you have set up your product
and installed the EPSON Print CD software as described on the Start Here sheet.
Printing on a CD/DVD with Windows
Printing on a CD/DVD with Mac OS X
Parent topic: Printing on CDs/DVDs
Related tasks
Loading a CD/DVD

Printing on a CD/DVD with Windows
You can print with your product using the EPSON Print CD software, as described in these sections.
Designing a CD/DVD - Windows
Printing Your CD/DVD Design - Windows
Adjusting CD/DVD Print Position - Windows
Adjusting CD/DVD Print Quality - Windows
Parent topic: Printing on CDs/DVDs from a Computer

Designing a CD/DVD - Windows
You can use EPSON Print CD to design your disc by importing photos, adding text, and creating special
effects.
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1. Open the EPSON Print CD program on your computer.
You see this screen:

2. Use the buttons on the left side of the screen to select a pre-designed template or add a background
image, picture, text, or graphic elements. For more information, select the Help menu.

3. When you are finished creating your design, click Save and save your design file.
Parent topic: Printing on a CD/DVD with Windows

Printing Your CD/DVD Design - Windows
After you create your design, you can print it on paper to test it, then print it on the CD or DVD that
contains your data, photos, video, or music. Make sure the disc is loaded for printing before you start.
1. Open your file in EPSON Print CD and click Print.

You see this screen:
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2. Make sure your product is selected as the Printer setting.
3. To see how your design will look without printing on the disc, click Test Print and follow the

instructions on the screen.
4. When you are ready to print on the disc, click the Print button on the screen.
5. Click Print.
Parent topic: Printing on a CD/DVD with Windows

Adjusting CD/DVD Print Position - Windows
If your printed design is not positioned correctly on the disc, you can adjust the print position. First, load
an extra CD/DVD to use for printing test patterns.
1. Open your file in EPSON Print CD and click Print.

You see this screen:
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2. Select Print Position Confirmation Pattern.
3. Click Print.
4. Remove the disc after printing.
5. Using a metric ruler, measure the distance from the hole to the cross marks labeled Top and Right.

Note: Be sure to measure from the edge of the hole and not the edge of the printable area.

6. Click Print again, then select Adjust Print Position.
You see this screen:
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7. Click Enter Values, then select the distance for Top into the Height (Top) box and the distance for
Right in the Width (Right) box.

8. Click OK.
Parent topic: Printing on a CD/DVD with Windows

Adjusting CD/DVD Print Quality - Windows
If ink smears on your disc or is sticky after it dries, you can adjust the color saturation and ink density.
This may be necessary to make sure your designs look their best on the particular brand of discs you are
using. First, load an extra CD/DVD to use for printing test patterns.
1. Open your file in EPSON Print CD and click Print.

You see this screen:
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2. Select Print Density Confirmation Pattern.
3. Click Print.
4. Remove the disc after printing and check to see if you need to make the density darker or lighter.
5. Load the same disc in the product again.
6. Click Print.
7. Adjust the Print Color Correction slider to a darker or lighter setting as necessary.
8. Select Print Density Confirmation Pattern and select the Second radio button.
9. Click Print to print another test pattern
10. Examine the disc after printing to see if further adjustment is needed.
When the ink density looks good, you are ready to print on your burned CD or DVD.
Parent topic: Printing on a CD/DVD with Windows

Printing on a CD/DVD with Mac OS X
You can print with your product using the EPSON Print CD software, as described in these sections.
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Designing a CD/DVD - Mac OS X
Printing Your CD/DVD Design - Mac OS X
Adjusting CD/DVD Print Position - Mac OS X
Adjusting CD/DVD Print Quality - Mac OS X
Parent topic: Printing on CDs/DVDs from a Computer

Designing a CD/DVD - Mac OS X
You can use EPSON Print CD to design your disc by importing photos, adding text, and creating special
effects.
1. Open the EPSON Print CD program in the Applications > Epson Software > Print CD folder on

your Mac.
You see this screen:

2. Use the icons on the left side of the screen to add a background image, picture, text, or graphic
elements.
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3. When you are finished creating your design, make sure you save it.
Parent topic: Printing on a CD/DVD with Mac OS X

Printing Your CD/DVD Design - Mac OS X
After you create your design, you can print it on paper to test it, then print it on the CD or DVD that
contains your data, photos, video, or music. Make sure the disc is loaded for printing before you start.
1. Open your file in EPSON Print CD and select Print from the File menu.

You see this screen:

2. Make sure your product is selected as the Printer setting.
3. To see how your design will look without printing on the disc, select Test Print and follow the

instructions on the screen.
4. When you are ready to print on the disc, click the Print button on the screen.
Parent topic: Printing on a CD/DVD with Mac OS X

Adjusting CD/DVD Print Position - Mac OS X
If your printed design is not positioned correctly on the disc, you can adjust the print position. First, load
an extra CD/DVD to use for printing test patterns.
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1. Open your file in EPSON Print CD and select Print from the File menu.
You see this screen:

2. Select Print Position Check Pattern.
3. Click Print.
4. Remove the disc after printing.
5. Using a metric ruler, measure the distance from the hole to the cross marks labeled Top and Right.

Note: Be sure to measure from the edge of the hole and not the edge of the printable area.

6. Select Print from the File menu.
7. Select Position Adjustment.

You see this screen:
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8. Click Value Entry, then select the distance for Top into the Top Space box and the distance for
Right in the Right Space box.

9. Click OK.
Parent topic: Printing on a CD/DVD with Mac OS X

Adjusting CD/DVD Print Quality - Mac OS X
If ink smears on your disc or is sticky after it dries, you can adjust the color saturation and ink density.
This may be necessary to make sure your designs look their best on the particular brand of discs you are
using. First, load an extra CD/DVD to use for printing test patterns.
1. Open your file in EPSON Print CD and select Print from the File menu.

You see this screen:
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2. Select Print Density Check Pattern.
3. Click Print.
4. Remove the disc after printing and check to see if you need to make the density darker or lighter.
5. Load the same disc in the product again.
6. Select Print from the File menu.
7. Select a darker or lighter setting in the Color Correction box as necessary.
8. Select Print Density Check Pattern and select Second Time.
9. Click Print to print another test pattern.
10. Examine the disc after printing to see if further adjustment is needed.
When the ink density looks good, you are ready to print on your burned CD or DVD.
Parent topic: Printing on a CD/DVD with Mac OS X
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Replacing Ink Cartridges
When an ink cartridge is expended, you need to replace it.
You may also need to replace a cartridge that is more than six months old, if your printouts do not look
their best, even after cleaning and aligning the print head.

Note: Please dispose of your used EPSON branded ink cartridges responsibly and in accordance with
local requirements. If you would like to return your used ink cartridges to Epson for proper disposal,
please go to www.epson.com/recycle for more information.

Check Cartridge Status
Purchase EPSON Ink Cartridges
Removing and Installing Ink Cartridges
Conserving Low Black Ink with Windows

Check Cartridge Status
Your product and its printing software will let you know when an ink cartridge is low or expended.
Checking Cartridge Status on the LCD Screen
Checking Cartridge Status with Windows
Checking Cartridge Status with Mac OS X
Parent topic: Replacing Ink Cartridges

Checking Cartridge Status on the LCD Screen
You can check the status of your ink cartridges using your product's LCD screen.

1. Press the home button, if necessary.
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2. Press the left or right arrow button and then select Setup.

3. Select Ink Levels.
The ink cartridge status is displayed.

Note: Displayed ink levels are approximate.

4. Select OK to exit.
Parent topic: Check Cartridge Status
Related tasks
Removing and Installing Ink Cartridges

Checking Cartridge Status with Windows
A low ink reminder appears if you try to print when ink is low, and you can check your cartridge status at
any time using a utility on your Windows computer.
1. To check your cartridge status, double-click the product icon in the Windows taskbar.

You see this window:
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2. Replace or reinstall any ink cartridge indicated on the screen.

Note: If any of the cartridges installed in the product is broken, incompatible with the product model,
or improperly installed, EPSON Status Monitor will not display an accurate cartridge status.

3. To disable the low ink reminder, right-click the product icon in the Windows taskbar and select
Monitoring Preferences.
You see this window:
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4. Deselect the See Low Ink Reminder alerts checkbox at the bottom of the screen.
5. To disable promotional offers, deselect the Display Epson Offers checkbox.
Parent topic: Check Cartridge Status
Related tasks
Removing and Installing Ink Cartridges
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Checking Cartridge Status with Mac OS X
You can check the status of your ink cartridges using a utility on your Mac.
1. Do one of the following:

• Mac OS X 10.6/10.7/10.8: In the Apple menu or the Dock, select System Preferences. Select
Print & Fax or Print & Scan, select your product, and select Options & Supplies. Select Utility
and select Open Printer Utility.

• Mac OS X 10.5: In the Apple menu or the Dock, select System Preferences. Select Print & Fax,
select your product, and select Open Print Queue. Select Utility.

2. Select EPSON Status Monitor.
You see this window:
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3. Do the following as necessary:
• You can update the ink cartridge status by clicking Update.
• Replace or reinstall any ink cartridge indicated on the screen.

Note: If any of the cartridges installed in the product is broken, incompatible with the product model,
or improperly installed, EPSON Status Monitor will not display an accurate cartridge status.

Parent topic: Check Cartridge Status
Related tasks
Removing and Installing Ink Cartridges

Purchase EPSON Ink Cartridges
You can purchase genuine EPSON ink and paper at EPSON Supplies Central at www.epson.com/ink3
(U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an EPSON
authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

Note: We recommend that you use genuine EPSON cartridges and do not refill them. The use of other
products may affect your print quality and could result in printer damage.
The cartridges included with the printer are designed for printer set up and not for resale. After some ink
is used for priming, the rest is available for printing. Yields vary considerably based on images printed,
print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink
remains in the cartridge after the "replace cartridge" indicator comes on.

Ink Cartridge Part Numbers
Parent topic: Replacing Ink Cartridges

Ink Cartridge Part Numbers
Use these part numbers when you order or purchase new ink cartridges.

Note: For best printing results, use up a cartridge within 6 months of opening the package.

Ink color Part number
Standard-capacity High-capacity

Black 277 277XL
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Ink color Part number
Standard-capacity High-capacity

Cyan 277 277XL
Magenta 277 277XL
Yellow 277 277XL
Light Cyan 277 277XL
Light Magenta 277 277XL

Parent topic: Purchase EPSON Ink Cartridges

Removing and Installing Ink Cartridges
Make sure you have your replacement cartridges handy before you begin. You must install new
cartridges immediately after removing the old ones.

Caution: Leave your old cartridges in the printer until you are ready to replace them to prevent the print
head nozzles from drying out. Do not open ink cartridge packages until you are ready to install the ink.
Cartridges are vacuum packed to maintain reliability.

1. Make sure that the CD/DVD tray is not inserted for printing.
2. Turn on your product.

• If an ink cartridge is expended, you see a message on the LCD screen. Note which cartridges
need to be replaced and select Proceed, then choose Yes, replace now.

• If you are replacing a cartridge before you see a message on the LCD screen, select Setup >
Maintenance > Ink Cartridge Replacement.
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3. Lift up the scanner unit.

Caution: Do not move the print head by hand; otherwise, you may damage your product. Do not
touch the flat white cable inside the printer.

4. Push in the blue tab to unlock the ink cartridge you are replacing. Then lift the bottom of the ink
cartridge to remove it.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,
flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away.
Keep ink cartridges out of the reach of children.
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5. Recap the used ink cartridge using the cap that came with it.

Note: Dispose of used cartridges carefully. Do not take the used cartridge apart or try to refill it.

6. Remove the new ink cartridge from the package.

Caution: Do not shake the cartridges after opening the packages, or ink may leak. Do not touch the
areas shown above. Doing so may prevent normal operation and printing.
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7. Remove the cap from the cartridge and store it in the bag that came with your product for later use.

Note: Save the cap so you can recap ink cartridges before storing or disposing of them.

Caution: Do not remove any other labels or seals, or ink will leak.

8. Insert the ink cartridge head first into the ink cartridge holder. Then press the bottom of the ink
cartridge down until it clicks into place.

260



9. Once you replace all the cartridges that need replacing, close the scanner unit.

The product starts priming the ink. This takes a few minutes. When you see a completion message
on the LCD screen, ink replacement is complete.

Note: If you see an error screen telling you an ink cartridge is installed incorrectly, lift up the scanner
unit and press the ink cartridge down until it clicks into place. When you're finished, close the
scanner unit.

If you remove a low or expended ink cartridge, you cannot re-install and use the cartridge.

Caution: If you remove an ink cartridge for later use, recap the ink cartridge using the cap that came
with it to prevent the ink from drying out and to protect the surrounding area from getting smeared by ink.
Store the ink cartridge in the same environment as the product. Do not leave the product with the ink
cartridges removed for an extended period of time. Otherwise, ink remaining in the print head nozzles
may dry out and you may not be able to print.

Parent topic: Replacing Ink Cartridges
Related concepts
Purchase EPSON Ink Cartridges

Conserving Low Black Ink with Windows
The following window appears when black ink runs low and there is more color ink.
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Note: The window appears only when you have selected Plain Paper/Bright White Paper as the paper
type setting, and depends on other selected print settings. To use this feature, EPSON Status Monitor
must be enabled.

• Click Yes to use a mixture of color inks to create black, or No to continue using the remaining black ink
for the document you are printing.

• Click Disable this feature to continue using the remaining black ink.

Note: If you disable this feature, it remains disabled unless you reinstall the printer software.

Parent topic: Replacing Ink Cartridges
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Adjusting Print Quality
If your print quality declines, you may need to run a utility to clean or align the print head.
If running these utilities does not solve the problem, you may need to replace the ink cartridges.
Print Head Maintenance
Print Head Alignment
Cleaning the Paper Path
Related topics
Replacing Ink Cartridges

Print Head Maintenance
If your printouts become too light, or you see dark or light bands across them, you may need to clean the
print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.
You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.

Print Head Nozzle Check
Print Head Cleaning
Parent topic: Adjusting Print Quality
Related topics
Replacing Ink Cartridges

Print Head Nozzle Check
You can print a nozzle check pattern to check for clogged nozzles.
Checking the Nozzles Using the Product Control Panel
Checking the Nozzles Using a Computer Utility
Parent topic: Print Head Maintenance

Checking the Nozzles Using the Product Control Panel
You can check the print head nozzles using the control panel on your product.
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1. Make sure the CD/DVD tray is not inserted for printing.
2. Load a few sheets of plain paper in the product.

3. Press the home button, if necessary.
4. Press the left or right arrow button and then select Setup.
5. Select Maintenance.

6. Select Nozzle Check.

7. Press the start button.
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The nozzle check pattern is printed.
8. Check the printed pattern to see if there are gaps in the lines.

Print head is clean

Print head needs cleaning

9. Do one of the following:
• If there are no gaps, the print head is clean. Select Done.
• If there are gaps or the pattern is faint, select Clean the Print Head.

10. Follow the instructions on the screen to clean the print head.
If you don’t see any improvement after cleaning the print head up to 2 times, leave the product on and
wait at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the
ink cartridges may be old or damaged and needs to be replaced.
Parent topic: Print Head Nozzle Check
Related tasks
Cleaning the Print Head Using the Product Control Panel
Loading Paper in Cassette 2 (Lower Cassette)
Related topics
Replacing Ink Cartridges

Checking the Nozzles Using a Computer Utility
You can check the print head nozzles using a utility on your Windows or Mac computer.
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1. Make sure the CD/DVD tray is not inserted for printing.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:

• Windows: Right-click the product icon in the Windows taskbar.
• Mac OS X 10.6/10.7/10.8: In the Apple menu or the Dock, select System Preferences. Select

Print & Fax or Print & Scan, select your product, and select Options & Supplies. Select Utility
and select Open Printer Utility.

• Mac OS X 10.5: In the Apple menu or the Dock, select System Preferences. Select Print & Fax,
select your product, and select Open Print Queue. Select Utility.

4. Select Nozzle Check.
You see one of these windows:
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5. Click Print.
6. Check the printed pattern to see if there are gaps in the lines.

Print head is clean

Print head needs cleaning
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7. If there are no gaps, click Finish.
If there are gaps or the pattern is faint, clean the print head.

Parent topic: Print Head Nozzle Check
Related tasks
Cleaning the Print Head Using a Computer Utility
Loading Paper in Cassette 2 (Lower Cassette)
Related topics
Replacing Ink Cartridges

Print Head Cleaning
If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the
print head.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.

Cleaning the Print Head Using the Product Control Panel
Cleaning the Print Head Using a Computer Utility
Parent topic: Print Head Maintenance
Related topics
Replacing Ink Cartridges

Cleaning the Print Head Using the Product Control Panel
You can check the print head nozzles using the control panel on your product.
1. Make sure the CD/DVD tray is not inserted for printing.
2. Load a few sheets of plain paper in the product.

3. Press the home button, if necessary.
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4. Press the left or right arrow button and then select Setup.
5. Select Maintenance.

6. Select Head Cleaning.

7. Press the start button to clean the print head. You see a message on the LCD screen during the
cleaning cycle.

Caution: Never turn off the product during a cleaning cycle or you may damage it.

When the cleaning cycle is finished, you see a message on the display screen.
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8. Select Print Nozzle Check Pattern, then press the start button to run a nozzle check and confirm
that the print head is clean.

If you don’t see any improvement after cleaning the print head up to 2 times, leave the product on and
wait at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the
ink cartridges may be old or damaged and needs to be replaced.
Parent topic: Print Head Cleaning
Related tasks
Checking the Nozzles Using the Product Control Panel
Loading Paper in Cassette 2 (Lower Cassette)
Related topics
Replacing Ink Cartridges

Cleaning the Print Head Using a Computer Utility
You can clean the print head using a utility on your Windows computer or Mac.
1. Make sure the CD/DVD tray is not inserted for printing.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:

• Windows: Right-click the product icon in the Windows taskbar.
• Mac OS X 10.6/10.7/10.8: In the Apple menu or the Dock, select System Preferences. Select

Print & Fax or Print & Scan, select your product, and select Options & Supplies. Select Utility
and select Open Printer Utility.

• Mac OS X 10.5: In the Apple menu or the Dock, select System Preferences. Select Print & Fax,
select your product, and select Open Print Queue. Select Utility.

4. Select Head Cleaning.
You see one of these windows:
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5. Click Start to begin the cleaning cycle.
You see a message on the LCD screen during the cleaning cycle.

Caution: Never turn off the product during a cleaning cycle or you may damage it.

6. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click Print Nozzle
Check Pattern and click Print.

7. Check the printed pattern to see if there are gaps in the lines.
Print head is clean
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Print head needs cleaning

• If there are no gaps, click Finish.
• If there are gaps or the pattern is faint, click Clean to clean the print head again.

If you don’t see any improvement after cleaning the print head up to 2 times, leave the product on and
wait at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the
ink cartridges may be old or damaged and needs to be replaced.
Parent topic: Print Head Cleaning
Related tasks
Checking the Nozzles Using a Computer Utility
Loading Paper in Cassette 2 (Lower Cassette)
Related topics
Replacing Ink Cartridges

Print Head Alignment
If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or
light horizontal bands, you may need to align the print head.

Note: Banding may also occur if your print head nozzles need cleaning.

Aligning the Print Head Using the Product Control Panel
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Aligning the Print Head Using a Computer Utility
Parent topic: Adjusting Print Quality

Aligning the Print Head Using the Product Control Panel
You can align the print head using the control panel on your product.
1. Make sure the CD/DVD tray is not inserted for printing.
2. Load a few sheets of plain paper in the product.

3. Press the home button, if necessary.
4. Press the left or right arrow buttons and then select Setup.
5. Select Maintenance.
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6. Select Print Head Alignment.

7. Press the start button to print an alignment sheet.

Note: Do not cancel printing while you are printing a head alignment pattern.

8. Check the printed pattern and select the number representing the best printed pattern for each set.
9. Select Done when you are finished.
Parent topic: Print Head Alignment
Related tasks
Loading Paper in Cassette 2 (Lower Cassette)

Aligning the Print Head Using a Computer Utility
You can align the print head using a utility on your Windows computer or Mac.
1. Make sure the CD/DVD tray is not inserted for printing.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:

• Windows: Right-click the product icon in the Windows taskbar.
• Mac OS X 10.6/10.7/10.8: In the Apple menu or the Dock, select System Preferences. Select

Print & Fax or Print & Scan, select your product, and select Options & Supplies. Select Utility
and select Open Printer Utility.
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• Mac OS X 10.5: In the Apple menu or the Dock, select System Preferences. Select Print & Fax,
select your product, and select Open Print Queue. Select Utility.

4. Select Print Head Alignment.
5. Click Next, then click Print to print an alignment sheet.

Note: Do not cancel printing while you are printing a head alignment pattern.

You see one of these windows:
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6. Check the printed pattern and follow the instructions on the screen to choose the number
representing the best printed pattern for each set.
• After choosing each pattern number, click Next.
• If no patterns are aligned in one or more of the sets, choose the closest one in each set and click

Realignment. Then print another alignment sheet and check it.

Note: Click Skip (where available) if you want to skip a particular alignment sheet.

7. When you are done, click Finish.
Parent topic: Print Head Alignment
Related tasks
Loading Paper in Cassette 2 (Lower Cassette)
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Cleaning the Paper Path
If you see ink on the back of a printout, you can clean the paper path to remove any excess ink.
1. Load a few sheets of plain paper in the product.
2. Use the product control panel to make a copy, but without placing a document on the scanner glass.
3. Check the back of the ejected paper to see if it is clean.
4. Repeat as necessary until the paper comes out clean.
Parent topic: Adjusting Print Quality
Related tasks
Loading Paper in Cassette 2 (Lower Cassette)
Related topics
Copying
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Cleaning and Transporting Your Product
See these sections if you need to clean or transport your product.
Cleaning Your Product
Transporting Your Product

Cleaning Your Product
To keep your product working at its best, you should clean it several times a year.
Close the output tray and front cover when you are not using the product to protect it from dust.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.
Do not use oil or other lubricants inside the product or let water get inside it.

1. Turn off the product.
2. Unplug the power cable.
3. Disconnect any connected cables.
4. Remove all the paper.
5. Clean the scanner glass with a soft, lint-free cloth (microfiber is recommended), moistened with a

little glass cleaner.

Caution: Do not spray glass cleaner directly on the glass and do not press the glass surface with
any force.
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6. Open the ADF cover and use a soft, dry, lint-free cloth (microfiber is recommended), to clean the
roller and the interior of the ADF.

7. Clean the outer case and control panel with a soft, dry cloth. Do not use liquid or chemical cleansers.
Parent topic: Cleaning and Transporting Your Product

Transporting Your Product
If you need to ship your product or transport it a long distance, prepare it for transportation as described
here.

Caution: During transportation and storage, follow these guidelines:
• Avoid tilting the product, placing it vertically, or turning it upside down; otherwise ink may leak.
• Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may prevent

the product from printing.
• Do not carry the product by its control panel; this may damage the product.

1. Turn off the product.
2. Lift up the scanner unit and check to see if the print head is in the far right position (the home

position). If not, turn on the product, wait for the print head to move, then turn the product off again.
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3. Secure the ink cartridge holder to the case with tape.

Caution: Do not place tape on the white flat cable inside the product; otherwise, you may damage
your product.

4. Lower the scanner unit.
5. Remove all the paper from the product.
6. Unplug the power cable.
7. Disconnect any connected cables.
8. Close the rear paper feed slot cover, the output tray, the ADF input tray, and the ADF output tray

extension. Then lower the control panel.
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9. Place the product in its original packing materials, if possible, or use equivalent materials with
cushioning around the product.

Keep the product level during transportation. Be sure to remove the tape from the ink cartridge holder
before turning on your product. If print quality has declined when you print again, clean and align the
print head.
Parent topic: Cleaning and Transporting Your Product
Related concepts
Print Head Cleaning
Print Head Alignment
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Solving Problems
Check these sections for solutions to problems you may have using your product.
Checking for Software Updates
Product Status Messages
Running a Product Check
Resetting Control Panel Defaults
Solving Setup Problems
Solving Network Problems
Solving Copying Problems
Solving Paper Problems
Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems
Solving Scanning Problems
Solving Scanned Image Quality Problems
Solving Memory Card Problems
Solving Faxing Problems
When to Uninstall Your Product Software
Where to Get Help

Checking for Software Updates
Periodically, it's a good idea to check Epson's support website for free updates to your product software.
You can select Download the Latest Software from the Home screen of this manual or visit Epson's
driver download site (U.S. downloads or Canadian downloads).
With Windows, your printer software automatically checks for updates. You can also manually update
the software by selecting Software Update or Driver Update here:
• Right-clicking the product icon in the Windows taskbar
• On the Maintenance tab in the printer settings window
• In the EPSON program group under your product name
Parent topic: Solving Problems
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Related tasks
Changing Automatic Update Options

Product Status Messages
You can often diagnose problems with your product by checking the messages on its LCD screen. You
can also see help information and how-to instructions on the screen. Press the home button, if
necessary, press the left or right arrow button, and then select Help.

LCD screen message Condition/solution
Paper jam Paper is jammed in the product. Follow the instructions on the LCD screen to

remove the jammed paper from the indicated area.
Paper out No paper is loaded. Load paper in the product.
Photos not recognized. There is a problem with originals placed on the product. Check to make sure
Place the photos they are placed correctly and repeat the operation.
correctly on the scanner
glass.
Printer error. Turn the A fatal error has occurred. Turn the product off and then back on again. If the
power off and on again. error continues, check for a paper jam. If there is no paper jam, contact
For details, see your Epson for support.
documentation.
Communication error. Make sure the computer is connected to your product and your scanning
Check if a computer is software is installed correctly.
connected.
A printer's ink pad is The ink pads are near the end of their service life and the message will be
nearing the end of its displayed until the ink pad is replace. Contact Epson for support. (To resume
service life. Please printing, press the start button.)
contact Epson Support.
A printer's ink pad is at The ink pad is at the end of its service life. Turn off the product and contact
the end of its service life. Epson for support.
Please contact Epson
Support.
Memory card or external Make sure the memory card or external device is inserted correctly and
device not recognized. meets the specifications for your product.
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LCD screen message Condition/solution
No dial tone detected. Make sure the phone cable is connected correctly and the phone line works.
Run Check Fax If you connected the product to a PBX (Private Branch Exchange) phone line
Connection under Fax or Terminal Adapter, turn off the Dial Tone Detection setting.
Settings in Setup menu.
Combination of IP There is a problem with the network connection to your product.
address and subnet
mask is invalid. See
your documentation.
Recovery mode An error has occurred during firmware updating. Connect your product using

a USB cable and try downloading the Firmware Update from Epson's support
website. If you still need help, contact Epson for support.

Parent topic: Solving Problems
Related references
Fax Communications Options
Where to Get Help
Paper Jam Problems Inside the Product
Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Auto Duplexer
Paper Jams in the Automatic Document Feeder
Related topics
Loading Paper
Placing Originals on the Product

Running a Product Check
Running a product check helps you determine if your product is operating properly.
1. Disconnect any interface cables connected to your product.
2. Load plain paper in the product.

3. Press the home button, if necessary.
4. Press the left or right arrow button and then select Setup.
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5. Select Maintenance.

6. Select Nozzle Check.

7. Press the start button.
The nozzle check pattern is printed.

8. Do one of the following, depending on the results of the product check:
• If the page prints and the nozzle check pattern is complete, the product is operating properly. Any

operation problem you may have could be caused by your computer, cable, software, or selected
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settings. Check the other solutions in this book or try uninstalling and reinstalling your printer
software.

• If the page prints but the nozzle check pattern has gaps, clean or align the print head.
• If the page does not print, the product may have a problem. Check the other solutions in this

manual. If they do not work, contact Epson.
Parent topic: Solving Problems
Related concepts
Print Head Cleaning
Print Head Alignment
When to Uninstall Your Product Software
Related references
Where to Get Help

Resetting Control Panel Defaults
If you have a problem with settings on the product control panel, you can reset them to their factory
defaults. You can choose which settings to reset or reset them all.

1. Press the home button, if necessary.
2. Press the left or right arrow button and then select Setup.
3. Scroll down and select Restore Default Settings.
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4. Select one of these options:
• Fax Send/Receive Settings: Resets all settings on the Send Settings, Receive Settings, and

Communication screens.
• Fax Data Settings: Erases the speed dial list, group dial list, header, and fax log.
• Wi-Fi/Network Settings: Resets all network settings.
• All except Wi-Fi/Network & Fax Settings: Resets all control panel settings, except for network

and fax settings.
• All Settings: Resets all control panel settings.
You see a confirmation screen.

5. Select Yes to reset the selected settings. (Select No if you want to cancel the operation.)
Parent topic: Solving Problems

Solving Setup Problems
Check these sections if you have problems while setting up your product.
Noise After Ink Installation
Software Installation Problems
Control Panel Setup Problems
Parent topic: Solving Problems

Noise After Ink Installation
If you hear noises from your product after installing ink, check the following:
• The first time you install ink cartridges, the product must prime its print head. Wait until priming

finishes before you turn off the product, or it may prime improperly and use excess ink the next time
you turn it on. Your product is finished priming the print head when the power light stops flashing.

• If the product's print head stops moving or making noise, and the charging process has not finished
after approximately 5 minutes, turn off your product. Turn it back on and check to see if charging is still
in progress. If it is still in progress, contact Epson for help.

Parent topic: Solving Setup Problems
Related references
Where to Get Help
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Software Installation Problems
If you have problems while installing your product software, try these solutions:
• Make sure your product is turned on and the USB cable is securely connected at both ends. If you still

have problems installing software, disconnect the cable and carefully follow the instructions on the
Start Here sheet. Also make sure your system meets the requirements for your operating system.

• Close any other programs, including screen savers and virus protection software, and install your
product software again.

• In Windows, make sure your product is selected as the default printer and the correct port is shown in
the printer properties.

• If you see any error message or your software does not install correctly in Windows, you may not have
software installation privileges. Contact your System Administrator.

Parent topic: Solving Setup Problems
Related concepts
When to Uninstall Your Product Software
Related references
Windows System Requirements
Mac System Requirements

Control Panel Setup Problems
If you have problems setting up the control panel, try these solutions:
• To view LCD screen text in a different language, you can select a different Language setting.
• To adjust the position of the control panel, carefully raise or lower it.
Parent topic: Solving Setup Problems
Related tasks
Adjusting Control Panel Position
Changing LCD Screen Language

Solving Network Problems
Check these solutions if you have problems setting up or using your product on a network.
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Note: Breakdown or repair of this product may cause loss of fax and network data and settings. Epson is
not responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your fax and network data and settings.

Product Cannot Connect to a Wireless Router or Access Point
Network Software Cannot Find Product on a Network
Product Does Not Appear in Mac OS X Printer Window
Cannot Print Over a Network
Cannot Scan Over a Network
Printing a Network Status Sheet
Parent topic: Solving Problems

Product Cannot Connect to a Wireless Router or Access Point
If your product has trouble finding or connecting to a wireless router or access point, try these solutions :
• Make sure to place your product within contact range of your router or access point.

Note: Avoid placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal
object, such as a filing cabinet.

• Verify that your router or access point is operating correctly by connecting to it from your computer or
another device.

• You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

• Check to see if access restrictions, such as MAC address filtering, are set on the router or access
point. If access restrictions are set, add your product's MAC address to your router's address list. To
obtain your product's MAC address, print a network status sheet. Then follow the instructions in your
router or access point documentation to add the address to the list.

• If your router or access point does not broadcast its network name (SSID), follow the instructions that
came with your product to enter your wireless network name manually.

• If your router or access point has security enabled, determine the kind of security it is using and any
required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA
passphrase correctly.

Parent topic: Solving Network Problems
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Network Software Cannot Find Product on a Network
If EpsonNet Setup cannot find your product on a network, try these solutions:
• Make sure your product is turned on and connected to your network. Verify connection using your

product control panel.
• If necessary, reinstall your product software and try running EpsonNet Setup again.
Parent topic: Solving Network Problems
Related concepts
When to Uninstall Your Product Software

Product Does Not Appear in Mac OS X Printer Window
If your product does not appear in the Mac OS X printer window, try these solutions:
• Turn your product off, wait 30 seconds, then turn it back on again.
• If you are connecting the product via EpsonNet Setup and the WiFi light on your product is not solid

green, make sure your product software was installed correctly. If necessary, reinstall your software.
Parent topic: Solving Network Problems
Related concepts
When to Uninstall Your Product Software

Cannot Print Over a Network
If you cannot print over a network, try these solutions:
• Make sure that your product is turned on.
• Make sure you install your product's network software as described in your product documentation.
• Print a network status sheet and verify that the network settings are correct. If the network status is

Disconnected, check any cable connections and turn your product off and then on again.
• If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your

network does not assign IP addresses using DHCP, set the IP address manually.
• Make sure your computer and product are both using the same wireless network.
• If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place

your product closer to your router or access point.

Note: Avoid placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal
object, such as a filing cabinet.
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• Check your wired LAN router or access point to see if the LED for the port to which your product is
connected is on or flashing . If the link LED is off, try the following:
• Make sure the Ethernet cable is securely connected to your product and to your router, access

point, switch, or hub.
• Try connecting your product to a different port or a different router, access point, switch, or hub.
• Try connecting with a different Ethernet cable.
• Try printing to your product from another computer on the network.

• If you are connecting the product via EpsonNet Setup and the WiFi light on your product is not solid
green , make sure your product software was installed correctly. If necessary, reinstall your software.

Parent topic: Solving Network Problems
Related concepts
When to Uninstall Your Product Software
Related tasks
Printing a Network Status Sheet

Cannot Scan Over a Network
If you cannot start EPSON Scan for scanning over a network, try these solutions:
• If you are scanning a large original at a high resolution, a network communication error may occur. Try

scanning again at a lower resolution.
• If network communication was interrupted while starting EPSON Scan, exit EPSON Scan, wait a few

seconds, and restart it. If EPSON Scan cannot restart, turn off your product, turn it back on, and try
restarting EPSON Scan again.

• Check the connection setting and test the connection using EPSON Scan Settings:

Windows: Click or Start > All Programs or Programs > EPSON > EPSON Scan > EPSON Scan
Settings. Make sure the Connection setting is set to Network, then click the Test button.
Mac OS X: Open the Applications folder, click Epson Software, and click EPSON Scan Settings.
Make sure the Connection setting is set to Network, then click the Test button.

• Make sure the option selected as the Timeout Setting in the EPSON Scan Settings program is long
enough to complete scanning over a network.

• You may need to disable the firewall and any anti-virus software on your wireless router or access
point.
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Note: With Mac OS X 10.6, 10.7, or 10.8, in addition to scanning with Image Capture, you can download
and install EPSON Scan scanning software. EPSON Scan provides additional image adjustment and
photo correction features for enhancing scanned images, and provides an interface for TWAIN-
compliant OCR scanning software, such as ABBYY FineReader. To download EPSON Scan, visit
Epson's driver download site (U.S. downloads or Canadian downloads).

Parent topic: Solving Network Problems
Related topics
Scanning

Printing a Network Status Sheet
You can print a network status sheet to help you determine the causes of any problems you may have
using your product on a network.

1. Press the home button, if necessary.
2. Press the left or right arrow button and then select Setup.
3. Scroll down and select Wi-Fi/Network Settings.

4. Select Wi-Fi/Network Status.
5. Select Print the status sheet.
6. Press the start button to print the network status sheet.

(Select Cancel if you want to cancel the operation.)
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Examine the settings shown on the network status sheet to diagnose any problems you have.
Parent topic: Solving Network Problems

Solving Copying Problems
Check these solutions if you have problems copying with your product.
Product Makes Noise, But Nothing Copies
Product Makes Noise When It Sits for a While
Parent topic: Solving Problems

Product Makes Noise, But Nothing Copies
If your product makes a noise, but nothing copies, try these solutions:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• If the nozzle check page does not print, but the product's power light is on, make sure your product

software is installed correctly.
• Make sure your product is level (not tilted).
Parent topic: Solving Copying Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning

Product Makes Noise When It Sits for a While
Your product is performing routine maintenance. This is normal.
Parent topic: Solving Copying Problems

Solving Paper Problems
Check these sections if you have problems using paper with your product.
Paper Feeding Problems
Paper Jam Problems Inside the Product
Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Auto Duplexer
Paper Jams in the Automatic Document Feeder
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Paper Ejection Problems
Parent topic: Solving Problems

Paper Feeding Problems
If you have problems feeding paper, try these solutions:
• If paper does not feed correctly, remove and reload it against the right side of the cassette and adjust

the edge guides. Make sure the paper stack is not above the tab on the edge guides inside the
cassette.

• If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
• Do not load more than the recommended number of sheets.
• If paper jams when you print on both sides of the paper, try loading fewer sheets.
• For best results, follow these guidelines:

• Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
• Load paper in the cassette printable side down.
• Follow any special loading instructions that came with the paper.

Parent topic: Solving Paper Problems
Related references
Paper Loading Capacity
Paper Jam Problems Inside the Product
Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Auto Duplexer
Paper Jams in the Automatic Document Feeder
Related topics
Loading Paper

Paper Jam Problems Inside the Product
If you see a message that paper has jammed inside the product, follow the steps below or on the LCD
screen to clear the jam.
1. Cancel the print job, if necessary.
2. Remove any jammed paper from the rear paper feed slot.
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3. Lift the scanner unit and remove any jammed paper inside.

Caution: Do not touch the flat white cable inside the printer.

4. Close the scanner unit.
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5. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems
Related references
Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Auto Duplexer
Paper Jams in the Automatic Document Feeder

Paper Jam Problems in the Paper Cassette
If you see a message that paper has jammed in the paper cassette, follow the steps below or on the LCD
screen to clear the jam.
1. Cancel the print job, if necessary.
2. Pull out the paper cassette, then carefully remove any jammed paper.

3. Make sure the paper you loaded is under the edge guides.
4. Keep the cassette flat as you insert it. If inserting Cassette 1 (upper cassette), insert it until the arrows

on the right side line up.
5. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam

message, check the other paper jam solutions.
Parent topic: Solving Paper Problems

297



Related references
Paper Jam Problems Inside the Product
Paper Jam Problems in the Auto Duplexer
Paper Jams in the Automatic Document Feeder

Paper Jam Problems in the Auto Duplexer
If you see a message that paper has jammed in the auto duplexer, follow the steps below or on the LCD
screen to clear the jam.
1. Cancel the print job, if necessary.
2. Press the buttons to release the auto duplexer and remove the duplexer from your product. Carefully

remove any jammed paper from inside the unit.

3. Remove any jammed paper from the duplexer.
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4. Open the duplexer and remove any jammed paper from inside it.

5. Reattach the duplexer.

6. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems
Related references
Paper Jam Problems Inside the Product
Paper Jam Problems in the Paper Cassette
Paper Jams in the Automatic Document Feeder
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Paper Jams in the Automatic Document Feeder
If you have problems with paper jams in the automatic document feeder (ADF), follow the steps below or
on the LCD screen to clear the jam.
1. Cancel the print job, if necessary.
2. Remove your originals from the ADF.
3. Open the ADF cover, then carefully remove any jammed paper.

Caution: Make sure you open the ADF cover before removing any jammed paper. Otherwise the
product may be damaged.

4. Leave the ADF cover open, then raise the scanner unit.
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5. Press the tabs and remove the document mat.

6. Carefully remove any jammed paper.
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7. Reattach the document mat, lower the scanner unit, and close the ADF cover.
8. Open the ADF as shown.

9. Carefully remove any jammed paper from beneath the ADF.
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10. Close the ADF.
11. Reload your originals.

Caution: Do not load the ADF beyond its capacity for your paper size. Also make sure your originals
are not bent, folded, or curled and do not have tape, staples, or other materials that could obstruct the
feeder.

12. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems
Related references
Paper Jam Problems Inside the Product
Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Auto Duplexer
Automatic Document Feeder (ADF) Specifications

Paper Ejection Problems
If you have problems with paper ejecting properly, try these solutions:
• If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper.

Select the correct paper size when you reprint.
• If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select

the correct paper type setting when you reprint.
Parent topic: Solving Paper Problems
Related references
Paper or Media Type Settings
Paper Jam Problems Inside the Product
Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Auto Duplexer
Paper Jams in the Automatic Document Feeder
Related tasks
Cancelling Printing Using a Product Button
Related topics
Loading Paper
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Solving Problems Printing from a Computer
Check these sections if you have problems while printing from your computer.
Nothing Prints
Product Icon Does Not Appear in Windows Taskbar
Error After Cartridge Replacement
Printing is Slow
Parent topic: Solving Problems

Nothing Prints
If you have sent a print job and nothing prints, try these solutions:
• Make sure your product is turned on.
• Make sure any interface cables are connected securely at both ends.
• If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print,

connect your product directly to your computer instead of the hub.
• Run a product check to see if a test page prints. If the test page prints, check to see if your product

software is installed correctly.
• In Windows, make sure your product is selected as the default printer.
• In Windows, clear any stalled print jobs from the Windows Spooler:

• Windows 7: Click and select Devices and Printers. Right-click your product name, select See
what's printing, select your product name again if necessary, right-click the stalled print job, click
Cancel, and click Yes.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
right-click your product name, select Open, right click the stalled print job, click Cancel, and click
Yes.

• Windows XP: Click Start and select Printers and Faxes. (Or open the Control Panel, select
Printers and Other Hardware if necessary, and select Printers and Faxes.) Right-click your
product name, select Open, right-click the stalled print job, click Cancel, and click Yes.

Parent topic: Solving Problems Printing from a Computer
Related tasks
Running a Product Check
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Product Icon Does Not Appear in Windows Taskbar
If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does
not work, try this solution:
1. Do one of the following:

• Windows 7: Click and select Devices and Printers.

• Windows Vista: Click , select Control Panel, and click Printer under Hardware and Sound.
• Windows XP: Click Start and select Printers and Faxes. (Or open the Control Panel, select

Printers and Other Hardware if necessary, and Printers and Faxes.)
2. Right-click your product name, select Printing Preferences, and select your product name again if

necessary.
3. Click the Maintenance tab.
4. Click the Speed & Progress or Extended Settings button.
5. Click the Monitoring Preferences button.
6. Click the Shortcut Icon box.
7. Click OK to close the open program windows.
Parent topic: Solving Problems Printing from a Computer

Error After Cartridge Replacement
If you see an error light or error message after you replace an ink cartridge, follow these steps:
1. Make sure the print head is in the ink cartridge replacement position. (The ink cartridge holder should

be beneath the cutout in the product case, allowing access to the cartridges.)

Note: If the print head is not in the correct position, close the scanner unit, then select Setup >
Maintenance > Ink Cartridge Replacement to move it to the ink cartridge replacement position.

2. Remove and reinsert the ink cartridge you replaced, making sure to push it all the way into its slot.
3. Complete the ink cartridge installation steps.
Parent topic: Solving Problems Printing from a Computer
Related topics
Replacing Ink Cartridges
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Printing is Slow
If printing becomes slow, try these solutions:
• Make sure your system meets the requirements for your operating system. If you are printing a high-

resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory.

• If you are using Windows 7, close the Devices and Printers window before you print.
• Clear space on your hard drive or run a defragmentation utility to free up existing space.
• Close any programs you are not using when you print.
• If your product is connected to a USB hub, connect it directly to your computer instead.
• If printing becomes slower after printing continuously for a long time, the product may have

automatically slowed down to protect the print mechanism from overheating or becoming damaged.
Let the product rest with the power on for 30 minutes, then try printing again.

For the fastest printing, select the following settings in your product software:
• Make sure the paper type setting matches the type of paper you loaded.
• Turn on any high speed settings in your product software.
• Select a lower print quality setting.
• Windows: Click the Maintenance tab, select Speed & Progress or Extended Settings, and select

the following settings:
• High Speed Copies
• Always spool RAW datatype
• Page Rendering Mode
• Print as Bitmap

Parent topic: Solving Problems Printing from a Computer
Related references
Windows System Requirements
Mac System Requirements
Paper or Media Type Settings
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac OS X
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Solving Page Layout and Content Problems
Check these sections if you have problems with the layout or content of your printed pages.
Inverted Image
Too Many Copies Print
Blank Pages Print
Incorrect Margins on Printout
Border Appears on Borderless Prints
Incorrect Characters Print
Incorrect Image Size or Position
Slanted Printout
Parent topic: Solving Problems

Inverted Image
If your printed image is inverted unexpectedly, try these solutions:
• Turn off any mirror or inversion settings in your printing application.
• Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer

software. (This option has different names, depending on your operating system version.)

Note: Leave these options turned on when you print on EPSON Iron-on Cool Peel Transfer paper, if
available for your product.

Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Print Layout Options - Windows
Selecting Basic Print Settings - Mac OS X

Too Many Copies Print
Make sure that the Copies setting in your printing program or printer software is not set for multiple
copies.
Parent topic: Solving Page Layout and Content Problems
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Blank Pages Print
If blank pages print unexpectedly, try these solutions:
• Make sure you selected the correct paper size settings in your printing program and printer software.
• If a blank page exists in a document you are printing and you want to skip printing it, select the Skip

Blank Page setting in your printer software.
• Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if

necessary.
• Make sure your product is selected as the printer in your printing program.
Parent topic: Solving Page Layout and Content Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Related references
Printing Preferences - Mac OS X
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac OS X

Incorrect Margins on Printout
If your printed page has incorrect margins, try these solutions:
• Make sure you selected the correct paper size settings in your printing program and printer software.
• Make sure you selected the correct margins for your paper size in your printing program.
• Make sure your paper is positioned correctly for feeding into the printer.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Print Layout Options - Windows
Selecting Basic Print Settings - Mac OS X
Related topics
Loading Paper
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Border Appears on Borderless Prints
If you see a border on borderless prints, try these solutions:
• Make sure you are printing on a compatible borderless paper type and size.

Note: Do not select a custom paper size for borderless prints.

• Windows: Make sure you selected the Borderless setting in your printer software.
• Mac OS X: Make sure you selected the Borderless checkbox or a paper size with a Borderless

option in your printer software.
• Adjust the Expansion setting to adjust the amount of image expansion on the edges of borderless

prints.
• Make sure the image size and the paper size are set correctly; if the image is small, the enlargement

may not be enough to cover the paper.
Parent topic: Solving Page Layout and Content Problems
Related references
Borderless Paper Type Compatibility
Related tasks
Selecting Basic Print Settings - Windows
Selecting Print Layout Options - Windows
Selecting Basic Print Settings - Mac OS X
Selecting Page Setup Settings - Mac OS X

Incorrect Characters Print
If incorrect characters appear in your prints, try these solutions before reprinting:
• Make sure any cables are securely connected at both ends.
• In Windows, delete all print jobs from the Windows Spooler:

• Windows 7: Click and select Devices and Printers. Right-click your product name, select See
what's printing, select your product name again if necessary, right-click the stalled print job, click
Cancel, and click Yes.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
right-click your product name, select Open, right click the stalled print job, click Cancel, and click
Yes.
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• Windows XP: Click Start and select Printers and Faxes. (Or open the Control Panel, select
Printers and Other Hardware if necessary, and select Printers and Faxes.) Right-click your
product name, select Open, right-click the stalled print job, click Cancel, and click Yes.

• Make sure your product is selected as the printer in your printing program.
• If your product is connected to a USB hub, connect it directly to your computer instead.
Parent topic: Solving Page Layout and Content Problems

Incorrect Image Size or Position
If your printed image is the wrong size or in the wrong position, try these solutions:
• Make sure you selected the correct paper size and layout settings in your printing program and printer

software.
• Make sure your paper is positioned correctly for feeding into the printer.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Windows
Selecting Print Layout Options - Windows
Selecting Basic Print Settings - Mac OS X
Selecting Page Setup Settings - Mac OS X
Related topics
Loading Paper

Slanted Printout
If your printouts are slanted, try these solutions:
• Slide the edge guides against the edges of the paper.
• Select a higher print quality setting in your printer software.
• Align the print head.
• Make sure the product is not printing while tilted or at an angle.
Parent topic: Solving Page Layout and Content Problems
Related concepts
Print Head Alignment
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Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac OS X

Solving Print Quality Problems
Check these sections if your printouts have problems with print quality, but your image looks fine on your
computer screen.
White or Dark Lines in Printout
Blurry or Smeared Printout
Faint Printout or Printout Has Gaps
Grainy Printout
Incorrect Colors
Parent topic: Solving Problems
Related topics
Solving Scanned Image Quality Problems

White or Dark Lines in Printout
If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure you loaded the printable side of the paper facedown in the cassette or faceup in the rear

feed slot.
• Turn off any high speed settings in your product software.
• Align the print head.
• You may need to replace the ink cartridges.
Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
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Related references
Paper or Media Type Settings
Printing Preferences - Mac OS X
Related tasks
Selecting Advanced Print Settings - Windows
Related topics
Loading Paper
Replacing Ink Cartridges

Blurry or Smeared Printout
If your printouts are blurry or smeared, try these solutions:
• Make sure your paper is not damp, curled, old, or loaded faceup in the cassette (the printable side

should be facedown).
• Make sure your paper is not loaded facedown in the rear feed slot (the printable side should be

faceup)
• Use a support sheet with special paper, or load special paper one sheet at a time.
• Make sure your paper meets the specifications for your product.
• Use EPSON papers to ensure proper saturation and absorption of genuine EPSON inks.
• Make sure the paper type setting in your product software matches the type of paper you loaded.
• Remove each sheet from the output tray as it is printed.
• Avoid handling printouts on glossy paper right after printing to allow the ink to set.
• Turn off any high speed settings in your product software.
• If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily

saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first.
Adjust the Print Density and/or Increased Ink Drying Time settings.

• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

• Align the print head.
• Clean the paper path.

Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that
extends beyond the base of the product in all directions.
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Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Related references
Printing Preferences - Mac OS X
Paper Specifications
Related tasks
Selecting Basic Print Settings - Windows
Selecting Advanced Print Settings - Windows
Selecting Double-sided Printing Settings - Windows
Selecting Basic Print Settings - Mac OS X
Selecting Double-sided Printing Settings - Mac OS X
Cleaning the Paper Path
Related topics
Loading Paper

Faint Printout or Printout Has Gaps
If your printouts are faint or have gaps, try these solutions:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• The ink cartridges may be old or low on ink, and you may need to replace them.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure your paper is not damp, curled, old, or loaded faceup in the cassette (the printable side

should be facedown).
• Make sure your paper is not loaded facedown in the rear feed slot (the printable side should be

faceup).
• Align the print head.
• Clean the paper path.
Parent topic: Solving Print Quality Problems
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Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
Related references
Paper or Media Type Settings
Related tasks
Cleaning the Paper Path
Related topics
Loading Paper
Replacing Ink Cartridges

Grainy Printout
If your printouts are grainy, try these solutions:
• Make sure you loaded the printable side of the paper facedown in the cassette or faceup in the rear

feed slot.
• Select a higher print quality setting and turn off any high speed settings in your product software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• Align the print head.
• You may need to increase the image resolution or print a smaller size; see your software

documentation.
Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
Related references
Printing Preferences - Mac OS X
Related tasks
Selecting Basic Print Settings - Windows
Selecting Advanced Print Settings - Windows
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Selecting Basic Print Settings - Mac OS X
Related topics
Loading Paper

Incorrect Colors
If your printouts have incorrect colors, try these solutions:
• Make sure the Black/Grayscale or Grayscale setting is not selected in your printer software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• The ink cartridges may be old or low on ink, and you may need to replace them.
• Your printed colors can never exactly match your on-screen colors. However, you can use a color

management system to get as close as possible. Try using the color management options in your
printer software.

• For best results, use genuine EPSON ink and paper.
Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Related tasks
Selecting Basic Print Settings - Windows
Selecting Advanced Print Settings - Windows
Selecting Basic Print Settings - Mac OS X
Managing Color - Mac OS X
Related topics
Replacing Ink Cartridges

Solving Scanning Problems
Check these solutions if you have problems scanning with your product.
Scanning Software Does Not Operate Correctly
Cannot Start EPSON Scan
Parent topic: Solving Problems
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Scanning Software Does Not Operate Correctly
If your scanning software does not operate correctly, try these solutions:
• Make sure your computer has adequate memory and meets the system requirements for your

operating system.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,

wake your system and restart your scanning software.
• If you upgraded your operating system but did not reinstall your scanning software, try reinstalling it.

Note: With Mac OS X 10.6, 10.7, or 10.8, in addition to scanning with Image Capture, you can
download and install EPSON Scan scanning software. EPSON Scan provides additional image
adjustment and photo correction features for enhancing scanned images, and provides an interface
for TWAIN-compliant OCR scanning software, such as ABBYY FineReader. To download EPSON
Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

Parent topic: Solving Scanning Problems
Related concepts
When to Uninstall Your Product Software
Related references
Windows System Requirements
Mac System Requirements
Related tasks
Scanning with Mac OS X 10.6/10.7/10.8 Using Image Capture

Cannot Start EPSON Scan
If you cannot start EPSON Scan, try these solutions:
• Make sure your product is turned on and any interface cables are securely connected at both ends.
• Make sure EPSON Scan is selected in your scanning program.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,

wake your system and restart EPSON Scan.
• Check the connection setting and test the connection using EPSON Scan Settings:

Windows: Click or Start > All Programs or Programs > EPSON > EPSON Scan > EPSON Scan
Settings. Make sure the correct Connection setting is selected, then click the Test button.
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Mac OS X: Open the Applications folder, click Epson Software, and click EPSON Scan Settings.
Make sure the correct Connection setting is selected, then click the Test button.

• Make sure you do not have multiple versions of EPSON Scan installed. If you do, uninstall both
versions and install one version.

• If you upgraded your operating system but did not reinstall EPSON Scan, try reinstalling it.

Note: With Mac OS X 10.6, 10.7, or 10.8, in addition to scanning with Image Capture, you can download
and install EPSON Scan scanning software. EPSON Scan provides additional image adjustment and
photo correction features for enhancing scanned images, and provides an interface for TWAIN-
compliant OCR scanning software, such as ABBYY FineReader. To download EPSON Scan, visit
Epson's driver download site (U.S. downloads or Canadian downloads).

Parent topic: Solving Scanning Problems
Related tasks
Scanning with Mac OS X 10.6/10.7/10.8 Using Image Capture
Related topics
Starting a Scan

Solving Scanned Image Quality Problems
Check these sections if a scanned image on your computer screen has a quality problem.
Image Consists of a Few Dots Only
Line of Dots Appears in All Scanned Images
Straight Lines in an Image Appear Crooked
Image is Distorted or Blurry
Image Colors are Patchy at the Edges
Image is Too Dark
Back of Original Image Appears in Scanned Image
Ripple Patterns Appear in an Image
Scanned Image Colors Do Not Match Original Colors
Scan Area is Not Adjustable in Thumbnail Preview
Scanned Image Edges are Cropped
Parent topic: Solving Problems
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Related topics
Solving Print Quality Problems

Image Consists of a Few Dots Only
If your scanned image consists only of a few dots, try these solutions:
• Make sure you placed your original for scanning facing the correct way.
• If you are scanning using the EPSON Scan Black & White setting, adjust the Threshold setting and

scan again.
Parent topic: Solving Scanned Image Quality Problems
Related references
Available Image Adjustments - Office Mode
Available Image Adjustments - Home Mode
Available Image Adjustments - Professional Mode
Related topics
Placing Originals on the Product

Line of Dots Appears in All Scanned Images
If a line of dots appears in all your scanned images, clean the scanner glass with a soft, dry, lint-free
cloth or use a small amount of glass cleaner on the cloth, if necessary. Paper towels are not
recommended.

Caution: Do not spray glass cleaner directly on the scanner glass.

Parent topic: Solving Scanned Image Quality Problems
Related tasks
Cleaning Your Product

Straight Lines in an Image Appear Crooked
If straight lines in an original appear crooked in a scanned image, make sure to place your original
straight when you scan it.
Parent topic: Solving Scanned Image Quality Problems
Related topics
Placing Originals on the Product
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Image is Distorted or Blurry
If a scanned image appears distorted or blurry, try these solutions:
• Make sure your original is not wrinkled or warped. This may prevent the original from laying flat on the

scanner glass.
• Do not move your original or your product during scanning.
• Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that

extends beyond the base of the product in all directions.
• Adjust these EPSON Scan settings (if available) and try scanning again:

• Select the Unsharp Mask setting.
• Adjust the Auto Exposure setting.
• Increase the Resolution setting.

Parent topic: Solving Scanned Image Quality Problems
Related topics
Selecting EPSON Scan Settings

Image Colors are Patchy at the Edges
If you are scanning a thick or warped original, cover its edges with paper to block external light as you
scan it.
Parent topic: Solving Scanned Image Quality Problems

Image is Too Dark
If your scanned image is too dark, try these solutions:
• Adjust these EPSON Scan settings (if available) and try scanning again:

• Auto Exposure
• Brightness
• Histogram Adjustment

• Check the brightness and contrast settings of your computer monitor.
Parent topic: Solving Scanned Image Quality Problems
Related topics
Selecting EPSON Scan Settings
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Back of Original Image Appears in Scanned Image
If an image from the back of a thin original appears in your scanned image, place a piece of black paper
on the back of the original and scan it again.
Parent topic: Solving Scanned Image Quality Problems

Ripple Patterns Appear in an Image
You may see a ripple pattern (called a moiré) in scanned images of printed documents. This is caused
by interference from differing pitches in the scanner's screen and your original's halftone screen. To
reduce this effect, adjust these EPSON Scan settings (if available) and try scanning again:
• Select the Descreening setting.
• Select a lower Resolution setting.
Parent topic: Solving Scanned Image Quality Problems
Related topics
Selecting EPSON Scan Settings

Scanned Image Colors Do Not Match Original Colors
Printed colors can never exactly match the colors on your computer monitor because printers and
monitors use different color systems: monitors use RGB (red, green, and blue) and printers typically use
CMYK (cyan, magenta, yellow, and black).
Check the color matching and color management capabilities of your computer, display adapter, and the
software you are using to see if they are affecting the palette of colors you see on your screen.
To adjust the colors in your scanned image, adjust these EPSON Scan settings (if available) and try
scanning again:
• Change the Image Type setting and experiment with different combinations of the next settings.
• Adjust the Tone Correction setting.
• Adjust the Auto Exposure setting.
Parent topic: Solving Scanned Image Quality Problems
Related topics
Selecting EPSON Scan Settings
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Scan Area is Not Adjustable in Thumbnail Preview
If you cannot adjust the scan area while viewing a Thumbnail preview in EPSON Scan, try these
solutions:
• Create a scan area by drawing a marquee on your preview image and adjusting it as necessary.
• Switch to Normal preview mode, if available, and preview your image again.
Parent topic: Solving Scanned Image Quality Problems
Related concepts
Image Preview Guidelines
Related tasks
Selecting a Scan Area - Office Mode
Selecting a Scan Area - Home Mode
Selecting a Scan Area - Professional Mode

Scanned Image Edges are Cropped
If the edges of a scanned image are cropped, make sure your original is placed correctly for scanning. If
necessary, move your original away from the edges of the scanner glass slightly.
Parent topic: Solving Scanned Image Quality Problems
Related topics
Placing Originals on the Product

Solving Memory Card Problems
Check these solutions if you have problems using memory cards with your product.
Memory Card Does Not Fit Into a Slot
Cannot View or Print Photos from a Memory Card
Cannot Transfer Photos To or From a Memory Card
Parent topic: Solving Problems

Memory Card Does Not Fit Into a Slot
If a memory card does not fit properly in a slot, do not force it in. You may need to use an adapter with
your memory card.
Parent topic: Solving Memory Card Problems
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Related references
Memory Card Types
Related tasks
Inserting a Memory Card

Cannot View or Print Photos from a Memory Card
If you cannot view or print photos from a memory card inserted in your product, try these solutions:
• Make sure you have inserted only one memory card at a time.
• Make sure your memory card is compatible with the product.
• Make sure the files on your memory card are in the correct format.
• If you have too many photos on your memory card, you may not see all the photos you expect or may

be prompted to select a group of photos by date. Reduce the number of photos on your card or select
one group of photos at a time. Check the memory card specifications for the maximum number of
photos.

Parent topic: Solving Memory Card Problems
Related references
Memory Card Types
Memory Card File Specifications
Related tasks
Inserting a Memory Card

Cannot Transfer Photos To or From a Memory Card
If you have problems transferring photos to or from a memory card inserted in your product, try these
solutions:
• Make sure you have inserted only one memory card at a time.
• Make sure your memory card is compatible with the product.
• Make sure your product is securely connected to your computer.
• If you are transferring photos to the memory card, check the memory card's write-protect tab to make

sure it is set to allow writing to the card.
• Make sure that the file sharing setting for your product is set correctly.
Parent topic: Solving Memory Card Problems
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Related references
Memory Card Types
Memory Card File Specifications
Related topics
Transferring Photos on a Memory Card

Solving Faxing Problems
Check these solutions if you have problems faxing with your product.
Cannot Send or Receive Faxes
Cannot Receive Faxes with a Telephone Connected to Your Product
Parent topic: Solving Problems

Cannot Send or Receive Faxes
If you cannot send or receive faxes, try these solutions:
• Make sure the recipient's fax machine is turned on and working.
• Make sure paper is loaded correctly in your product.
• Make sure Auto Answer mode is turned on to receive faxes automatically. Check your product control

panel to see if this mode is turned on.
• Check that the cable connecting your telephone wall jack to your product's LINE port is secure.
• Print a fax connection report using your product control panel or fax software to help diagnose the

problem.
• Verify that the telephone wall jack works by connecting a phone to it and testing it.
• If you connected your product to a DSL phone line, you must connect a DSL filter to the phone jack to

enable faxing over the line. Contact your DSL provider for the necessary filter.
• Try lowering the Fax Speed setting.
• Make sure the ECM (Error Correction Mode) setting is turned on if you are trying to send or receive a

color fax.

Note: If your product is connected to a VoIP (Voice over Internet Protocol) phone line, keep in mind that
fax machines are designed to work over analog phone lines. Epson cannot guarantee that fax
transmission will work when using VoIP.
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If your phone line includes voice mail answering services, calls or faxes may be inadvertently received
by your voice mail service.

Parent topic: Solving Faxing Problems
Related tasks
Connecting a Telephone or Answering Machine
Receiving Faxes Automatically (Auto Answer)
Selecting Fax Communication Settings
Printing Fax Reports
Related topics
Loading Paper

Cannot Receive Faxes with a Telephone Connected to Your Product
Make sure your telephone is connected to your product's EXT port.

Note: When answering a call that is a fax, wait until the product's LCD screen displays a message that a
connection has been made before you hang up.

Parent topic: Solving Faxing Problems
Related tasks
Connecting a Telephone or Answering Machine

When to Uninstall Your Product Software
If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.
Uninstalling Product Software - Windows
Uninstalling Product Software - Mac OS X
Parent topic: Solving Problems

Uninstalling Product Software - Windows
You can uninstall and then re-install your product software to solve certain problems.
1. Turn off the product.
2. Disconnect any interface cables.
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3. Click or Start, and select All Programs or Programs.
4. Select EPSON, select your product, then click EPSON Printer Software Uninstall.

Note: If you see a User Account Control window, click Yes or Continue.

5. In the next window, select your product and click OK. Then follow any on-screen instructions.
6. Open the Windows Control Panel utility.
7. Do one of the following to uninstall EPSON Event Manager, then follow any on-screen instructions:

• Windows 7 or Windows Vista: Select Programs and Features. (In Classic view, select
Programs and click Uninstall a program.) Select Epson Event Manager and click
Uninstall/Change.

• Windows XP: Double-click Add or Remove Programs. Select Epson Event Manager and click
Change/Remove.

8. Do one of the following to uninstall EPSON Scan, then follow any on-screen instructions:
• Windows 7 or Windows Vista: Select EPSON Scan and click Uninstall/Change.
• Windows XP: Select EPSON Scan and click Change/Remove.

9. Restart your computer, then see the Start Here sheet to re-install your software.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

Parent topic: When to Uninstall Your Product Software

Uninstalling Product Software - Mac OS X
In most cases, you do not need to uninstall your product software before re-installing it. However, you
can download the Uninstaller utility from the Epson support website to uninstall your product software as
described here.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit the Epson download site (U.S. downloads or Canadian
downloads).

2. Follow the instructions on the screen to install the Uninstaller utility.
3. Quit all applications currently running on your Mac.
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4. Double-click the Uninstaller icon.
5. Select the checkbox for each software program you want to uninstall.
6. Click Uninstall.
7. Follow the on-screen instructions to uninstall the software.
8. To reinstall your product software, see the Start Here sheet for instructions.

Note: If you uninstall the printer driver and your product name remains in the Print & Fax or Print & Scan
window, select your product name and click the – (remove) icon to remove it.

Parent topic: When to Uninstall Your Product Software

Where to Get Help
If you need to contact Epson for technical support services, use the following support options.

Internet Support
Visit Epson's support website at www.epson.com/support (U.S.) or www.epson.ca/support (Canada) for
solutions to common problems. You can download drivers and documentation, get FAQs and
troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:
• Product name
• Product serial number (located on a label on the product)
• Proof of purchase (such as a store receipt) and date of purchase
• Computer configuration
• Description of the problem
Then call:
• U.S.: (562) 276-4382, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific

Time, Saturday
• Canada: (905) 709-3839, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM,

Pacific Time, Saturday
Days and hours of support are subject to change without notice. Toll or long distance charges may
apply.
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Purchase Supplies and Accessories
You can purchase genuine EPSON ink and paper at EPSON Supplies Central at www.epson.com/ink3
(U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an EPSON
authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).
Parent topic: Solving Problems
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Technical Specifications
These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life products. Please go to www.epson.com/recycle for
information on how to return your products for proper disposal.

Windows System Requirements
Mac System Requirements
Printing Specifications
Scanning Specifications
Automatic Document Feeder (ADF) Specifications
Fax Specifications
Paper Specifications
Printable Area Specifications
Ink Cartridge Specifications
Memory Card Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Interface Specifications
External USB Device Specifications
Network Interface Specifications
Safety and Approvals Specifications

Windows System Requirements
To use your product and its software, your computer should use one of these operating systems:
• Microsoft Windows 7
• Windows Vista
• Windows XP Professional x64 Edition
• Windows XP SP3
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Note: Visit Epson's support website at www.epson.com/support (U.S.) or www.epson.ca/support
(Canada) for the latest in compatibility and drivers for your product.

Parent topic: Technical Specifications

Mac System Requirements
To use your product and its software, your Mac should use one of these operating systems:
• Mac OS X 10.5.8
• Mac OS X 10.6.x
• Mac OS X 10.7.x
• Mac OS X 10.8.x

Note: Visit Epson's support website at www.epson.com/support (U.S.) or www.epson.ca/support
(Canada) for the latest in compatibility and drivers for your product.

Parent topic: Technical Specifications

Printing Specifications
Paper path Paper cassette 1 (upper) and cassette 2 (lower), front entry

Rear paper feed slot, top entry
Capacity Cassette 1: 0.24 inch (6.0 mm) thick stack

Approximately 100 sheets at 20 lb (75 g/m2)
Cassette 2: 0.43 inch (11.0 mm) thick stack
Approximately 20 sheets of EPSON Premium Photo Paper Glossy
Rear Paper Feed Slot: One sheet between 0.002 (0.05 mm) to 0.024
inch (0.6 mm) thickness

Parent topic: Technical Specifications

Scanning Specifications
Scanner type Flatbed, color
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Photoelectric device CIS
Effective pixels 40800 × 56160 pixels at 4800 dpi
Document size Maximum: 8.5 × 11.7 inches (216 × 297 mm)

Scanner glass: US letter or A4
Scanning resolution 4800 dpi (main scan)

4800 dpi (sub scan)
Output resolution 50 to 4800, 7200, and 9600 dpi

(50 to 4800 dpi in 1 dpi increments)
Image data 16 bits per pixel per color internal

8 bits per pixel per color external (maximum)
Light source LED

Parent topic: Technical Specifications

Automatic Document Feeder (ADF) Specifications
Paper input Faceup loading
Paper output Facedown ejection
Paper size US letter, legal, or A4 size

You cannot use the 2-sided scanning feature with legal size paper
Paper type Plain paper
Paper weight 17 lb (64 g/m2) to 24 lb (95 g/m2)
Sheet feeding capacity Total thickness: 0.12 inch (3 mm)

Approximately 30 sheets (US letter or A4) or 10 sheets (legal)

Parent topic: Technical Specifications

Fax Specifications
Fax type Black and white and color fax capability
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Support line Household phone line
Speed Up to 33.6 kbps
Resolution Monochrome

Standard: 200 × 100 dpi
Fine: 200 × 200 dpi
Photo: 200 × 200 dpi
Color
Fine: 200 × 200 dpi
Photo: 200 × 200 dpi

Error correction mode CCITU/ITU Group 3 fax with error correction mode
Speed dial/group dial numbers Up to 60 (combined)
Page memory Up to 180 (ITU-T No. 1 chart )
Redial 2 times (with 1 minute interval)
Interface RJ-11 Phone Line

RJ-11 Telephone set connection

Parent topic: Technical Specifications

Paper Specifications
Note: Since the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, Epson cannot guarantee the quality of any non-EPSON brand or type of paper. Always test a
sample of paper stock before purchasing large quantities or printing large jobs.

331



Single-sheets

Size A4 (8.3 × 11.7 inches [210 × 297 mm])
A6 (4.1 × 5.8 inches [105 × 148 mm])
Letter (8.5 × 11 inches [216 × 279 mm])
Legal (8.5 × 14 inches [216 × 357 mm])
4 × 6 inches (102 × 152 mm)
5 × 7 inches (127 × 178 mm)
8 × 10 inches (203 × 254 mm)
3.5 × 5 inches (89 × 127 mm)
16:9 wide (4 × 7.1 inches [102 × 181 mm])
Half Letter (5.5 × 8.5 inches [140 × 279 mm])

Paper types Plain paper and paper distributed by Epson
Thickness 0.003 inch (0.08 mm) to 0.004 inch (0.11 mm)
Weight 17 lb (64 g/m2) to 24 lb (90 g/m2)

Envelopes

Size No. 10 (4.1 × 9.5 inches [105 × 241 mm])
Paper types Plain bond paper
Weight 20 lb (75 g/m2) to 24 lb (90 g/m2)

Parent topic: Technical Specifications

Printable Area Specifications
Note: When printing borderless, quality may decline in the expanded printable area.
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Single sheets

1 Top: 0.12 inch (3.0 mm) minimum
2 Left: 0.12 inch (3.0 mm) minimum
3 Right: 0.12 inch (3.0 mm) minimum
4 Bottom: 0.12 inch (3.0 mm) minimum

Envelopes
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1 Left: 0.12 inch (3.0 mm) minimum
2 Bottom: 0.20 inch (5.0 mm) minimum
3 Top: 0.20 inch (5.0 mm) minimum
4 Right: 0.83 inch (21.0 mm) minimum

CD/DVDs
12-cm CD/DVDs

1 0.7 inch (18 mm) minimum inner margin
2 4.7 inch (120 mm) maximum outer margin

Note: Avoid printing in the clear plastic areas of discs to prevent staining the disc with ink.

Parent topic: Technical Specifications

Ink Cartridge Specifications
Note: We recommend that you use genuine EPSON cartridges and do not refill them. The use of other
products may affect your print quality and could result in printer damage.
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The cartridges included with the printer are designed for printer set up and not for resale. After some ink
is used for priming, the rest is available for printing. Yields vary considerably based on images printed,
print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink
remains in the cartridge after the "replace cartridge" indicator comes on.

Color Black, Cyan, Magenta, Yellow, Light Cyan, Light Magenta
Cartridge life Opened package: 6 months

Unopened package: do not use if the date on the package has
expired

Temperature Storage: –4 to 104 ºF (–20 to 40 ºC)
1 month at 104 ºF (40 ºC)
Ink freezes at 3.2 ºF (–16 ºC)
Ink thaws and is usable after 3 hours at 77 ºF (25 ºC)

Note: For best printing results, use up a cartridge within 6 months of opening the package.

Parent topic: Technical Specifications

Memory Card Specifications
Note: Cards marked with an asterisk (*) require an adapter; consult your adapter documentation for
details on using it.
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Compatible types CompactFlash
Microdrive
Memory Stick Duo
Memory Stick PRO Duo
Memory Stick PRO-HG Duo
Memory Stick Micro*
MagicGate Memory Stick Duo
SDXC
SDHC
SD
MultiMediaCard
MMCplus
MMCmobile*
MMCmicro*
miniSDHC*
miniSD*
microSDXC*
microSDHC*
microSD*

Media format DCF DCF (Design rule for Camera File system) version 1.0 or 2.0
compliant

Voltage requirements 3.3 V
Maximum current for CompactFlash and Microdrive: 500 mA

Parent topic: Technical Specifications
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Dimension Specifications
Height Stored: 7.5 inches (191 mm)

Printing: 8.1 inches (207 mm)
Width Stored: 15.4 inches (390 mm)

Printing: 17.2 inches (438 mm)
Depth Stored: 13.3 inches (339 mm)

Printing: 23.5 inches (598 mm)
Weight 19.2 lb (8.7 kg)
(without ink cartridges)

Parent topic: Technical Specifications

Electrical Specifications
Power supply rating 100 to 120 V
Input voltage range 90 to 132 V
Rated frequency range 50/60 Hz
Input frequency range 49.5/60.5 Hz
Rated current 0.7 A
Power consumption Standalone copying: 21 W (ISO/IEC24712)

Ready mode: 7.0 W
Sleep mode: 2.0 W
Power off mode: 0.2 W

Parent topic: Technical Specifications
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Environmental Specifications
Temperature Operating: 50 to 95 ºF (10 to 35 ºC)

Storage: –4 to 104 ºF (–20 to 40 ºC)
1 month at 104 ºF (40 ºC)

Humidity Operating: 20 to 80% RH
(non-condensing) Storage: 5 to 85% RH

Parent topic: Technical Specifications

Interface Specifications
Interface type Hi-Speed USB (Device Class for computers)

Hi-Speed USB (for PictBridge compliant device/Mass storage class
for external storage)

Note: Epson cannot guarantee the operation of externally connected devices.

Parent topic: Technical Specifications

External USB Device Specifications
Note: Use only external storage devices with independent AC power sources. External storage devices
that are powered via USB are not recommended. Epson cannot guarantee the operation of externally
connected devices.

CD-ROM/CD-R drive 700MB maximum capacity
CD-RW is not supported

DVD-ROM/DVD-R drive 4.7GB maximum capacity
DVD-RW, DVD+R, and DVD+RW are not supported

Magneto-optical drive 1.3GB
Hard disk and USB flash 2TB
drives Formatted in FAT, FAT32, or exFAT.
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Parent topic: Technical Specifications

Network Interface Specifications
Wi-Fi

Standard IEEE 802.11 b/g/n
Security WPA-PSK (TKIP/AES); WPA2 compliant

WEP (64/128 bit)
Frequency band 2.4 GHz
Communication mode Infrastructure mode

Ad hoc mode
Wi-Fi Direct

Note: Wireless LAN standard complies with either IEEE 802.11 b/g or IEEE 802.11 b/g/n, depending on
purchase location.

Ethernet

Standard IEEE802.3i/u, IEEE802.3az*
Communication mode Ethernet 100BASE-TX/10BASE-T

* The connected device should be IEEE802.3az compliant.
Parent topic: Technical Specifications

Safety and Approvals Specifications
United States Safety: UL60950-1

EMC: FCC part 15 Subpart B class B
Canada Safety: CAN/CSA C22.2 No. 60950-1

EMC: CAN/CSA-CEI/IEC CISPR 22 Class B
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This equipment contains the following wireless module:
• Manufacturer: Askey Computer Corporation.
• Type: WLU6117-D69 (RoHS)
This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation of the device.
To prevent radio interference to the licensed service, this device is intended to be operated indoors and
away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed
outdoors is subject to licensing.
Parent topic: Technical Specifications
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Notices
Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life products. Please go to www.epson.com/recycle for
information on how to return your products for proper disposal.

FCC Compliance Statement
Software Notice
Trademarks
Copyright Notice

FCC Compliance Statement
For United States Users
This equipment complies with Part 68 of the FCC rules and the requirements adopted by the
Administrative Council for Terminal Attachments ("ACTA") . On the surface of this equipment is a label
that contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If
requested, this number must be provided to the telephone company.
Applicable certification jack Universal Service Order Codes ("USOC") for the equipment: RJ11C.
A plug and jack used to connect this equipment to the premises wiring and telephone network must
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant
telephone cord and modular plug is provided with this product. It is designed to be connected to a
compatible modular jack that is also compliant. See installation instructions for details.
The REN is used to determine the number of devices that may be connected to a telephone line.
Excessive RENs on a telephone line may result in the devices not ringing in response to an incoming
call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number
of devices that may be connected to a line, as determined by the total RENs, contact the local telephone
company. For products approved after July 23, 2001 , the REN for this product is part of the product
identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN without a
decimal point (e.g., 03 is a REN of 0.3). For earlier products, the REN is separately shown on the label.
If this equipment causes harm to the telephone network, the telephone company will notify you in
advance that temporary discontinuance of service may be required. But if advance notice isn't practical,
the telephone company will notify the customer as soon as possible. Also, you will be advised of your
right to file a complaint with the FCC if you believe it is necessary.
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The telephone company may make changes in its facilities, equipment, operations or procedures that
could affect the operation of the equipment. If this happens the telephone company will provide advance
notice in order for you to make necessary modifications to maintain uninterrupted service.
If you have problems with this product and require technical or customer support, please visit
www.epson.com for more information.
This product is not intended to be repaired by the customer. If you experience trouble connecting this
equipment to a telephone line, please contact:
Name: Epson America, Inc.
Address: 3840 Kilroy Airport Way, Long Beach, CA 90806 U.S.A.
Telephone: (562) 981-3840
If the equipment is causing harm to the telephone network, the telephone company may request that you
disconnect the equipment until the problem is resolved.
This equipment may not be used on coin service provided by the telephone company. Connection to
party line service is subject to state tariffs. Contact the state public utility commission, public service
commission or corporation commission for information.
If your home has specially wired alarm equipment connected to the telephone line, ensure the
installation of this equipment does not disable your alarm equipment. If you have questions about what
will disable alarm equipment, consult your telephone company or a qualified installer.
The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or
other electronic device, including fax machines, to send any message unless such message clearly
contains in a margin at the top or bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of the business or other entity, or other
individual sending the message and the telephone number of the sending machine or such business,
other entity, or individual. (The telephone number provided may not be a 900 number or any other
number for which charges exceed local or long-distance transmission charges.)
In order to program this information into your fax machine, follow the instructions in "Entering Fax
Header Information".
According to the FCC's electrical safety advisory, we recommend that you may install an AC surge
arrester in the AC outlet to which this equipment is connected. Telephone companies report that
electrical surges, typically lightning transients, are very destructive to customer terminal equipment
connected to AC power sources and that this is a major nationwide problem.
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
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interference to radio or television reception. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

WARNING
The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC
Certification or Declaration of this device and may cause interference levels which exceed the limits
established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded
equipment interface cable with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces. Changes or modifications not expressly approved by
the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users
1. This product meets the applicable Industry Canada technical specifications.
2. The Ringer Equivalence Number is an indication of the maximum number of devices allowed to be
connected to a telephone interface. The termination on an interface may consist of any combination of
devices subject only to the requirement that the sum of the RENs of all the devices does not exceed five.
This Class B digital apparatus complies with Canadian ICES-003.
Le présent matériel est conforme aux spécifications techniques applicables d’Industrie Canada.
L’indice d’équivalence de la sonnerie (IES) sert à indiquer le nombre maximal de terminaux qui peuvent
être raccordés à une interface téléphonique. La terminaison d’une interface peut consister en une
combinaison quelconque de dispositifs, à la seule condition que la somme d’indices d’équivalence de la
sonnerie de tous les dispositifs n’excède pas 5.
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
Parent topic: Notices

Software Notice
1. This printer product includes open source software programs listed in Section 6) according to the

license terms of each open source software program.
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2. We provide the source code of the GPL Programs, LGPL Programs, Apache License Program and
ncftp license Program (each is defined in Section 6) until five (5) years after the discontinuation of
same model of this printer product. If you desire to receive the source code above, please contact the
customer support of your region. You shall comply with the license terms of each open source
software program.

3. The open source software programs are WITHOUT ANY WARRANTY; without even the implied
warranty of MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. See the license
agreements of each open source software program for more details, which are described in OSS.pdf
on your Printer Software CD.

4. OpenSSL toolkit
This printer product includes software developed by the OpenSSL project for use in the OpenSSL
Toolkit (http://www.openssl.org/).
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).

5. The license terms of each open source software program are described in OSS.pdf on your Printer
Software CD.

6. The list of open source software programs which this printer product includes are as follows.
GNU GPL
This printer product includes the open source software programs which apply the GNU General Public
License Version 2 or later version ("GPL Programs").
The list of GPL Programs:
linux-2.6.35-arm1-epson12
busybox-1.17.4
udhcp 0.9.8cvs20050124-5
ethtool-2.6.35
GNU LGPL
This printer product includes the open source software programs which apply the GNU Lesser General
Public License Version 2 or later version ("LGPL Programs").
The list of LGPL Programs:
uclibc-0.9.32
libusb-1.0.8
zeroconf 0.6.1-1
iksemel-rev25
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Apache License
This printer product includes the open source software program "Bonjour" which apply the Apache
License Version2.0 ("Apache License Program").
Bonjour License
This printer product includes the open source software program "Bonjour " which applies the terms and
conditions provided by owner of the copyright to the "Bonjour ".
Net-SNMP license
This printer product includes the open source software program "Net-SNMP" which applies the terms
and conditions provided by owner of the copyright to the "Net-SNMP".
OpenSSL License/Original SSLeay License
This printer product includes t he open source software program "OpenSSL toolkit" which applies the
license terms of OpenSSL License and Original SSLeay License.
BSD License (Berkeley Software Distribution License)
This printer product includes the open source software program "busybox-1.17.4 " which apply the
Berkeley Software Distribution License ("BSD Program").
Sun RPC License
This printer product includes the open source software program "busybox-1.17.4 " which apply the Sun
RPC License ("Sun RPC Program").
ncftp license
This printer product includes the open source software program "ncftp-3.2.4 " which applies the terms
and conditions provided by owner of the copyright to the "ncftp ".
ARC4 license
This printer product includes the open source software program "ARC4" which applies the terms and
conditions provided by owner of the copyright to the "ARC4".
json_parserlicense
This printer product includes the open source software program "json_parser" which applies the terms
and conditions provided by owner of the copyright to the " json_parser ".
MD5license
This printer product includes the open source software program "MD5" which applies the terms and
conditions provided by owner of the copyright to the " MD5 ".
AESlicense
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This printer product includes the open source software program "AES" which applies the terms and
conditions provided by owner of the copyright to the "AES".
SHA1 license
This printer product includes the open source software program "SHA1" which applies the terms and
conditions provided by owner of the copyright to the "SHA1".
Parent topic: Notices

Trademarks
EPSON® and Supplies Central® are registered trademarks, EPSON ConnectTM, EPSON iPrintTM, and
Remote PrintTM are trademarks, and EPSON Exceed Your Vision is a registered logomark of Seiko
Epson Corporation.
EPSON StoreSM is a service mark of Epson America, Inc.
Apple, iPad, iPhone, iPod touch, and Mac OS are trademarks of Apple Inc., registered in the U.S. and
other countries. AirPrint is a trademark of Apple Inc.
General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Parent topic: Notices

Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
designed only for use with this EPSON product. Epson is not responsible for any use of this information
as applied to other products.
Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.
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Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original EPSON Products or
EPSON Approved Products by Seiko Epson Corporation.
Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as EPSON
approved Products by Seiko Epson Corporation.
This information is subject to change without notice.
libTIFF Software Acknowledgment
A Note Concerning Responsible Use of Copyrighted Materials
Default Delay Times for Power Management for EPSON Products
Copyright Attribution
Parent topic: Notices

libTIFF Software Acknowledgment
Copyright © 1988-1997 Sam Leffler
Copyright © 1991-1997 Silicon Graphics, Inc.
Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose
is hereby granted without fee, provided that (I) the above copyright notices and this permission notice
appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and
Silicon Graphics may not be used in any advertising or publicity relating to the software without the
specific, prior written permission of Sam Leffler and Silicon Graphics.
THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT
ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT
OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
Parent topic: Copyright Notice

A Note Concerning Responsible Use of Copyrighted Materials
Epson encourages each user to be responsible and respectful of the copyright laws when using any
EPSON product. While some countries' laws permit limited copying or reuse of copyrighted material in
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certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.
Parent topic: Copyright Notice

Default Delay Times for Power Management for EPSON Products
This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets
Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to
sleep to a shorter interval.
Parent topic: Copyright Notice

Copyright Attribution
© 2013 Epson America, Inc.
2/13
CPD-37262R1
Parent topic: Copyright Notice
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